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Document History

Before you start, make sure you have the latest version of this document. You can find the latest version at the

following location:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |l Installation and Upgrade 3

The following table provides an overview of the most important document changes. If the information you are
looking for is not described in this guide or if you find something described incorrectly, please send an email to

mailto:saphybrismarketingfeedback@sap.com and we'll update this guide.
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1 Introduction

This installation guide describes how to install the high-performance application SAP Hybris Marketing on
premise. The application can also be operated in the SAP HANA Enterprise Cloud, under the name SAP Hybris
Marketing Cloud with a separate license.

1.1 About this Document

This guide applies to consultants and system administrators who intend to install one or more of the components
of SAP Hybris Marketing. It covers both the technical side (how installation is done) and the functional side (for
example, customizing activities).

e Constraints:
This guide provides you with the main application-specific installation and configuration steps. The installation
and configuration of the underlying SAP HANA platform and the required SAP NetWeaver ABAP AS system
are not described in this installation guide in particular, but in separate documentation, referenced where
necessary.
e Considerations:
o The sections and instructions in this guide are relevant for all above mentioned components unless
otherwise expressly indicated.
o Access to the separate solutions is managed via the corresponding authorization roles. For more
information about activating roles, see Generating Authorization Profiles for the User Interface [page
691].
o Before starting the installation make sure that you are aware of all required installation steps that have to
be executed before the actual installation of the application. The prerequisites are mentioned in this
document.

1.2 Feedback

We'd really like to know what you think of the quality, structure or content of this guide. Please send your feedback
to us at mailto:saphybrismarketingfeedback@sap.com.

1.3 Licenses of SAP Hybris Marketing

SAP Hybris Marketing contains the following licenses that can be purchased separately:

e SAP Hybris Marketing Data Management (mandatory)
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e SAP Hybris Marketing Insight

e SAP Hybris Marketing Segmentation

e SAP Hybris Marketing Recommendation

e SAP Hybris Marketing Planning

e SAP Hybris Marketing Acquisition

Any licensing of SAP Hybris Marketing includes the marketing platform SAP Hybris Marketing Data Management.

In addition, the common objects such as Target Group, Campaign, Interaction, Export Definition, Predictive Model,
or User Lists are always available regardless of the purchased license.

For a brief description of the SAP Hybris Marketing licenses and the corresponding applications, see the SAP Help
Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |» Application Help # SAP Hybris Marketing 3
(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US)

1.4 Integration

SAP Hybris Marketing is based on the SAP HANA appliance software, in particular the SAP HANA database, and
SAP NetWeaver 7.5.

The SAP HANA database must be available and configured with the latest revision of the current support package
before starting the actual installation of SAP Hybris Marketing. You can check the exact support package and
required revision levels in the Preconditions section of Release Information Note 1885803 #r .

For more information about how to receive the latest revision of the SAP HANA database, see the SAP HANA
Master Update Guide at:

http://help.sap.com/hana_platform# |» Select "Version: 1.0 SPS 12" in the upper right corner ¥ Installation and
Upgrade » View All » SAP HANA Master Update Guide 3
(https://help.sap.com/viewer/d2c61312b97d4d8288487afc085e9ad9/1.0.12/en-US)

In addition, if you plan to use SAP ERP and/or SAP CRM as source system to operate your marketing, sales, and/or
service business, the following releases are proposed for the different solutions:

Table 2:

SAP Hybris Marketing License ‘ SAP ERP ’ SAP CRM

SAP Hybris Marketing Insight 6.0 or higher (mandatory) 7.01 (SP0O4 plus SAP Note 1995798 Fr )
or higher (optional)

SAP Hybris Marketing Segmentation 6.0 or higher (mandatory) 7.01 (SP0O4 plus SAP Note 1995798 Fr )

on SAP ERP Accounts or higher (optional)

SAP Hybris Marketing Segmentation 6.0 or higher (optional) 7.01 (SP04 plus SAP Note 1995798 Fr )

on SAP CRM Business Partners or higher (mandatory)
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SAP Hybris Marketing License SAP ERP SAP CRM
SAP Hybris Marketing Data Manage- 6.0 or higher (optional) 7.01 (SP04 plus SAP Note 1995798 Fir )
ment or higher (optional)

SAP Hybris Marketing Recommenda- 6.0 or higher (mandatory)
tion

The solutions SAP Hybris Marketing Acquisition and SAP Hybris Marketing Planning do not use SAP ERP or SAP
CRM data.

Browser Recommendations

For a recommendation concerning the appropriate browser platform to run the application, refer to the Product
Availability Matrix (PAM) at http://support.sap.com/pam#s under SAP Hybris Marketing 1.2.

1.5 SAP Notes for Installation

The Release Information Note (RIN) contains general installation information concerning SAP Hybris Marketing.

You find the RIN under https://launchpad.support.sap.com/#/mynotes#te. Enter the RIN number in the
corresponding field in the upper right corner of the screen.

1 Note

Ensure that you have carefully read the RIN before you implement the included SAP Notes. The RIN contains
information about the exact point in time for the implementation of every included SAP Note:

e Before the import of the support package

e Before executing the technical configuration

e After executing the technical configuration

e SAP Note only relevant for a certain solution scope

If there is additional information or updates to the installation process described in this installation and
configuration guide, you find the corresponding information in the SAP Notes mentioned below in the table.

Make sure that you have the up-to-date version of each SAP Note, which you can find on the SAP Service
Marketplace at: https://launchpad.support.sap.com/#/mynotes .
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Table 3:

SAP Note Number

Release Information Note 1885803 #r

‘ Title

RIN SAP Hybris Marketing (formerly SAP
Customer Engagement Intelligence)

Description

Contains information and references in
the context of applying SAP Hybris
Marketing

Note 2076331

Follow Up Tasks after System Copy

Contains information about the actions
to be carried out after system copy

10 CUSTOMER
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2 Technical System Landscape

SAP Hybris Marketing is based on the following components:

e SAPHANA10, SPS12

e SAP NetWeaver 7.50, SP0O6 (including SAP NetWeaver Gateway and SAP NetWeaver Ul Extension)
e SAP Business Suite Foundation (SAP_BS_FND) 748, SPO1

e SAP MDG Foundation (MDG_FND) 749, SPO1 or higher

e SAP Web UIF (WEBCUIF) 748, SPO1

1 Note

Most applications within SAP Hybris Marketing such as Customer Journey Insight, are SAP Fiori apps. All SAP
Fiori apps are directly deployed on the SAP Hybris Marketing server.

All these components are embedded in the SAP Fiori launchpad that is based on HTML5 (SAPUI5). Some
administrative tasks, such as Customizing tasks, are also based on the traditional SAP GUI technology, which is
not explicitly shown in Figure 1. Figure 1 gives an example of a possible technical system landscape for SAP Hybris
Marketing, which includes the use of SAP ERP and SAP CRM data.

The communication of the front-end components with the back end, which is an SAP NetWeaver 7.5 application
server, is based on HTTPS. The Web applications are embedded in a shell that ensures secure session
management. All servers run behind the firewall.

The requests of the stateless Web applications to the back end are based on OData (read and write) using HTTPS.

The main reused components of the application server are those of SAP NetWeaver 7.5, for example, user
management, authentication, and authorization. SAP Gateway handles the requests from the front end through
OData channel services.

The underlying database for SAP Hybris Marketing is SAP HANA 1.0. To leverage the capabilities of the SAP HANA
database, parts of the segmentation, search capabilities, and analysis are performed directly on the database
using stored procedures and SAP HANA information models, such as calculation views, attribute views, and
analytical views. All access to the database is done through the SAP NetWeaver 7.5 application server using
OpenSQL or the ABAP Database Connectivity (ADBC) interface of ABAP to the SAP HANA database. Only the user
management of SAP NetWeaver is required and only a technical user within the SAP HANA database is required
for the access.

Data from SAP ERP, for example, and other SAP components can be replicated to SAP Hybris Marketing with the
SAP LT replication framework. For more information about the tables that are required for the usage of SAP Hybris
Marketing in connection with SAP ERP or SAP CRM, and need to be configured in SAP LT, see the Appendix section
of this document. Results for SAP Hybris Marketing can be sent to SAP CRM. For other deployment options of SAP
Hybris Marketing with SAP ERP and SAP CRM, see Deployment Scenarios [page 14].

The SAP NetWeaver role and authorization framework is used with SAP Hybris Marketing.
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More Information

For more information about the SAP HANA database system landscape, see the SAP Help Portal at:

http://help.sap.com/hana_platform#ar |» Select "Version: 1.0 SPS 12" in the upper right corner » Security » SAP

HANA Security Guide

(https://help.sap.com/viewer/b3ee5778bc2e4a089d3299b82ec762a7/1.0.12/en-US/ ¥r)

For more information, see the resources listed in the following table.

12
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Table 4:
Guide/Tool Quick Link on SAP Service Market-
place or SCN
Security See applicable documents http://scn.sap.com/community/security
L

https://help.sap.com/viewer/p/
SAP_HYBRIS_MARKETING

Il Security 3
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3 Deployment Scenarios

SAP Hybris Marketing can use SAP ERP data from SAP ERP 6.0 or higher and SAP CRM data from enhancement
package (EHP) 1 for SAP CRM 7.0 SP04 (plus SAP Note 1995798 ) or higher. Several deployment options are
available. Your decision for a certain deployment option depends on the release of your source system and the SAP
Hybris Marketing applications that you want to run. The table below shows which data is mandatory for each
solution.

For recommendations concerning the appropriate system landscape to run the application, refer to the Product
Availability Matrix (PAM) at http:/support.sap.com/pam# |» SAP HYBRIS MARKETING 1.2 ¥ Related Links 3.

Table 5:
SAP Hybris Marketing Licenses or Ap- | SAP ERP SAP CRM
plications
Data Management optional optional
Insight - Marketing Executive Dashboard | optional optional
Insight - Relationship Analysis Sales, mandatory optional
Stratification, Margin Decomposition
Insight - Relationship Analysis Presales | optional mandatory
Segmentation on SAP ERP Accounts mandatory optional
Segmentation on SAP CRM Accounts optional mandatory
Segmentation on contact of third party | optional optional
data
Recommendation optional optional
Planning optional optional
Acquisition optional optional

Installation and Configuration Guide 1702
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3.1 Scenario A: Standalone Deployment

SAP Hybris Marketing Segmentation and SAP Hybris Marketing Data Management can be used without SAP ERP or
SAP CRM data. Third-party data to be used in these applications can be replicated to the SAP HANA database or
imported to the SAP Hybris Marketing system with different tools:

e For the replication of your third-party data, you can use one of the SAP HANA data provisioning tools
described in the SAP HANA Master Guide under:
http://help.sap.com/hana_platform# | Select "Version: 1.0 SPS 12" in the upper right corner ¥ Installation
and Upgrade » SAP HANA Master Guide 3
(https://help.sap.com/viewer/eb3777d5495d46c5b2fa773206bbfb46/1.0.12/en-US)

e For the import of your third-party data to your SAP Hybris Marketing system, you can use one of the inbound
interfaces for data upload, described in the Data Management Upload Interfaces guide under:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |j» Integration » Data Management Upload
Interfaces 3

(https://help.sap.com/doc/4d660f95f99b41a3a66283a7dff0el60/1702%20YMKT/en-US/
10i0339d4f548e6a5176e10000000a4450e5. pdf)

yMKT

AS ABAP
@

SAP HANA

Figure 1: Standalone Deployment
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3.2 Scenario B: Hub-Deployment with Separate SAP HANA
System

You can deploy SAP Hybris Marketing in a side-by-side approach. This means that the application runs on a
separate application server with a separate SAP HANA database. In this case the data is replicated from your
source system into the SAP HANA database with the SAP Landscape Transformation Replication Server (SAP LT).

Using separate deployment and data replication ensures that there is no incident or disruption in your production
source systems, since the application does not directly access your production data. Replication also allows your
SAP HANA-based application to work with data even if your production systems do not use SAP HANA.

For more information about the data replication, see Data Replication [page 30].

In this scenario, you can, in addition, upload third-party data to your SAP Hybris Marketing system by using one of
the inbound interfaces for data upload, described in the Data Management Upload Interfaces guide under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration » Data Management Upload
Interfaces 3

(https://help.sap.com/doc/4d660f95f99b41a3a66283a7dff0el60/1702%20YMKT/en-US/
10i0339d4f548e6a5176e10000000a4450e5.pdf)

SAP ERP SAP CRM
AS ABAP AS ABAP AS ABAP
4) d) Replication el)
i 1 ’O Y
DB DB

Figure 2: Hub-Deployment with Separate SAP HANA System
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The following table shows the minimum required releases:

Table 6:

SAP ERP SAP CRM

SAP ERP 6.0 EHP1 for SAP CRM 7.0 SPO4 plus SAP Note 1995798 F

3.3 Scenario C: Hub-Deployment with Shared SAP HANA
System of SAP Business Suite

SAP Hybris Marketing can be deployed in parallel with SAP Business Suite applications on the same SAP HANA
database. In this case SAP Hybris Marketing shares the SAP HANA database with one SAP ERP, one SAP CRM, or
one SAP S/4HANA system, reading SAP ERP, SAP CRM, or SAP S/4HANA data directly without replication.

1 Note

In this scenario, ensure that you have carefully read and considered SAP Note 1826100#% as it contains more
information about this deployment.

In this scenario, you can, in addition, upload third-party data to your SAP Hybris Marketing system by using one of
the inbound interfaces for data upload, described in the Data Management Upload Interfaces guide under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# |+ Integration » Data Management Upload
Interfaces 3

(https://help.sap.com/doc/4d660f95f99b41a3a66283a7dff0el60/1702%20YMKT/en-US/
10i0339d4f548e6a5176e10000000a4450e5.pdf)

If you decide to deploy SAP Hybris Marketing in such a deployment scenario, you have the following options:

® You can deploy SAP Hybris Marketing on the same SAP HANA database as your SAP ERP system if your SAP
ERP system is minimum an EHP6 for SAP ERP 6.0 on SAP HANA. In addition, if you require to use SAP CRM
business data as well, you can replicate this data from your SAP CRM system into the same SAP HANA
database. This means that the SAP Hybris Marketing system is deployed with a shared SAP HANA database of
SAP ERP, whereas SAP CRM runs on a separate database, as shown in scenario B.
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DB SAP HANA

Figure 3: Hub-Deployment with Shared SAP HANA System of SAP ERP

The following table shows the minimum required releases:

Table 7:
EHPG6 for SAP ERP 6.0 on SAP HANA EHP1 for SAP CRM 7.0 SPO4 plus SAP Note 1995798 ¥
EHP7 for SAP ERP 6.0 EHP1 for SAP CRM 7.0 SPO4 plus SAP Note 1995798 ¥

® You can deploy SAP Hybris Marketing on the same SAP HANA database as your SAP CRM system if your SAP
CRM system is minimum an EHP2 for SAP CRM 7.0 on SAP HANA. In addition, if you require to use SAP ERP
business data as well, you can replicate this data from your SAP ERP system into the same SAP HANA
database. This means that the SAP Hybris Marketing system is deployed with a shared SAP HANA database of
SAP CRM, whereas SAP ERP runs on a separate database, as shown in scenario B.

Installation and Configuration Guide 1702
18 CUSTOMER Deployment Scenarios


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1995798
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1995798

SAP ERP SAP CRM yMKT

AS ABAP AS ABAP AS ABAP

Replication ()
O

DB SAP HANA

Figure 4: Hub-Deployment with Shared SAP HANA System of SAP CRM

The following table shows the minimum required releases:

Table 8:
SAP ERP 6.0 EHP2 for SAP CRM 7.0 on SAP HANA SPO1 plus SAP Note
1996523 F
SAP ERP 6.0 EHP3 for SAP CRM 7.0

® You can deploy SAP Hybris Marketing on the same SAP HANA database as your SAP S/4HANA system. In
addition, if you require to use SAP CRM or SAP ERP business data as well, you can replicate this data from
your SAP CRM or SAP ERP system into the same SAP HANA database. This means that the SAP Hybris
Marketing system is deployed with a shared SAP HANA database of SAP S/4HANA, whereas SAP CRM or SAP
ERP runs on a separate database, as shown in scenario B.
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Figure 5: Hub-Deployment with Shared SAP HANA System of SAP S/4HANA

3.4 Scenario D: Hub-Deployment with Shared SAP HANA
System of Other Application

SAP Hybris Marketing can be deployed on an SAP HANA database that is already used for applications which are
listed in SAP Note 1661202 — Support for Multiple Applications on SAP HANA. If you require to use SAP ERP or
SAP CRM business data as well, you can replicate this data into the same SAP HANA database.

This deployment scenario is not separately pointed out in this installation guide. If you require to replicate data
refer to the deployment process for scenario B; if you do not require to replicate data refer to the deployment
process for scenario A.

In this scenario, you can, in addition, upload third-party data to your SAP Hybris Marketing system by using one of
the inbound interfaces for data upload, described in the Data Management Upload Interfaces guide under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration » Data Management Upload
Interfaces 3

(https://help.sap.com/doc/4d660f95f99b41a3a66283a7dff0el60/1702%20YMKT/en-US/
[0i0339d4f548e6a5176e10000000a4450e5.pdf)
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Figure 6: Hub-Deployment with Shared SAP HANA System of Other Application
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4 Development and Production Systems

We recommend that you install or update first in a development system. After testing, you may begin installation in
your production system.

1 Note

Certain tasks are only carried out in the development system (see Creating Development Package [page 51]).
These tasks generate repository objects and Customizing objects that are imported into the production system
at a later point in time (see Applying Technical Configuration Artifacts to Production System [page 67]).
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5 Installation

This section explains how the base installation of SAP Hybris Marketing on premise is to be executed. Since SAP
Hybris Marketing runs on an SAP NetWeaver AS ABAP system with SAP HANA as the primary and only database,
you must set up the database first. The SAP NetWeaver AS ABAP system as well as theSAP Hybris Marketing
system will be installed on this SAP HANA database in a second step.

The following flow chart illustrates the sequence of the installation process.

Installation or Reuse of
SAP HANA Platform

¥

Installation of
AS ABAP and SAP Hybris Marketing

Installation or Reuse of
SAP Web Dispatcher

= aW

Post-Installation
lincluding Technical Configuration)
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5.1 |Installation of the SAP HANA Platform

As an appliance, SAP HANA uses software components from SAP optimized for proven hardware provided by
SAP's hardware partners. Therefore, the components of SAP HANA can only be installed by certified hardware
partners on validated hardware running a specific operating system.

To ensure that your SAP HANA appliance is optimally prepared for use with your application, you should consider
the following topics.

5.1.1 Correct Sizing of the SAP HANA Database

For help in determining SAP HANA sizing for SAP Hybris Marketing Cloud, see the Sizing Guide for SAP Hybris
Marketing Cloud on the SAP Service Marketplace at:

http://service.sap.com/sizing® | Sizing Guidelines » Database and Technology » SAP In-Memory Computing 3.
(http://service.sap.com/%7Esapidb/011000358700000373142013E )

Another option is to use the web-based Quick Sizer at http:/service.sap.com/quicksizing .

5.1.2 Installing the SAP HANA Database

For information about the installation and configuration of the SAP HANA database follow the instructions in the
corresponding master and installation guides. You find both documents under http://help.sap.com/hana_platform

#i |» Select "Version: 1.0 SPS 12" in the upper right corner ¥ Installation and Upgrade 3:
o  SAP HANA Master Guide: https://help.sap.com/viewer/eb3777d5495d46chb2fa773206bbfb46/1.0.12/en-US
[

e SAP HANA Server Installation and Update Guide: https://help.sap.com/viewer/
2c1988d620e04368aa4103bf2617727/1.0.12/en-US e

5.1.3 Updating to Higher Revisions of the SAP HANA Database

SAP ships SAP HANA Support Package revisions, which contain latest capabilities in SAP HANA. As your current
installation might not contain the latest revision, you must update your SAP HANA database accordingly. Check
the Release Information Note (RIN) forSAP Hybris Marketing 1885803#% to find information about the minimum
SAP HANA revision required for SAP Hybris Marketing.

You can find the RIN under http://support.sap.com/notes#e.

For information about the SAP HANA update, see the SAP HANA Master Update Guide at:

http://help.sap.com/hana_platform# |» Select "Version: 1.0 SPS 12" in the upper right corner ¥ Installation and
Upgrade ¥ View All % SAP HANA Master Update Guide J
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5.1.4 Installing the SAP HANA Application Function Library
(AFL)

An SAP HANA system consists of the SAP HANA server and additional components like the Application Function
Library (AFL). SAP Hybris Marketing requires this library. Therefore install the library as described in section
Managing SAP HANA System Components of the SAP HANA Administration Guide under:

http://help.sap.com/hana_platform [ Select "Version: 1.0 SPS 12" in the upper right corner » Administration »
SAP HANA Administration Guide 3.

(https://help.sap.com/viewer/6b94445c94ae495c83a19646e7c3fd56/1.0.12/en-US)

5.2 Installation of AS ABAP and SAP Hybris Marketing

1 Note

Your application runs only on a SAP NetWeaver system that is installed with SAP HANA as the primary and only
database system. Other types of database systems are not supported.

The SAP Hybris Marketing application is based on an SAP NetWeaver 7.5 application server (AS). The installation
of the AS ABAP and the SAP Hybris Marketing system is executed using tools of the software logistics toolset (SL
Toolset). The SL Toolset is a product-independent delivery channel that delivers up-to-date software logistics
tools.

You have several options supported by SAP NetWeaver to installSAP Hybris Marketing. In the following, you are
provided with a description of an up-to-date installation based on Maintenance Planner, a tool that is based on SAP
Solution Manager’s processes and data. Maintenance Planner is part of the SL Toolset.

For other installation options, see the required information in the corresponding standard guides on the SAP
Support Portal (https://support.sap.com/sltoolset#).

The simplified up-to-date installation supports planning of new installations on a chosen stack level. You can
generate a consolidated stack configuration file which allows you to install and directly update your system at the
chosen SPS level. The up-to-date installation allows you to select target software level and push archives to the
download basket in a single step.

For a first impression about Maintenance Planner, see https://blogs.sap.com/2015/07/09/maintenance-
planner-2/ ¥ .

To start the up-to-date installation procedure, follow the description in the sections below.
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5.2.1 Up-to-Date Installation Using Maintenance Planner

To initially use Maintenance Planner, follow the instructions in the corresponding user guide. You can find the guide
on the SAP Help Portal at:

http://help.sap.com/maintenanceplanner | Maintenance Planner User Guide 3
(http://wiki.scn.sap.com/wiki/download/attachments/187337812/Maintenance_Planner_User_Guide.pdf#r)

Once you have logged on to Maintenance Planner following the description in the appropriate chapters of the user
guide, you start the up-to-date installation of the AS ABAP-based software components required to run SAP Hybris
Marketing:

e Application Server ABAP (AS ABAP) including all required subcomponents
e SAP Hybris Marketing add-on including all depending subcomponents

For a general step-by-step description of the up-to-date installation process, see https://blogs.sap.com/
2016/10/21/up-to-date-installation-2 .

During the installation process, you select the following components:

e SAP NETWEAVER 7.5 with the latest SPS
o SAPHYBRIS MARKETING 1.2

Caution

In the Select Files step, Maintenance Planner provides you with the Alternative Selection component USER
INTERFACE TECHNOLOGY.

Although the component USER INTERFACE TECHNOLOGY 7.50 with description SAP_UI 750 (recommended) is
preselected, you must deselect this option and select USER INTERFACE TECHNOLOGY 7.51 with description
SAP_UI 751.

Be sure to consider the following during the installation process:

e |nthe Select Files step, ensure that you selected the latest version of the Software Update Manager for your
operating system as this tool is used in the background during the installation process.

Maintenance Planner, in addition, recommends to select the latest versions of Software Provisioning Manager,

SAP Kernel, SAP IGS, and SAP Host Agent for your operating system.

® |nthe Download Files step, you choose the Download Stack XML pushbutton to download the corresponding
XML file as this file is required during the installation process.

® |nthe Download Files step, you choose the Download PDF pushbutton to receive the overview of your
maintenance plan.

1. Once downloaded, open the PDF document.

2. Click the Download Installation/Upgrade Media from SAP Service Marketplace link.

3. The Software Downloads application in the SAP Support Portal opens.

4. Under Installation and Upgrade, verify your operating system and database and select the following entry
in addition: NW 7.5 Installation Export. You can add other entries according to your requirements, for
example, the language files.

The selected entries are added to your already existing download basket created in Maintenance Planner.

5. Atthe end of the process, check your download basket for all required components.
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Installation

To install SAP NetWeaver AS ABAP and SAP Hybris Marketing, follow the instructions in the installation guide for
your operating system (Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.31
to 7.5 on <Your Operating System>: SAP HANA Database). You can find the appropriate guide on the SAP Help
Portal at:

http://help.sap.com/nw75% || Installation and Upgrade ¥ Installation Guide ¥ Installation ¥ Plan and Install
Installation - SAP NetWeaver 7.5-based Systems » Download Page » SAP HANA Database » <Your Operating
System> » ABAP 1

(https://service.sap.com/~sapidb/011000358700000828172012E | SAP HANA Database » <Your Operating
System> ¥ ABAP 1)

1 Note

Make use of the option to add the parameter
SAPINST STACK XML=<Absolute Path To Stack XML File>.

Integrated SAP Web Dispatcher

The use of an SAP Web Dispatcher is mandatory for running SAP Hybris Marketing. To simplify the installation,
SAP recommends to use the integrated SAP Web Dispatcher.

For information on how to install the integrated SAP Web Dispatcher, see section ASCS Instance with Integrated
SAP Web Dispatcher in the installation guide mentioned above.
1 Note
If you already use an SAP Web Dispatcher in your system landscape, you can reuse it for SAP Hybris Marketing

purposes. For the required configuration, see Configuring the SAP Web Dispatcher [page 43].

If you do not want to use the integrated SAP Web Dispatcher or reuse your SAP Web Dispatcher that is already in
use, you can install the SAP Web Dispatcher from scratch. To do so, follow the instructions under:

http://help.sap.com/nw75#% || Installation and Upgrade Information » Additional Installation Information ¥
Installation - Standalone Engines ¥ Installation: Web Dispatcher for SAP NetWeaver 7.1 or Higher ¥ <Your Operating
System> 3

Microsoft Windows: https://service.sap.com/~sapidb/011000358700000877232012E #
Unix: https://service.sap.com/~sapidb/011000358700000851902012E ¥

IBM i: https://service.sap.com/~sapidb/011000358700000877242012E #

5.3 Installing SAPUI5 Tools and ABAP Development Tools

If you want to enhance or change the the SAPUI5-based user interface of SAP Hybris Marketing, then you must
install the required development tools, which are the SAPUI5 Tools integrated development environment (IDE) and
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the SAPUI5 Team Provider, on each client. With the installation of these tools, you also install the ABAP
Development Tools.

For detailed information about the installation process, see the master guide for user interface add-ons for SAP
NetWeaver on the SAP Service Marketplace at:

http:/service.sap.com/instguides# | SAP NetWeaver » User Interface Add-On 1.0 for SAP NetWeaver » Master
Guide for Ul Add-On 1.0 SPS 16 for SAP NetWeaver 3

(https://service.sap.com/~sapidb/011000358700000436252013E #r)

5.4 Installing SAP Smart Business, executive edition

Within SAP Hybris Marketing, the following applications are based on the native SAP HANA application SAP Smart
Business, executive edition:

e Marketing Executive Dashboard
The Marketing Executive Dashboard application contains key performance indicators (KPI), which allow
marketing executives to review the success of marketing investments, and gain an overview of KP| attainment
and marketing performance benchmarks.

® | ead Dashboard
The Lead Dashboard application allows marketing experts to review the success of the lead management
process, and provides them with a comprehensive overview of KPI attainment and lead management
performance benchmarks.

If you want to use one of the applications above, you must install SAP Smart Business, executive edition by
downloading and installing the following component before executing the technical configuration scenarios
Marketing Executive Dashboard (see section Scenario "Marketing Executive Dashboard" [page 59]) or Lead
Management with Cloud for Customer Integration (see section Scenario "Lead Management with Cloud for
Customer Integration" [page 62]).

To do so, proceed as follows:

1. Goto the SAP Software Download Center at https://support.sap.com/swdc .

2. Choose || Installation and Upgrades ¥ Software Downloads # By Alphabetical Index (A-Z) » S 3 and search for
the following component:

o | SAP SBEE FOR HYBRIS MARKETING » SAP SBEE FOR HYBRIS MARKETING 1.0 3

Caution

SAP Smart Business, executive edition is available in a special version for SAP Hybris Marketing. Make sure
that you download the component mentioned above. The component contains two delivery units that you
must install in the following sequence:

o Firstyou install ENTERPRISE COCKPIT CON 100 (HCOEADCON)
o Thenyou install ENTERPRISE COCKPIT FND 100 (HCOEADEND)
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1 Note

After the installation of SAP Smart Business, executive edition and the execution of the corresponding technical
configuration scenario (see above), you must ensure the configuration of SAP Smart Business, executive
edition.

For more information, see section Configuring SAP Smart Business, executive edition [page 86].

5.5 Implementation of SAP Notes Listed in Release
Information Note

To complete the installation process, you must implement all SAP Notes listed in the Release Information Note
(RIN) for SAP Hybris Marketing, number 1885803 #% that have not been implemented before.

You can find the RIN under http://support.sap.com/notes#r, entering the RIN number in the corresponding field
on the screen.

1 Note

Ensure that you have carefully read the RIN before you implement the included SAP Notes. The RIN contains
information about the exact point in time for the implementation of every included SAP Note:

e Before the import of the support package

e Before executing the technical configuration

e After executing the technical configuration

e SAP Note only relevant for a certain solution scope

To install the SAP Notes in the RIN, do the following:

1. Logon tothe back-end SAP NetWeaver system as an administrator. You can log on to the production client of
the application; installing SAP Notes is a client-independent procedure.

2. Use transaction sNOTE to install the SAP Notes in the RIN.
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6 Data Replication

1 Note

This section is relevant only if you have decided to deploy SAP Hybris Marketing separately from your source
system using one of the hub-deployment approaches.

For more information about the various deployment scenarios, see Deployment Scenarios [page 14].

6.1 Installation of SAP Landscape Transformation Replication
Server

To install and set up trigger-based data replication, follow the instructions in the following installation guide in the
SAP Help Portal at:

http://help.sap.com/hana_platform#|p Select "Version: 1.0 SPS 12" in the upper right corner ¥ Installation and
Upgrade ¥ View All ¥ Installation and Upgrade Information » SAP HANA Trigger-Based Data Replication Using SAP
LT Replication Server 3

(https://help.sap.com/http.svc/rc/d6873be224f54celb941e949e0822f81/1.0.12/en-US/
SAP_HANA _Installation_Guide_Trigger_Based_Replication_SLT_en.pdffr)

= Recommendation

SAP recommends to use at minimum the SAP Landscape Transformation Replication Server version 2.0 SP0O5
for SAP Hybris Marketing.

6.1.1 Connection Setup between SAP Hybris Marketing and
SAP LT Replication Server

1. Logontoyour SAP LT Replication Server system.
2. Enter transaction PFCG, and copy the role SAP TUUC_REPL REMOTE. You must enhance the role by the
following authorizations:
o Authorization Object: s RFC
o Activity:16 (Execute)
o Name of RFC to be protected: SDTB, SDIFRUNTIME
o Type of RFC to be protected: FUGR
© Authorization Object: s RFC
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o Activity:16 (Execute)

©  Name of RFC to be protected: SCSI_GET SYSTEM INFO

o Type of RFC to be protected: FUNC

o Authorization Object: s DMIS

o Activity: 02 (Change)

o MBT PCL Scenario: SLOP

o MBT PCL Processing Role Level: PACKAGE
For more information about the maintenance of authorization profiles, see the SAP Help Portal at:
https://help.sap.com/viewer/p/SAP_SAHANA_ON-PREMISE | SAP NetWeaver for SAP S/AHANA » SAP
NetWeaver Library: Function-Oriented View # Security ¥ Identity Management » User and Role Administration
of Application Server ABAP ¥ Reference Documentation for User and Role Administration ¥ Organization
Without the Profile Generator  Creating and Maintaining Authorizations/Profiles Manually ¥ Maintaining

Authorizations and Their Values 3
(https://help.sap.com/viewer/DRAFT/c6e6d078ab99452db94ed7b3b7bbcccf/1709%20000/en-US/
4ca289f2d4233b9ee10000000a42189b.html)

3. Generate the profile of your role and leave transaction PFCG.

4. Enter transaction su01 and create a user with your new role. You use this user in the RFC destination between
your SAP Hybris Marketing system and the SAP LT Replication Server.

5. Logon to your SAP Hybris Marketing system.

6. Enter transaction sM59, and choose the Create menu option in the Edit menu to create a new ABAP
connection between your SAP Hybris Marketing system and your SAP LT Replication Server.

7. Enter your name for the RFC destination. Enter all required information and use the user you created in step 4.

8. Confirm your entries and save the RFC destination. Test the RFC destination using the connection test.

6.1.2 Connection Setup between SAP Hybris Marketing and
SAP Source System

During the installation of SAP Landscape Transformation Replication Server you have installed the SAP Landscape
Transformation add-on on your SAP source system. To enable the replication between your SAP Hybris Marketing
system and your SAP source system, you must create an RFC destination. To do so, execute the following steps:

1. Logon to your SAP source system.
2. Enter transaction PFCG, and copy the role SAP_TUUC_REPL REMOTE. You must enhance the copied role by the
following authorizations:
© Authorization Object: s RFC
o Activity: 16 (Execute)
© Name of RFC to be protected: SDTB, SDIFRUNTIME
o Type of RFC to be protected: FUGR
For more information about the maintenance of authorization profiles, see the SAP Help Portal at:
https:/help.sap.com/viewer/p/SAP_S4HANA_ON-PREMISE |[p SAP NetWeaver for SAP S/4HANA » SAP
NetWeaver Library: Function-Oriented View ¥ Security ¥ Identity Management » User and Role Administration
of Application Server ABAP » Reference Documentation for User and Role Administration » Organization
Without the Profile Generator » Creating and Maintaining Authorizations/Profiles Manually » Maintaining

Authorizations and Their Values 3

Installation and Configuration Guide 1702
Data Replication CUSTOMER 31


https://help.sap.com/viewer/p/SAP_S4HANA_ON-PREMISE
https://help.sap.com/viewer/DRAFT/c6e6d078ab99452db94ed7b3b7bbcccf/1709%20000/en-US/4ca289f2d4233b9ee10000000a42189b.html
https://help.sap.com/viewer/DRAFT/c6e6d078ab99452db94ed7b3b7bbcccf/1709%20000/en-US/4ca289f2d4233b9ee10000000a42189b.html
https://help.sap.com/viewer/p/SAP_S4HANA_ON-PREMISE
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3. Generate the profile of your role and leave transaction PFCG.

4. Enter transaction su01 and create a user with your new role. You use this user in the RFC destination between
your SAP Hybris Marketing system and your SAP source system.

5. Log on to your SAP Hybris Marketing system.

6. Enter transaction sM59, and choose the Create menu option in the Edit menu to create a new ABAP
connection between your SAP Hybris Marketing system and your SAP source system.

7. Enter your name for the RFC destination. Enter all required information and use the user you created in step 4.

8. Confirm your entries and save the RFC destination. Test the RFC destination using the connection test.

6.1.3 Basic Configuration of Data Replication

You must create a basic configuration for all source systems from which you want to replicate data to your SAP
Hybris Marketing system. To do so, follow the instructions in section Creating a Configuration of the Application
Operations Guide for SAP Landscape Transformation Replication Server. You find this Application Operations
Guide on the SAP Help Portal at:

http://help.sap.com/hana_platform# | Select "Version: 1.0 SPS 12" in the upper right corner ¥ Administration
System Administration and Maintenance Information » Application Operations Guide — Trigger-Based Data
Replication Using SAP LT Replication Server for SAP HANA

(https://help.sap.com/http.svc/rc/ef98691bbce6494b9b7b9b05d1ef197f/1.0.12/en-US/
SAP_Landscape_Transformation_for_SAP_HANA_Operations_Guide_en.pdfi)

The technical configuration (see Using the Technical Configuration Cockpit [page 52]) automatically adjusts this
configuration and adds the required tables (see also the Replicated Tables sections in the Appendix [page 142]).
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7 Post-Installation

After you have installed all the components that you need to run the SAP Hybris Marketing application and have
implemented all relevant SAP Notes from the RIN 1885803, carry out the following technical configuration
steps. You find these steps listed in the following sections.

Caution

e Make sure that you carry out the following post-installation steps in the same client in which you want to run
the SAP Hybris Marketing application.

® The sequence of the post-installation steps reflected by the following sections depends on the role of
system, in which you execute the installation: The sequence in the development system differs from the
sequence in the production system.
For more information, see the graphic below.

1 Note

During the following post-installation process executed in your development system, transport requests are
created, which contain generated objects and Customizing entries. While some of the requests are created
automatically by the technical configuration cockpit, you need to create other requests manually.

After testing, the transport requests are imported into the production system in a specific sequence (see
Applying Technical Configuration Artifacts to Production System [page 67]).

When you carry out the installation in the production system, the technical configuration cockpit automatically
skips the tasks that no longer need to be carried out, due to the import of transport requests from the
development system.
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Figure 7: Post-Installation Process Flow for Development and Production Systems

71 Application Configuration and Customizing

7.1.1 Initial Customizing Adjustment

With the installation of SAP Hybris Marketing (see Installation of AS ABAP and SAP Hybris Marketing [page 25]),
Customizing is installed only in client 000 of your SAP NetWeaver system. To ensure the availability of all relevant
Customizing in your productive client, we recommend to create this client via client copy from client 000. During
the client copy process, select a copy role, which ensures that Customizing is copied. Note that all application data

is erased during the copy procedure.

1 Note

Ensure that the SAP Hybris Marketing add-on is installed before executing the client copy. If the SAP Hybris
Marketing add-on is not installed the Customizing to be copied is not available.
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For more information, see the SAP Help Portal under:

http://help.sap.com/nw75% || Operations » Technical Operations for SAP NetWeaver » Administration of
Application Server ABAP » Change and Transport System » BC - Client Copy and Transport (BC-CTS-CCO) »
Client Copier 3

(https://help.sap.com/viewer/4a368c163b08418890a406d413933ba7/7.5.6/en-US/
4d7cel5219a00f88e10000000a42189b.htm| k)

7.1.2 Customizing via SAP Solution Manager

You execute the configuration for SAP Hybris Marketing with the help of SAP Solution Manager 7.1, SPO5 or higher.
In your Solution Management system, you can find the corresponding business scenario group, named SAP Hybris
Marketing under Applications Powered by SAP HANA in transaction SOLARO1.

1 Note

Make sure that you implemented ST 1CcO 150 700 SP046 to access the required content.

More Information

e For anintroduction to the use of the SAP Solution Manager content, see the SAP Help Portal at:

http://help.sap.com/crm702#% | Configuration » SAP Solution Manager Content J
(http://help.sap.com/content/documentation/solutionmanager/DISPLAYSOLMANCONTENT.pdf#)

e For detailed information on executing application configuration via SAP Solution Manager, see the SAP Help
Portal at:

http://help.sap.com/solutionmanager# | Select "Version: 7.1 SPS 14" in the upper right corner » Application
Help » Application Help <your_language> ¥ Solution Implementation }» Implementation/Upgrade Work Center

» Business Blueprint 3
(https://help.sap.com/saphelp_sm71_spl4/helpdata/en/45/f6da633a292312e10000000a11466f/
frameset.htmes)

7.2 Configuring the SAP HANA Database

7.2.1 Configuring SSL for SAP HANA XS Engine

Set up secure communication between Web-based clients and SAP HANA Extended Application Services.
This secure communication is required for the following SAP Hybris Marketing applications and features:

e Applications and features in the context of the SAP HANA rules framework (see section Scenario "HANA Rules
Framework" [page 58])
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e Applications and features in the context of SAP Smart Business, executive edition (see sections Scenario
"Marketing Executive Dashboard" [page 59] and Configuring SAP Smart Business, executive edition [page
36])

For information and how to establish the secure communication, see the following instructions in the SAP HANA
documentation:

e Chapter Secure Communication Between SAP HANA XS Classic and HTTP Clients in the SAP HANA security
guide under:
http://help.sap.com/hana_platform | Select "Version: 1.0 SPS 12" in the upper right corner » Security » SAP
HANA Security Guide ¥ SAP HANA Network and Communication Security # Securing Data Communication
Secure Communication Between SAP HANA XS Classic and HTTP Clients 3

(https://help.sap.com/viewer/b3ee5778bc2e4a089d3299b82ec762a7/1.0.12/en-US/
ddcc0645464a4a2b8b3eead269ea09d7.html)

e Chapter Configure HTTPS (SSL) for Client Application Access in the SAP HANA administration guide under:
http://help.sap.com/hana_platform |l Select "Version: 1.0 SPS 12" in the upper right corner ¥ Administration
SAP HANA Administration Guide » Maintaining the Application Services Run-Time Environment » Maintaining
the SAP HANA XS Classic Model Run Time » Maintaining HTTP Access to SAP HANA » Configure HTTPS (SSL)

for Client Application Access 4
(https://help.sap.com/viewer/6b94445c942ae495c83a19646e7c¢3fd56/1.0.12/en-US/
d33b259c567441aa97e99228dc0f2088.html)

You must establish a trust relationship between your AS ABAP server and your SAP HANA database later on. For
this reason, you either export the certificate of your SAP HANA server or the Certificate Authority (CA) root
certificate, which has been used to sign the SAP HANA server certificate. Provide the certificate to the AS ABAP
administrator who performs the SSL setup of the AS ABAP system.

= Recommendation

You can display and copy the certificates of the SAP HANA server to the file by connecting your internet browser
to the address https://<host name of SAP HANA server>:43<instance number>, and choosing the lock symbol
in the address bar.

For more information, see SAP Note 1094342 #r.

7.2.2 SAP HANA User for Technical Configuration

During the technical configuration of SAP Hybris Marketing, several actions must be executed on the SAP HANA
database which require different authorizations. To ensure that all of these authorizations are available, run the
following script to create a user with sufficient authorization for carrying out the SAP Hybris Marketing technical
configuration on the SAP HANA database.

1 Note
The SAP HANA authorizations required during business usage are granted to the AS ABAP user (SAP<SID>).

You can deactivate the user after successful completion of the technical configuration for the installation of SAP
Hybris Marketing. You must reactivate the user again when performing technical configuration such as upgrade
activities.
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Proceed as follows:

1. Logontothe SAP HANA studio with the sYSTEM user.
2. Open the SQL console.
3. Copy the script below into the SQL console. If there are more than one, choose the correct database

connection.

4. Choose Execute (F8).
5. Check the log to see if all steps were carried out successfully.

1 Note

e |f you want to copy and paste the SQL statements below, ensure that all blank characters are copied

accurately.

e After running the script, you must ensure the following:

e o C(Checkif every single statement is successfully executed.

o Log off and log back on again in order to change the initial password.

CREATE USER TC USER PASSWORD Initiall234;

-- object privileges
"GRANT ACTIVATED ROLE" TO TC USER WITH GRANT OPTION;

i ) TO TC USER WITH GRANT OPTION;

"GRANT PRIVILEGE ON ACTIVATED CONTENT" TO TC USER WITH GRANT

GRANT EXECUTE
GRANT EXECUTE
GRANT EXECUTE
OPTION;

GRANT EXECUTE
OPTION;

GRANT EXECUTE
GRANT EXECUTE
GRANT EXECUTE
GRANT OPTION;
GRANT EXECUTE
GRANT OPTION;
GRANT EXECUTE
GRANT EXECUTE
GRANT
GRANT UPDATE,
GRANT
GRANT
GRANT
GRANT
GRANT
GRANT
CALL
"~ 'TC_USER') ;
CALL

SYS REPO.GRANT ACTIVATED ROLE ('sap.hana.

"TC USER');

ON
ON
ON

ON
ON
ON
ON
ON

ON
ON

"REVOKE ACTIVATED ROLE"

"REVOKE PRIVILEGE ON ACTIVATED CONTENT" TO TC USER WITH GRANT

"GRANT APPLICATION PRIVILEGE" TO TC USER WITH GRANT OPTION;
"REVOKE APPLICATION PRIVILEGE" TO TC USER WITH GRANT OPTION;
"GRANT SCHEMA PRIVILEGE ON ACTIVATED CONTENT" TO TC USER WITH

"REVOKE SCHEMA PRIVILEGE ON ACTIVATED CONTENT" TO TC USER WITH

"AFL WRAPPER GENERATOR" TO TC USER WITH GRANT OPTION;
"AFL WRAPPER ERASER" TO TC USER WITH GRANT OPTION;

SELECT ON SCHEMA "_SYS_ﬁEPO" TO TC_USER WITH GRANT OPTION;

SELECT ON " SYS XS"."SQL CONNECTIONS" TO TC USER;
-- system privileges

"CREATE R SCRIPT"

"DATA ADMIN"

SYS REPO.GRANT ACTIVATED ROLE ('sap.hana.
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TO TC USER WITH ADMIN OPTION;
"CREATE STRUCTURED PRIVILEGE" TO TC USER WITH ADMIN OPTION;
"CREATE SCHEMA" TO TC USER WITH ADMIN OPTION;
"ROLE ADMIN" TO TC USER WITH ADMIN
TO TC USER WITH ADMIN
"USER ADMIN" TO TC USER WITH ADMIN

OPTION;
OPTION;
OPTION;

xXs.admin.roles

xs.admin.roles

::RuntimeConfAdministrator'

: :SQLCCAdministrator’',
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7.2.3 Authorization Settings for Deployment Scenario C: Hub-
Deployment with Shared SAP HANA System of SAP
Business Suite

1 Note

You follow the instructions in this section if you have decided to run deployment scenario C, Scenario C: Hub-
Deployment with Shared SAP HANA System of SAP Business Suite [page 17]. If you have chosen deployment
scenario C, carry out the following steps. If not, proceed with section 7.3.

7.2.3.1 Authorization Enhancement for _SYS_REPO User

Checkifuser sys REPO has SELECT authorization on your embedded SAP ERP or SAP CRM system:

1. Logon tothe SAP HANA studio with a user that is allowed to view the authorizations of user _SYs REPO, for
example, the sap<s1D> user of your embedded SAP ERP or SAP CRM system.
If you are familiar with the SQL Console you can run the following command:

SELECT DISTINCT PRIVILEGE, IS GRANTABLE, IS VALID FROM SYS.EFFECTIVE PRIVILEGES

WHERE USER NAME = ' SYS REPO' AND SCHEMA NAME = '<schema name of your embedded
SAP ERP or SAP CRM> ' AND PRIVILEGE = 'SELECT' AND IS GRANTABLE = 'TRUE' AND
IS VALID = 'TRUE'

If you get a result, the user _sys REPO is allowed to select data from the schema of your embedded SAP ERP
or SAP CRM system.

If you are not familiar with the SQL Console choose the Modeler perspective in the upper right corner.

In the Navigator section on the left, expand the folder of your SAP HANA database.

Expand the corresponding Security folder and the Users folder.

Double-click the sYS REPO user.

S e A

On the Granted Roles tab check if role ABAP _SYS REPO is assigned. If the role is assigned, double click the
role. The role will be opened in a new tab.

7. Navigate to Object Privileges tab. Check that the schema of your embedded deployed SAP ERP or SAP CRM
system is displayed and marked as Grantable to others.

If you cannot find the SELECT authorization for your embedded deployed SAP ERP or SAP CRM system add the
following authorizations to the sYs REPO user of your SAP Hybris Marketing system:

1. Logontothe SAP HANA studio with the sAP<sID> user of your embedded deployed SAP ERP or SAP CRM
system.

Choose the Modeler perspective in the upper right corner.

In the Navigator section on the left, expand the folder of your SAP HANA database.

Expand the corresponding Security folder and the Users folder.

Double-click the SYS REPO user.

In the center section, choose the Object Privileges tab, and choose the + pushbutton.

In the following Select Catalog Object dialog box, search for the schema of your embedded deployed SAP ERP
or SAP CRM system.

N O oA WD
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8. Select the privilege SELECT and the corresponding Grantable to Others option.
9. Savethe Sys REPOuser.

The SELECT authorization is required for SAP HANA content activation. The sSyS REPO user is a system user that
actually activates the SAP HANA content regardless of which user started the activation. The user takes all models
and creates the corresponding runtime objects. After having activated all models the sys REPO user grants read
access to the activated models to the user that started the activation. For this reason, the Grantable to Others
optionis required.

More Information

For more information about granting privileges to users, see the SAP HANA Developer Quick Start Guide, section
Grant Privileges to Users in the SAP HANA Studio under Setting Up Roles and Privileges. See the SAP Help Portal at:

http://help.sap.com/hana_platforme | Development » SAP HANA Developer Quick Start Guide 3

(https://help.sap.com/viewer/400066065alb46cf91df0ab436404ddc/1.0.12/en-US/
¢719b2e7d9761014b9d798770c3d0958.htm )

7.3 Profile Parameter Settings

SAP Hybris Marketing requires several profile parameter settings, for example, to set up HTTPS connections.

After you have set the required profile parameters, restart your system to make the parameter changes effective.

7.3.1 Configuring HTTPS

We recommend to realize the communication of the SAP Web Dispatcher (see subsection Integrated SAP Web
Dispatcher in section Up-to-Date Installation Using Maintenance Planner [page 26]) with the SAP NetWeaver
system via HTTPS.

To prepare the system for HTTPS communication, log on with the User for Application Setup [page 47], go to
transaction RZ10, and configure an HTTPS port in the instance profile of the system.

The following example shows how these parameters may be set:

Example

icm/server port 1 = PROT=HTTPS, PORT=443$$

For more information, see the SAP Help Portal at:

http://help.sap.com/nw75#% | Application Help » Function-Oriented View » Application Server » Application
Server Infrastructure » Components of SAP NetWeaver Application Structure ¥ Internet Communication Manager
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(ICM) - SAP NetWeaver » Administration of the ICM-SAPNetWeaver » ICM Parameters -Reference for ABAP and
Java 3

(https://help.sap.com/viewer/bd78479f4da741a59f5e2a418bd37908/7.5.7/en-US/
264e0677t391432fb0af513731bbf58d.htmi k).

7.3.2 Configuring the Secure Sockets Layer Protocol

To secure HTTP connections to and from the SAP NetWeaver system you use the Secure Sockets Layer (SSL)
protocol.

To configure SSL, follow the instructions of the documentation in the SAP Help Portal at:

http://help.sap.com/nw75% |+ Application Help » Function-Oriented View ¥ Security » Network and Transport
Layer Security » Transport Layer Security on the AS ABAP » Configuring the AS ABAP to Support SSL 3

(https://help.sap.com/viewer/e73bba71770e4cOcabfb2a3cl7e8e229/7.5.7/en-US/
4923501ebf5a1902e10000000a42189c.html)

1 Note

You can check whether the SAP Cryptographic Library software is already installed in your system by doing the
following:

1. Gototransaction STRUST.

2. Choose |r Environment ¥ Display SSF_Version 3. If the system response shows that the SAPCRYPTOLIB is
installed, then you can skip the installation step for the Cryptographic Library in the documentation cited
above.

74 Displaying the SAP Online Documentation

SAP currently provides an HTML-based solution for the online documentation, including the Application Help, the
Web Assistant, Glossary, Implementation Guide (IMG), and Release Notes. You can display the documentation
with a JavaScript-compatible Web browser on all front-end platforms supported by SAP.

To ensure the display of the online documentation in SAP Hybris Marketing, you must do the following:

e Considering documentation-relevant parameters in your SAP Web Dispatcher configuration
e FEnabling context-sensitive user assistance in your AS ABAP system
e Setting up the User Assistance Plugin
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Considering Documentation-Relevant Parameters in the SAP Web Dispatcher
Configuration

If you want to make context-sensitive user assistance available in the SAP Fiori launchpad, you must configure the
SAP Web Dispatcher. The steps to be executed are included in the section about the SAP Web Dispatcher
configuration, see section Considering Documentation-Relevant Parameters in Configuring the SAP Web
Dispatcher [page 43].

Enabling Context-Sensitive User Assistance in Your AS ABAP System

You need to do these settings in the AS ABAP system which you use to create your system configuration setting.
After you have done the settings, you save them, create a transport for them, and transport them to your
productive system(s).

Proceed as follows:

Open transaction sr13.
2. Select the tab PlainHtmIHttp.
3. Choose New Entry. Enter the following values:

Table 9:
Name Value to Be Entered
Variant Enter a name for the variant (any name).
Platform Select the platform relevant for your implementation, for example, NONE.
Area Select XML Documentation.
This will display as XML_DOCU in the table.
Server Name Enterhttps://help.sap.com/http.svec/ahp2/
Path Enter SAP_HYBRIS_MARKETING/1702%ZOYMKT
Language Select the language you need.
Default Select one entry as default per platform.

4. Repeat step 3 for each relevant platform and language.
5. Save your changes and create a transport.
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Setting up the User Assistance Plugin

To make context-sensitive user assistance available in the SAP Fiori launchpad, you set up the user assistance
plugin as follows:

1. You create a catalog.
For information about creating catalogs, see the documentation about the SAP Fiori Launchpad on SAP Help
Portal at:
https://help.sap.com/nw75%% |+ Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750
SAP Fiori Launchpad » Setting Up Launchpad Content » Best Practices for Setting Up Content » Configure
Custom Catalogs and Groups 3
(https://help.sap.com/viewer/cclc7615ee2f4a699a9272453379006¢/7.5.6/en-US/
af35d42e7d4f49d7b8e46080cd01c299.html )

2. You create arole that references the catalog.
For more information about creating roles for tile catalogs, see the documentation about the SAP Fiori
Launchpad on SAP Help Portal at:
https://help.sap.com/nw75¢% |+ Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750
SAP Fiori Launchpad ¥ Setting Up Launchpad Content » Configuring Authorization Roles » Configuring Roles
for Tile Catalogs and Groups # Configure Roles for Tile Catalogs 3
(https://help.sap.com/viewer/cclc7615ee2f4a699a9272453379006¢/7.5.6/en-US/
90d6b4e61091405e99bad598ee654eff.html)

3. You assign the role to every user that needs to access the context-sensitive user assistance.

4. Inthe catalog, you create a target mapping with the following values:

Table 10:

Field Label Value

Semantic Object Shell

Action plugin

Application Type SAPUI5 Fiori App

Title User Assistance Plugin

URL /resources/sap/dfa/help/utils/adapters/fiori
This requires that the SAP Web Dispatcher is set up accordingly so that this URL is
routed to the script server.

Component sap.dfa.help.utils.adapters.fiori

Information User Assistance Plugin, relevant for all app users
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Field Label Value

Device Types Select your devices:

o Desktop
o Tablet

o Phone

Parameters Enter the following parameters in the table:
o Name: product; Default Value: SAP_HYBRIS MARKTING
o Name: version; Default Value: 1702 YMKT

o Name: editor; Default Value: £alse

After you have made these setting, the user assistance icon is available for the SAP Fiori launchpad.

7.5 Configuring the SAP Web Dispatcher

SAP Hybris Marketing comprises both ABAP-based applications and SAP HANA Extended Application Services
(SAP HANA XS) applications .For this reason, SAP Hybris Marketing requires an SAP Web Dispatcher due to the
same origin policy of browsers. In addition, the SAP Web Dispatcher is required to display and use the Web
Assistant, an integrated help system that provides context sensitive user assistance.

To configure the SAP Web Dispatcher you must set up a few communication channels. To do so, proceed as
follows.

Communication Between SAP Web Dispatcher and Clients

To configure the communication between clients (for example, your browser) and the SAP Web Dispatcher, follow
the instructions under http://help.sap.com/fiori_bs2013# | System Landscape Required for SAP Fiori » Setup of
SAP Fiori System Landscape with SAP HANA Database » Communication Channels » Communication Between
Client and SAP Web Dispatcher ¥ Configuring Communication Channel between Clients and SAP Web

Dispatcher .

(http://help.sap.com/fiori_bs2013/helpdata/en/f8/0f4453d2e57425e10000000a44176d/content.htm)

As a result, your SAP Web Dispatcher will support HTTPS connections. Keep your HTTPS port in mind.

Communication Between SAP Web Dispatcher and AS ABAP

To configure the communication between the SAP Web Dispatcher and the SAP Hybris Marketing AS ABAP server,
follow the instructions in sections Defining Routing Rules for SAP Web Dispatcher and ABAP Front-End, Defining
Routing Rules for SAP Web Dispatcher and ABAP Backend, and Configuring Trust Between SAP Web Dispatcher and
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ABAP Servers under http:/help.sap.com/fiori_bs2013#% |p System Landscape Required for SAP Fiori # System
Landscape ¥ Setup of Fiori System Landscape with SAP HANA Database » Communication Channels »
Communication Between SAP Web Dispatcher and ABAP Servers 3.

(http://help.sap.com/fiori_bs2013/helpdata/en/49/e243539b47e344e10000000a423f68/content.htm )
Your SAP Hybris Marketing server is the AS ABAP front-end and back-end server.

Communication Between SAP Web Dispatcher and SAP HANA XS

To set up communication between the SAP Web Dispatcher and SAP HANA Extended Application Services, follow
the instructions under http://help.sap.com/fiori_bs2013#& | System Landscape Required for SAP Fiori ¥ System
Landscape » Setup of Fiori System Landscape with SAP HANA XS » Communication Channels » Communication
Between SAP Web Dispatcher and SAP HANA XS 1.

(http://help.sap.com/fiori_bs2013/helpdata/en/49/e243539b47e344e10000000a423f68/content.htm)

1 Note

The communication paths for communication between the SAP Web Dispatcher and the SAP HANA Extended
Application Services must be disjunct to be paths for communication between the SAP Web Dispatcher and the
SAP Hybris Marketing AS ABAP server.

When you define the routing rules between SAP Web Dispatcher and SAP HANA Extended Application Services,
add /sap/hana-app and /sap/uib as arouting rule.

During configuration a number of changes are made to the SAP Web Dispatcher profile. The following list shows a
sample profile after configuration.

Example

1 Note

The example does not ensure the proper run of the SAP Web Dispatcher in your system. Adapt your settings
according to your specific system requirements.

Sample Code

SAPSYSTEMNAME = WEB
SAPSYSTEM = 02
INSTANCE NAME = W02
DIR CT RUN = $(DIR EXE ROOT)$ (DIR SEP)$ (OS UNICODE)$ (DIR SEP)linuxx86 64
DIR EXECUTABLE = $(DIR CT RUN)
DIR PROFILE = $(DIR_INSTALL)/profile
PF = $(DIR PROFILE) /WEB W02 mo-29b02fleb

SETENV 00 = DIR LIBRARY=5 (DIR LIBRARY)

SETENV_01 = LD LIBRARY PATH=$ (DIR LIBRARY) :% (LD LIBRARY PATH)

SETENV_ 02 = SHLIB PATH=$ (DIR LIBRARY) :% (SHLIB_ PATH)

SETENV_03 = LIBPATH=$ (DIR LIBRARY) :% (LIBPATH)

SETENV 04 = PATH=$ (DIR EXECUTABLE) :% (PATH)

# _______________________________________________________________________

# Accessibility of Message Server
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rdisp/mshost = mo-29b02fleb
ms/http port = 8100

icm/max_conn = 500
icm/max_sockets = 1024
icm/req queue len = 500
icm/min_threads = 10
icm/max_threads = 50
mpi/total size MB = 80

icm/server port 0 = PROT=HTTP, HOST=mo-29b02fleb, PORT=81$$
icm/server port 1 = PROT=HTTPS,HOST=mo-29b02fleb, PORT=82$$
icm/HTTP/admin 0 = PREFIX=/sap/admin, DOCROOT=$ (DIR DATA)$ (DIR SEP)
icmandir, AUTHFILE=S (icm/authfile), PORT=81$5;82$$

WD = wd.sap$ (SAPSYSTEMNAME) S (INSTANCE NAME)

Execute 00 = local rm -f $( WD)

Execute 01 = local 1ln -s -f $(DIR EXECUTABLE)/sapwebdisp$ (FT_EXE) $( WD)
Start Program 00 = local $( WD) pf=$(_ PF)

SETENV_05 = SECUDIR=$ (DIR INSTANCE) /sec

wdisp/ping protocol = https

wdisp/group info protocol = https

wdisp/url map protocol = https

ssl/ssl 1lib = /usr/sap/WEB/SYS/exe/nuc/linuxx86 64/libsapcrypto.so
ssl/server pse = /usr/sap/WEB/W02/sec/sapssls.pse

icm/HTTPS/verify client = 0

ssl/client pse = /usr/sap/WEB/W02/sec/sapssls.pse

wdisp/ssl_encrypt = 1

wdisp/ssl auth = 2

wdisp/ssl cred = /usr/sap/WEB/W02/sec/sapssls.pse
icm/HTTPS/forward ccert as header = true

wdisp/system conflict resolution = 1

wdisp/add client protocol header =
wdisp/handle webdisp ap header = 1
wdisp/add xforwardedfor header = t

wdisp/system 0 = SID=NWl, NR=01, MSHOST=mo-29b02fleb.mo.sap.corp, MSPORT=8100,
SRCURL=/sap/opu;/sap/bc;/sap/public;/sap/es;/sap/cuan;/sap/ushell config

wdisp/system 2 = SID=HNA, EXTSRV=https://mo-02d2d957f.mo.sap.corp:4300,
SRCURL=/sap/hba; /sap/hana; /sap/hana-app;/sap/uib; /sap/ead; /sap/bi

wdisp/system <number> = SID=<SID1>, EXTSRV=https://cp.hana.ondemand.com,
SRCURL=/sap/dfa/help/, SRCSRV=*:*, STANDARD COOKIE FILTER=OFF

wdisp/system <number> = SID=<SID2>, EXTSRV=https://xray.hana.ondemand.com,
SRCURL=/resources/sap/dfa/help/, SRCSRV=*:*, STANDARD COOKIE FILTER=OFF
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Considering Documentation-Relevant Parameters

If you want to make context-sensitive user assistance available in the SAP Fiori launchpad, you must configure the
SAP Web Dispatcher.

1. Adjust the SAP Web Dispatcher profile file.

Inthe sapwebdisp pf.txt file, add the following parameters:

o For the User Assistance Content Platform:
wdisp/system <number> = SID=<SID1>, EXTSRV=https://cp.hana.ondemand.com,
SRCURL=/sap/dfa/help/, SRCSRV=*:*,6 PROXY=<your proxy>:<your proxy port>,
STANDARD COOKIE FILTER=OFF

o For the script server in your production system:
wdisp/system <number> = SID=<SID2>, EXTSRV=https://xray.hana.ondemand.com,
SRCURL=/resources/sap/dfa/help/, SRCSRV=*:*, PROXY=<your proxy>:<your Proxy
port>, STANDARD COOKIE FILTER=OFF

1 Note

o Make sure that the numbers following wdisp/system are smaller than the numbers that you use for
all your application server. The rules for the context-sensitive user assistance need to come before the
rules for the application servers.

o Make sure that the SIDs are not the same as your system IDs.

2. Activate the usage of the modification handler:
icm/HTTP/mod 0 = PREFIX=/, FILE=$(DIR PROFILE)/redirect.txt

For more information about the profile parameter, see SAP Help Portal at:

http://help.sap.com/nw75 | Application Help » Function-Oriented View j» Application Server » Application
Server Infrastructure » Components of SAP NetWeaver Application Server » SAP Web Dispatcher
Administration of the SAP Web Dispatcher » SAP Web Dispatcher Parameters - Reference ¥ icm/HTTP/
mod_<xx> 4

https://help.sap.com/viewer/683d6al797a34730a6e005d1e8de6f22/7.5.7/en-US/
6ad519e582334d94a3372e9992680e33.html

3. Adjust the SAP Web Dispatcher redirect file:
Inthe redirect. txt file, add the following parameters:

Code Syntax

# User Assistance Content Platform - rewrite rule
if ${SID} = <SIDl1>

begin

SetHeader HOST cp.hana.ondemand.com
RegRewriteRawUrl ~/sap/dfa/help/(.*) /dps/$1

end

# Script Server - rewrite rule
if ${SID} = <SID2>

begin

SetHeader HOST xray.hana.ondemand.com

RegRewriteRawUrl */resources/sap/dfa/help/(.*) /xRayControls/resources/sap/dfa/
help/$1

end
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1 Note

Make sure that the SIDs in the redirect. txt file are the same as in the sapwebdisp cf.txt file.

Restart of SAP Web Dispatcher

After you have made these changes, restart your SAP Web Dispatcher.

7.6 Prerequisites in AS ABAP System

Before you carry out the technical configuration, you need to do the following:

e Allow system changes to the relevant clients
e C(Create development packages (development and configuration system only)

7.6.1 User for Application Setup

For the technical configuration of SAP Hybris Marketing, system settings must be changed and application setup
steps must be performed. You therefore need an application user that can carry out the following tasks:

e Change client settings.
e C(Create a development package.

e Start the technical configuration in the Technical Configuration Cockpit, which sets up the application
environment that is, for example, relevant for the activation of ICF services.

e Set profile parameters.

To ensure an error-free configuration procedure, the user in the production client of your AS ABAP system needs
the following set of roles.

Table 11:
Role You need to
Z RT GW_USER Create the role, then assign it to the application setup user.
SAP MARKETING TECHNICAL CONF Assign it to the application setup user
SAP CUSTOMER ANALYTICS ADMIN Assign it to the application setup user.
SAP_BC_CTS_ADMIN Assign it to the application setup user.
SAP BC SIW DEV Assign it to the application setup user.
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SAP BC WEBSERVICE ADMIN TEC Change the role, then assign it to the application setup user.
SAP BC DB ADMIN Change the role, then assign it to the application setup user.
SAP_BC BASIS ADMIN Change the role, then assign it to the application setup user.
SAP CEI KUA If you want to use SAP Smart Business, executive edition for running the Mar-

keting Executive Dashboard or the Lead Dashboard (see Configuring SAP
Smart Business, executive edition [page 86]), copy this role, then assign it
to the application setup user.

In the following, you find information about how to create a specific user with the required roles.

Proceed as follows:

Create Role Z_RT_GW_USER

In order to start external services, you first need to create a new single role and clear your cache:

Go to transaction PFCG and create a new role.

Choose the Change Authorization Data pushbutton in the Maintain Authorization Data and Generate Profiles
section on the Authorizations tab.

When entering the Change Role: Authorizations screen you are provided with a list of templates. Select the
following template:/IWFND/RT GW_USER. Choose Adopt References.
You see a yellow light for the Cross-application Authorization Objects node. Drill down to | Check at Start of

External Services j Check at Start of External Services 7 by expanding the corresponding nodes.
Open Program, transaction or function in edit mode. In the dialog box that appears, select TADIR Service
and then choose the Full Authorization pushbutton. Save your entries.

6. Choose the + Manually pushbutton, add the s USER_GRP authorization object, and choose Continue.

9.

Under the Basis: Administration node, expand the User Master Maintenance: User Groups
(S_USER_GRP) )node.

Set the following values for the User Master Maintenance: User Groups (S_USER_GRP) authorization object:
1. Open Activity (ncTVT) in edit mode and choose the Full authorization pushbutton. Save your entries.

2. Open User group in user master maintenance (CLASS) in edit mode and choose the Full authorization
pushbutton. Save your entries.
Choose the + Manually pushbutton, add the /U12/CcHIP authorization object, and choose Continue.

10. Under the Basis: Administration node, expand the Page Building Service: CHIP node.

11. Set the following values for the Page Building Service: CHIP (/U12/CHIP) authorization object:

1. Open Web Dynpro ABAP: CHIP ID (/u12/CHIP)inedit mode and set the value to x-SAP-UI2*. Save your
entries.
2. Open Activity (aCcTVT) in edit mode and check the value 06 (Delete). Save your entries.

12. Generate a profile for the authorizations.

48
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Change Standard Roles

Make changes to the following roles:

® Role sAP BC WEBSERVICE ADMIN TEC:
Calluprole SAP BC WEBSERVICE ADMIN TEC intransaction PFCG in change mode.

2. Switch to the Authorizations tab and choose the Change Authorization Data pushbutton under Maintain
Authorization Data and Generate Profiles .

3. Expand node Basis: Administration, then node SOAP Runtime: Web Service Provider Configuration
(authorization object s SRT CF_P). In field Activity, add the value 01 (Create).

4. Save the changes and generate the profile.
® Role sAp_BC DB _ADMIN must be enhanced by the authorization for table access:
1. Calluprole sap_ BC DB ADMIN in transaction PFCG in change mode.

2. Switch to the Authorizations tab and select the Change Authorization Data pushbutton under Maintain
Authorization Data and Generate Profiles .

3. Expand the Basis: Administration node, then expand the Table Access via Generic Standard Tools node
(authorization object s TABU NaM). In field Activity, add the values 02 (Change) and 03 (Display).

4. Regenerate the profile. Check if a user comparison is required.

® RolesaP BC BASIS_ ADMIN must be enhanced by the authorization to access the Trust Manager for SSL
setup purposes:

1. Calluprole sap BC BASIS ADMIN intransaction PFCG in change mode.

2. Switch to the Authorizations tab and choose the Change Authorization Data pushbutton under Maintain
Authorization Data and Generate Profiles.

3. Expand the Cross-application Authorization Objects node, then expand the Transaction Code Check at
Transaction Start node.

Choose the + Manually pushbutton. Enter the authorization object S TCODE and choose Execute.
Now choose the Edit pushbutton next to the transaction code you just created.
In field 'From’, enter STRUST, then save.

N o oo

Regenerate the profile. Check if a user comparison is required.

Create a User for Application Setup and Assign the Relevant Roles

Before you assign a single role to a user you have to ensure that its role profile is generated.

To do this, call up the role in transaction PFCG in change mode, switch to the Authorizations tab and choose the
Change Authorization Data pushbutton under Maintain Authorization Data and Generate Profiles. Then choose the
pushbutton Generate.

For more information about profile generation, see the SAP Help Portal at:
http://help.sap.com/nw75%% ||» Application Help ¥ SAP NetWeaver Library: Function-Oriented View # Security #

Identity Management » User and Role Administration of Application Server ABAP » Configuration of User and Role

Administration » Role Administration » Role Administration Functions » Generating Authorization Profiles 3

(https://help.sap.com/viewer/c6e6d078ab99452db94ed7b3b7bbcccf/7.5.7/en-US/
739317502¢729d38e10000000a44176d.htm| )
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1 Note

Remember to also generate profiles for the single roles included in composite role
SAP MARKETING TECHNICAL CONF.

Now, create a user for application setup and assign the following roles.

1. Gototransaction su01 to create a new user of type Dialog (see tab Logon Data on the Maintain User screen).
2. Assign the following roles

© Z RT GW_USER

© SAP MARKETING TECHNICAL CONF (composite role)

© SAP BC CTS ADMIN

O SAP BC WEBSERVICE ADMIN TEC

© SAP_BC DB ADMIN

O SAP_BC BASIS ADMIN

You can lock the users after successful configuration of SAP Hybris Marketing. The user is needed again when you
carry out an upgrade of SAP Hybris Marketing.

7.6.2 Maintaining the Client

SAP Hybris Marketing uses Operational Data Provisioning (ODP) for the access of SAP HANA content. For the
configuration of ODP within your development and configuration system, you must allow system changes on the
relevant clients. To do so, proceed as follows:

1. Logon to the system with the user that you have created in section User for Application Setup [page 47].

2. Execute transaction scc4 for client maintenance. Ensure that a logical system is assigned to the client that will

be used for SAP Hybris Marketing.
For more information on logical system assignment, see the SAP Help Portal at:

http://help.sap.com/nw75% | Application Help » SAP NetWeaver Library: Function-Oriented View » Security
» Identity Management » User and Role Administration of Application Server ABAP » Configuration of User
and Role Administration  Central User Administration ¥ Setting Up Central User Administration j» Setting Up

Logical Systems
(https://help.sap.com/viewer/DRAFT/c6e6d078ab99452db94ed7b3b7bbccct/1709%20000/en-US/
b4b0b13bb3acef3cel0000000al1402f.html)

3. Set the field Cross-Client Object Changes to No changes to cross-client Customizing objects.
Then, ensure that the system changes become effective in the BW namespaces:

Go to transaction sE03.

Choose |» Administration # Set System Change Option 3. Set the Global setting to modifiable.
Set the attribute Modifiable for the namespaces /B1C/ and /BIO0/.

N N

Set your own namespaces to Modifiable by setting component L.OCATL and customer name spaces to
Modifiable.

For more information, see the SAP Help Portal at:

http://help.sap.com/nw75# | Application Help » SAP NetWeaver Library: Function-Oriented View » Application
Server ¥ Application Server ABAP » Administration of Application Server ABAP » Change and Transport System
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Transport Organizer (BC-CTS-ORG) » Requirements for Working with the Transport Organizer » Setting the System
Change Option 3

(https://help.sap.com/viewer/DRAFT/4a368c163b08418890a406d413933ba7/1709%20000/en-US/
5738de9b4eb711d182bf0000e829fbfe.html )

For general information about Namespaces and Naming Conventions, see the SAP Help Portal at:

http://help.sap.com/nw75# |l Application Help » SAP NetWeaver Library: Function-Oriented View  Application
Server » Application Server ABAP » Administration of Application Server ABAP » Change and Transport System
Namespaces and Naming Conventions (BC-CTS-NAM) 3

(https://help.sap.com/viewer/DRAFT/4a368c163b08418890a406d413933ba7/1709%20000/en-US/
2a6b0afe547a11d189600000e829fbbd.html)

In your productive system, you must also ensure that system changes to software component LOCAL are allowed:
1. Execute transaction sE03.
2. Choose [ Administration # Set System Change Option . Set the Global Setting to Modifiable in order to be

able to set component LOCAL to modifiable.

3. Set the component LocAL to Modifiable. All other components and name spaces can be set to Not modifiable.

7.6.3 Creating Development Packages

You can skip this step if your system is a production system that is supplied with transports from a development
and configuration system.

If your system is a development and configuration system, you need to create two separate development packages
for the following content:

e (Generated OData services
e Bl content.

The development requests need to be transported through your system landscape.

To create the development packages, proceed as follows:

1. Log on to the system with the user for application setup that you have created in section User for Application
Setup [page 47].

2. Create a workbench request for transports to the productive system (see Releasing Transport Requests in
Development System [page 677).

3. Execute transaction sE80 and choose the entry Package in the dropdown box to the left. Enter a name for the
new package for generated OData services, then press the enter key. In the following dialog box, confirm that
you want to create a new package. Enter a short description and a transport layer. Confirm your entries.

4. Repeat step 3, this time creating a package for activated Bl content.
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7.7 Using the Technical Configuration Cockpit

SAP Hybris Marketing requires several technical configuration steps that need to be carried out after installation.

1 Note

We recommend that you first complete the technical configuration in your development and configuration
system, then in the productive system.

The technical configuration cockpit is an application that helps you to carry out the bulk of technical steps.

1 Note

Before you start the technical configuration cockpit for the very first time in a closed system such as a
productive system, the required runtime objects are stored locally, ensure the following settings in your
system:

e |ntransaction sSE03, under node Administration of the Transport Organizer Tools tree, double-click Set
System Change Option. Ensure that the Global Setting field as well as the software component Local
Developments (No Automatic Transport) (LOCAL) are set to Modifiable.

® |ntransaction scc4, double-click the client, in which you want to execute the technical configuration
cockpit. Ensure that the Changes and Transports for Client-Specific Objects are not set to No changes
allowed. In addition, ensure that Cross-Client Object Changes are set to Changes to repository and cross-
client customizing allowed.

You can change these settings according to your requirements after the very first start of the technical
configuration cockpit.

To start the technical configuration cockpit, run transaction CUAN_ TECHNICAL CONF with the user for application
setup (see section User for Application Setup [page 47]) in your AS ABAP system. First, you have to provide the
fully qualified domain main and the port of your SAP Web Dispatcher (see section Configuring the SAP Web
Dispatcher [page 43]).

The technical configuration cockpit consists of clickable tiles that are divided into separate sections, which are
described in the chapters below.

1 Note

To speed up the post-installation process and to avoid errors, we strongly recommend that you use the
technical configuration cockpit.

If you are not able to use the technical configuration cockpit due to, for example, authorization restrictions, you
can fall back on the expert mode (see section Technical Configuration - Expert Mode [page 142]). In this case, you
will need to carry out all steps in the back end, with much less tool assistance.

7.7.1 Section "Overview"

In this section, you are provided with information about your AS ABAP back-end system.
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e SAP Hybris Marketing Product Version provides information about the installed software components and their
versions. In addition, you can check whether the installed component versions are compatible with the current
release of SAP Hybris Marketing, and whether an upgrade is required.

e Users Online provides information about the number of logged on users. Based on this information, you can
decide whether to start your configuration activities while other activities may be still ongoing in the system.

e Systems Connected includes a graphical representation of the most relevant components currently connected
in your system landscape, such as SAP Web Dispatcher, or an SAP ERP system. It also indicates the status of
the connections and includes other connection information such as server name and port. Erroneous system
connections are indicated with red numbers on the tile (3/7 in red with the status Action Required, for
example, means that only three of seven connections work properly).

Note that some components and connections are added during the scenario configuration, depending on your
functional scope and integration options.

e Tiles with SAP Note Information
You are provided with the following tiles offering information about SAP Notes to be implemented:

o Mandatory Notes for Essentials Scenario provides information about the SAP Notes to be implemented
before executing the Essentials scenario, and about their current implementation status. Open SAP Notes
that are still to be implemented are indicated with red numbers on the tile (3/7 in red with the status
Action Required, for example, means that only three of seven mandatory SAP Notes are implemented).

© Hybris Marketing Application Notes provides information about optional SAP Notes related to the various
SAP Hybris Marketing applications or integrations. If you have an application or integration, to which a
note refers, in scope, you must implement the note after you have completed the installation procedure
(see section SAP Notes for Installation and Upgrade [page 141]). The number on the tile indicates the
number of available SAP Notes.

The SAP Note information of both tiles is derived from the Release Information Note (RIN), which you can
access directly from within the tiles. You can download the relevant SAP Notes into your system. Implement
the SAP Notes using transaction SNOTE in your AS ABAP back-end system.

e Scenario Check provides information about the current technical configuration status of your SAP Hybris
Marketing system and corresponding solutions in case the check detects errors. Is the system ready for use or
does it require additional adaptations or corrections to be carried out? The check starts automatically when
the technical configuration cockpit is launched. It refers to and displays scenarios that have been executed
minimum one time and covers the following scenarios: Essentials, ERP Integration, and CRM Integration. The
following check statusses are possible:

o Check Successful
If the scenario check is successful the system is ready for use with no additional adaptations.

o Solutions Available
If solutions are available the check detected errors in at least one of the already executed scenarios and
offers more information on the check's detail screen.

On the details screen of the check, you are provided with the Check and the Solve views:

o Onthe Check view, you are provided with information about the check result and the latest check date for
each scenario. In addition, you can drill down into the check results for different configuration tasks using
the Show Details pushbutton.

o The Solve view offers detailed solutions with step by step descriptions for configuration tasks with errors.

The Run Check pushbutton allows you to re-execute the scenario check, for example, to update the check
result after you fixed an error or executed an additional scenario.

1 Note

Be prepared that re-executing the check can take up to a few minutes.
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7.7.2 Section "Scenarios"

In this section, you are provided with the available technical configuration scenarios. With the scenarios, the
cockpit follows an additive approach dividing the technical configuration into smaller executable parts: the basic
configuration (scenario Essentials), which is mandatory, and additional configuration that is optional and depends
on your scope.

You can execute any optional scenario at any time, either directly after the execution of Essentials, or at a later
point in time.

Every scenario consists of a description, the Progress section, and the Parameters section.

The Progress section is visible only once the configuration check or the configuration run has been started. It
includes clickable icons representing a task of the task list behind the scenario. Clicking the icon provides you with
more information about task and its configuration status.

In the Parameters section you have to provide the required input. The parameter fields are explained below in the
dedicated scenario descriptions for each scenario.

Once you provided the parameter values for a scenario, you choose the Check Configuration pushbutton first, to let
the system check your input. If the check is completed successfully, you choose the Run Configuration pushbutton
to execute the technical configuration scenario.

1 Note

You can run every configuration multipe times by choosing the Run Configuration pushbutton.

The following scenarios are available:

® Fssentials

® [RP Integration

® CRM Integration

o HANA Rules Framework

e Marketing Executive Dashboard

e Campaign Management

e | ead Management with Cloud for Customer Integration
® Recommendation

7.7.2.1 Scenario "Essentials"

1 Note

This scenario is mandatory for the setup of SAP Hybris Marketing and must be executed before any other
scenario. The scenario enables a basic configuration that allows the display of the SAP Hybris Marketing user
interface without any integration to other systems once all following steps (of section Post-Installation) are
carried out.
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The following is an extract of the steps that are automatically carried out by Essentials:

® The execution of task list CUAN_BASE CONFIG is automatically triggered.
e Users needed for post-installation steps are created automatically (where possible)
e Workbench and Customizing requests are created (for development systems):

Table 12:
Customizing Requests o Common Customizing Activities
Workbench Requests © Activated Bl Queries
o Common Workbench Objects
1 Note

The transport requests must be released manually and imported in the production system in a predefined
sequence. For details, see Releasing Transport Requests in Development System [page 67].

e Bl content and OData services are activated (for development systems).

® Background jobs are scheduled and executed.
In transaction SJOBREPO, you can check, which jobs are delivered with SAP Hybris Marketing. The name of the
relevant job definitions is SAP_CUAN_<*>, while job definitions and job hames are identical. In column JD
Status (Job Definition Status), you can check whether a job definition is scheduled in a task list. By double-
clicking a job definition, you can see the meta data of a job such as frequency or name of the corresponding
program.
In transaction sM37, you can check which jobs are scheduled or executed. In addition, you can change the
default frequency of regular background jobs.

® Full text indexes are generated.

You must provide values for the following parameters in Essentials:

® Role of System:
For this field, you have the following options:

o Dev. System: If you run the technical configuration in a development or configuration system (such as an
integration system), the system creates objects according to your settings in the wizard and writes them
to a transport request.

o Prod. System: If you run the technical configuration in a production system (such as a consolidation
system), the system does not create any objects according to your settings in the wizard, but the system
is capable to import objects via a transport request from a development or configuration system.

o Local System: If you run the technical configuration in another system (such as a demo system), the
system creates objects according to your configuration settings, but does not write them to a transport
request.

Caution

Note that changing the Role of System entry is not possible anymore once you have started the technical
configuration.

For example, if you configured the system as a demo system you cannot convert it into a development or
production system. These system types would need to be created from scratch.
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1 Note

Ensure that the selected system type matches with the corresponding entries in transaction scc4 (field
Client role and related entries):

o If you select Dev. System in field Role of System, the entry in the Client role field (transaction scc4)
must be other than Production.

o |f you select Prod. System in field Role of System, the entry in the Client role field (transaction scc4)
must be other than Customizing.

User for SAP HANA Database Connection:

In this field, you enter the SAP HANA user that you created in section SAP HANA User for Technical
Configuration [page 36]. The user enables executing changes, for example, granting privileges to other users,
in the SAP HANA database during the configuration of the system. By default, the user is TC_USER. As you
need the user also for an upgrade of SAP Hybris Marketing, we recommend to deactivate the user after
technical configuration rather than deleting it.

Password:

In this field, you enter the password of the SAP HANA user that you created in section SAP HANA User for
Technical Configuration [page 36]. The password is stored in the secure store. As you need the user and
password also for an upgrade of SAP Hybris Marketing, we recommend to document the password outside the
system.

Fully Qualified Domain Name:

In this field, you indicate the domain name of the installed and configured SAP Web Dispatcher (see section
Configuring the SAP Web Dispatcher [page 43]) for your system in the following format: <3rd-level-
label>.<2nd-level-label>.<Top-Level-Domain>.<root-label>, for example,
mywebdispatcher.wdf.sap.corp.

If you already specified the domain name in transaction CUAN TECHNICAL CONF before initially opening the
technical configuration cockpit, the field is already prefilled, and you can skip this step.

Port:

In this field, you indicate the port of the installed and configured SAP Web Dispatcher (see section Configuring
the SAP Web Dispatcher [page 43]), for example, 10100.

If you already specified the port in transaction CUAN_TECHNICAL CONF before initially opening the technical
configuration cockpit, the field is already prefilled, and you can skip this step.

OData Service Package:

This field is only available if you selected Dev. System in the Role of System field (see above).

Enter the package that you created for OData service generation in section Creating Development Packages
[page 51].

Bl Artifacts Package:

This field is only available if you selected Dev. System in the Role of System field (see above).

Enter the package that you created for Bl content activation in section Creating Development Packages [page
51].

User for Background Processing:

In this field, you can specify a user for the processing of background jobs. SAP Hybris Marketing processes
jobs for several parts of the functionality in the background, for example, the data load from connected
systems. By default, the system provides you with BATCH_USER.

If you want to use another user for background job processing, indicate the required user name. If the
indicated user exists, the system uses it for background job processing. If this user does not exist, the system
creates this user.
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1 Note

If you indicate a user for background job processing that is still to be created, ensure that the central user
administration is deactivated.

71.7.2.2 Scenario "ERP Integration”

You have the option to integrate SAP Hybris Marketing with your existing SAP ERP system to use your SAP ERP
data such as accounts and contacts within SAP Hybris Marketing. In this case, the SAP ERP data is either reused
(in case of co-deployment of SAP ERP with SAP Hybris Marketing on the same SAP HANA database), or replicated
to your SAP Hybris Marketing system using the SAP Landscape Transformation Replication Server (SAP LT). For
more information, see Data Replication [page 30].

For the optional integration with SAP ERP, you must specify the following parameters:

e SAP ERP Deployment:

By default, the parameter is set to No Integration. Choose one of the following alternatives for the business
data integration with SAP ERP:

o Reuse of Original Suite Schema: You can co-deploy SAP ERP and SAP Hybris Marketing on the same SAP
HANA database.

o Use of Replicated Suite Schema: You can replicate the required business data from the SAP ERP system
into the SAP HANA database of SAP Hybris Marketing.

Before you run the scenario, create the RFC destinations to the SAP ERP client, and to the SAP Landscape
Transformation (SLT).

e SAP ERP Source Data Client
Enter the source client number of the SAP ERP system.
® RFC Destination to SAP ERP System
Enter the name of the RFC destination to your SAP ERP source client.

Specify the following parameters if you use the option of replicating the SAP ERP business data:

e SAPLT Configuration Name as specified within your SLT configuration
® RFC Destination to SAP LT System for your SLT instance

o SAP HANA Host ID as specified within your SLT configuration

e  SAP HANA Instance Number as specified within your SLT configuration

e Select the option One Time Initial Data Load Only if you want to replicate the business data once for an initial
load. As a result, any changes in the source system are not reflected in your replicated business data.

7.7.2.3 Scenario "CRM Integration"

You have the option to integrate SAP Hybris Marketing with your existing SAP CRM system to use your SAP CRM
data such as accounts and contacts within SAP Hybris Marketing. In this case, the SAP CRM data is either reused
(in case of co-deployment of SAP CRM with SAP Hybris Marketing on the same SAP HANA database), or
replicated to your SAP Hybris Marketing system using the SAP Landscape Transformation Replication Server (SAP
LT). For more information, see Data Replication [page 30].
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For the optional integration with SAP CRM, you must specify the following parameters:

e SAP CRM Deployment
By default, the parameter is set to No Integration. Choose one of the following alternatives for the business
data integration with SAP CRM:

o Reuse of Original Suite Schema: You can co-deploy SAP CRM and SAP Hybris Marketing on the same SAP
HANA database.

o Use of Replicated Suite Schema: You can replicate the required business data from the SAP CRM system
into the SAP HANA database of SAP Hybris Marketing.

Before you run the scenario, create the RFC destinations to the SAP CRM client, and to the SAP Landscape
Transformation (SLT).

® SAP CRM Source Data Client
Enter the source client number of the SAP CRM system

® RFC Destination to SAP CRM System
Enter the name of the RFC destination to your SAP CRM source client.

Specify the following parameters if you use the option of replicating the SAP CRM business data:

e SAPLT Configuration Name as specified within your SLT configuration
® RFC Destination to SAP LT System for your SLT instance

e SAP HANA Host ID as specified within your SLT configuration

e SAP HANA Instance Number as specified within your SLT configuration

e Select the option One Time Initial Data Load Only if you want to replicate the business data once for an initial
load. As a result, any changes in the source system are not reflected in your replicated business data.

Specify the following for the HTTPS Connection to SAP CRM Source System:

e fully Qualified Host Name
e HTTPS Port

77.2.4 Scenario "HANA Rules Framework"

The SAP HANA rules framework (HRF) allows you to manage and automate business decisions based on rules and
rule services.

Within SAP Hybris Marketing, HRF is used for the following options:

e Scoring Based on SAP HANA Rules Framework in SAP Hybris Marketing Data Management:
HRF helps you to manage your heuristic scoring models in the Score Builder app.
For more information, see Scoring Based on SAP HANA Rules Framework (HRF) [page 78].

® Rule-based Tasks in SAP Hybris Marketing Recommendation:
o HRF is used in the Manage Recommendations app, for example, to re-rank and filter rules.
o HRF is used in the Manage Offer Recommendations app.
For more information, see Configuring Recommendation [page 99].
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If you want to use one of the options above, proceed as follows:

Prerequisites

Prior to execute the scenario SAP HANA Rules Framework in the technical configuration cockpit, you must carry
out the following steps:

e Configuring SSL for SAP HANA XS Engine
You have configured the SSL already in section Configuring SSL for SAP HANA XS Engine [page 35].

e |[nstalling the SAP HANA Rules Framework
You must install the SAP HANA rules framework separately on the SAP HANA database of your application.
For the required version of HRF, see the release information note (RIN) for SAP Hybris Marketing, 1885803 .
For the installation procedure, see the SAP HANA Rules Framework Installation Guide. Since you have already
installed SAP HANA, you can omit Installing the SAP HANA Appliance Software in this guide.
You can find this guide under: http://service.sap.com/instguides# [ SAP In-Memory Computing » SAP
HANA Rules Framework » SAP HANA Rules Framework 1.0 Inst. & Upgrade Guide 3.
(https://service.sap.com/~sapidb/012002523100018452052016E F)

Executing the Scenario "HANA Rules Framework"

For the use of HRF, you must specify the following parameters:

o  HANA Fully Qual. Hostname: Enter the name including domain details of your SAP HANA Extended Application
Services (SAP HANA XS).

o HANA XS HTTPS Port Number: Enter the SSL port number of your SAP HANA XS.

7.7.2.5 Scenario "Marketing Executive Dashboard"

The Marketing Executive Dashboard is an application available for marketing executives in the Marketing Executive
business group. The app contains key performance indicators (KPI), which allow marketing executives to review
the success of marketing investments, and gain an overview of KPI attainment and marketing performance
benchmarks.

1 Note

The Marketing Executive Dashboard application is available only if SAP Hybris Marketing Insight is active.
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If you want to use the option above, proceed as follows:

Prerequisites

Prior to execute the scenario Marketing Executive Dashboard in the technical configuration cockpit, you must carry
out the following steps:

e Configuring SSL for SAP HANA XS Engine
You have already configured the SSL in section Configuring SSL for SAP HANA XS Engine [page 35].

e Installing SAP Smart Business, executive edition
You have already installed SAP Smart Business, executive edition in section Installing SAP Smart Business,
executive edition [page 28].

1 Note

You must ensure the following:

o You have installed the latest version of SAP Smart Business, executive edition.

o You have applied the latest configuration file for the Marketing Executive Dashboard for SAP Smart
Business, executive edition.

Executing the Scenario "Marketing Executive Dashboard"

For the use of the Marketing Executive Dashboard, you must specify the following parameters:

e Target Host
If required, replace the default by the target host you use to run the SAP HANA Extended Application Services
(SAP HANA XS).

e Service Port Number
If required, replace the default by the service port number of your target host.

7.7.2.6 Scenario "Campaign Management"

The applications belonging to Campaign Management allow the efficient planning and execution of marketing
campaigns, which aim to increase the merchandise sales of individual products or the company as a whole, and to
increase the customer retention to the company.

The main features include the creation of marketing campaigns and their execution using various communication
channels such as emails or text message.
1 Note

The Campaign Management applications are available only if SAP Hybris Marketing Acquisition is active.
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If you want to use the Campaign Management, proceed as follows:

Executing the Scenario "Campaignh Management"

For the use of the Campaign Management applications, you must specify the following parameters:

SAP Web Dispatcher Settings for Tracking and Bouncing
Enter the Fully Qualified Domain Name, and the corresponding Port of the SAP Web Dispatcher you use to
enable the tracking for messages.
SAP Mobile Services for Sending Text Messages
If you want to use the option Enable Text Messaging Integration, make sure you have an SAP SMS 365 account
available. In addition, specify the following:
o User for your account
o Password for your account
o Path Prefix: Part of the URL made available by your provider that identifies the web service for your
account. For example, in the URL https://sms-pp.sapmobileservices.com/cmn/<accountid>/
<accountid>.sms, the path prefixis /cmn/<accountid>/<accountid>.sms.
SAP Mobile Services for Sending Email Messages
Choose the option Enable Mobile Service Integration to enable sending emails using SAP Mobile Service. Make
sure you have an SAP Mobile Service account available. Specify the User, and the Password for the SAP Mobile
Service account. In addition, specify the path prefix (part of the URL that identifies the web service for your
account).
Amazon Services for Sending Email Messages
If you want to use the option Enable Amazon Email Integration, make sure you have created an Amazon web
services (AWS) account for using the Amazon Simple Email Service (Amazon SES). You can create access
keys using the AWS Management Console. To use the option specify the following parameters:
o Amazon Access Key ID, and Amazon Secret Access Key for your account
o Define a name for the Amazon Feedback Queue. Configure the Amazon email service to collect all bounces
and complaints in a queue on the Amazon Queue Service. Make sure the feedback queue name matches
the queue name that is set up on Amazon’s side. The feedback queue path is the last individual part of the
queue URL at Amazon. For example, in the queue URL https://sgs.eu-
west-1.amazonaws.com/NNN/ABC, the feedback queue path is /NNN/ABC.
Digital Asset Management
The integration with Digital Asset Management allows you to search for, and to insert images into messages.
Choose an option depending on the external system you use. For the option Open Text, specify the User, and
the Password.
When you choose one of the options an empty RFC destination (HTTP connection to external server) is
created:
o RFC for Hybris Product Content Management: CEI_ME DAM HYBRIS
© RFC for Open Text: CEI ME DAM OPENTEXT
Maintain the RFC destination according to requirements of the external system you use, for example,
specifying target host, service number, logon. Use backend transaction RFC Destinations (sM59) to maintain
the RFC destination.
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77.2.7 Scenario "Lead Management with Cloud for Customer
Integration”

This scenario covers the technical configuration for the usage of the following applications or features:

® Lead Management
Lead Management integrates the business process between marketing and direct or indirect sales channels, to
drive higher-value opportunities through improved demand creation, execution, and opportunity
management. It comprises all measures a company takes to convert potential buyers and interested persons
to real buyers.
For more information about lead management, see the application help for SAP Hybris Marketing at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |» Application Help » SAP Hybris Marketing » SAP
Hybris Marketing Applications ¥ Lead Management 3
https://help.sap.com/viewer/0204678aad934e5da0ecf4d40ba38ca9/1702%20YMKT/en-US/

27ffe755856f7b43e10000000a4450e5.html
The Lead Management business group in SAP Hybris Marketing includes the following applications:

o Lead Dashboard
o Score Builder

o Lead Stages

o Transfer Leads

e (Call Center Integration with SAP Hybris Cloud for Customer
In SAP Hybris Marketing Acquisition, you are provided with the option to trigger SAP Hybris Cloud for
Customer call qualifications to the SAP Hybris Cloud for Customer system directly from a campaign in your
SAP Hybris Marketing system. For more information, see Setting Up Call Center Integration with SAP Hybris
Cloud for Customer [page 128].

The following prerequisites and dependencies apply for the Lead Management applications and for the Call Center
Integration with SAP Hybris Cloud for Customer:

Table 13:

Application/Integration Prerequisite

Lead Dashboard e SAP Smart Business, executive edition must be installed (see section In-
stalling SAP Smart Business, executive edition [page 28])

e SSL for SAP HANA XS Engine must be configured (see Configuring SSL
for SAP HANA XS Engine [page 35])

® | ead Management and Lead Dashboard indicators in technical configu-
ration scenario Lead Management with Cloud for Customer Integration
must be selected

Score Builder e Technical configuration scenario HANA Rules Framework must be exe-
cuted (see section Scenario "HANA Rules Framework" [page 58])

Lead Stages ® [ead Management indicator in technical configuration scenario Lead
Management with Cloud for Customer Integration must be selected
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Application/Integration Prerequisite

Transfer Leads ® SAP Hybris Cloud for Customer must be installed and configured (see
section Setting Up Integration with SAP Hybris Cloud for Customer be-
low)

® | ead Management and C4C Integration indicators in technical configu-
ration scenario Lead Management with Cloud for Customer Integration
must be selected

Call Center Integration with SAP Hybris Cloud e SAP Hybris Cloud for Customer must be installed and configured (see

for Customer section Setting Up Integration with SAP Hybris Cloud for Customer be-
low)

® (C4C Integration indicator in technical configuration scenario Lead
Management with Cloud for Customer Integration must be selected

Setting Up Integration with SAP Hybris Cloud for Customer

If you want to use the Transfer Leads application or the Call Center Integration with SAP Hybris Cloud for
Customer, you must set up the integration with SAP Hybris Cloud for Customer before you execute the Lead
Management with Cloud for Customer Integration scenario.

To do so, proceed as follows:

The integration of SAP Hybris Cloud for Customer is based on an integration system. You have two options
concerning your integration system:

e SAP Process Integration (Pl), an on premise solution
The minimum required release is SAP PI 7.3 with OData adapter PIADAPTERS02 7-20012293.SCA.

e SAP HANA Cloud Integration (HCI), a cloud solution

For information about how to set up the SAP Process Integration system, see the corresponding integration guide
on SAP Service Marketplace at:

http://service.sap.com/cloud4customer#r [ INTEGRATION: SAP Hybris Marketing and SAP C4C via Pl

(http://service.sap.com/~sapidb/012002523100002321982017E fte)

For information about how to set up the SAP HANA Cloud Integration system, see the corresponding integration
guide on SAP Service Marketplace at:

http://service.sap.com/cloud4customer# | INTEGRATION: SAP Hybris Marketing and SAP C4C via HCI 3

(http://service.sap.com/~sapidb/012002523100002321972017E #)

Web Services Reliable Messaging

Web Services Reliable Messaging (WS-ReliableMessaging) describes a protocol that allows messages to be
delivered reliably between distributed applications in the presence of software component, system, or network
failures.
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To be able to use Web services with WS-ReliableMessaging, you must configure the Web service runtime. In each
productive client and in client 000, execute the technical setup in transaction SRT ADMIN of your SAP Hybris
Marketing back-end system.

For information about how to configure the Web service runtime, see the following documentation on the SAP Help
Portal at:

http://help.sap.com/nw75 |» Application Help » SAP NetWeaver Library: Function-Oriented View » Application
Server ¥ Application Server ABAP ¥ Application Development on AS ABAP » ABAP Workbench - Classic » ABAP
Workbench Tools » ABAP Web Services p Operating Web Services j Configuring the Web Service Runtime 3

(https://help.sap.com/viewer/684cffda9cbc4187ad7dad790b03b983/7.5.6/en-US/
47ab7d3b49f84848e10000000a421138.html)

Executing the Scenario "Lead Management with Cloud for Customer
Integration”

For the use of the Lead Management with Cloud for Customer Integration, you must specify the following
parameters:

® | ead Management
Select this indicator to activate Lead Management applications along with the corresponding SAP HANA
content and BC sets in your system.

® | ead Dashboard
Select this indicator to activate the Lead Dashboard application. The dashboard can only be activated when
you selected the Lead Management indicator as well.

1 Note

To display the Lead Dashboard application on the user interface, ensure that a copy of standard role
SAP CEI LEAD DASHBOARD is assigned to the corresponding users.

Set the following parameters:
o Target Host:
If required, replace the default by the target host you use to run the SAP HANA Extended Application
Services (SAP HANA XS).
o Service Port Number:
If required, replace the default by the service port number of your target host.
® (CA4C Integration Configuration
This parameter controls the configuration of the SAP Hybris Cloud for Customer in your system. Select this
indicator to set up the RFC destination to SAP Hybris Cloud for Customer and logical ports to SAP NetWeaver
Process Integration (P1) and SAP HANA Cloud Integration (HCI).
Set the following parameters:
o Host Name of C4C:
Fully qualified domain name of your SAP Hybris Cloud for Customer system (Ul front end) for Ul
navigation. Example: myUiServer.ondemand. com.
o Port for C4C:
Enter the port number of your SAP Hybris Cloud for Customer system (Ul front end). Example: 443 (This
is the default https port).
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o Proxy Server (optional):

Fully qualified domain name of your proxy server for the PI/HCI communication. Use these parameters if

you require a proxy server to allow network connections to servers outside of your network.
o Proxy Port (optional):
Port number of your proxy server for the PI/HCI communication.
o Proxy User (optional):
If required, replace the default by the service port number of your target host.
o Proxy User Password (optional):
Password for the proxy server user for the PI/HCI communication.
o URL Access Path for Lead:
Service path of the PI/HCI server for communicating leads.
o Example for Pl systems: /XISOAPAdapter/MessageServlet?channel=:<yMKT system
name> <client>:<yMKT system name> SOAP LeadReplRequest Out
o Example for HCI systems: /cxf/yMKT/C4C/LeadReplicationRequest_Out_<yMKT system
name><client>
o URL Access Path for Activity:
Service path of the PI/HCI server for communicating activities.
o Example for Pl systems: /XISOAPAdapter/MessageServlet?channel=:<yMKT system
name> <client>:<yMKT system name> SOAP ActivityReplication Out
o Example for HCI systems: /cxf/yMKT/C4C/ActivityReplicationOut_<yMKT system name><client>
o Host Name of PI/HCI:
Fully qualified domain name of your PI/HCI server.
o Port of PI/HCI:
Port number of your PI/HCI server.
o PI/HCI User:
User of the PI/HCI server.
o PI/HCI Password:
Password of the PI/HClI user.

7.7.2.8 Scenario "Recommendation"

The applications belonging to Recommendation allow business analysts and marketing experts to create
recommendation models that provide consumers with relevant recommendations in real time, simultaneously
across multiple sales channels. Recommendation models leverage algorithms and SAP HANA to query and
retrieve recommendations from sales or business event data.

1 Note

The Recommendation applications are available only if SAP Hybris Marketing Recommendation is active.
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If you want to use Recommendation, proceed as follows:

Executing the Scenario "Recommendation”

For the use of the Recommendation applications, you must specify the following parameters:

e Section "SAP ERP Retail":
o  Rule-Based Product Recommendations:
Select this option if you want to use rule-based tasks in the Manage Recommendations application, for
example, to re-rank and filter rules.
e Section "Rule-Based Offer Recommendation Scenarios":
o SAP Customer Activity Repository:
Select this option, together with one of the following options:
o SAP Promotion Management for Retail (SAP PMR):
Select this option, if you want to include offers from SAP Promotion Management for Retail (PMR) in
the Manage Offer Recommendations app.
o SAP Hybris Marketing Offer Integrated with SAP PMR:
You have the option to combine offers from SAP Promotion Management for Retail (PMR) with offers
created in SAP Hybris Marketing. While the SAP Hybris Marketing offers contain the visual content
such as pictures and texts, the PMR offers contain the process-relevant part such as products, prices,
and discounts. You can build recommendation rules on the combined set of attributes of both of the
objects.
Select this option, if you want to use this feature.
o SAP Hybris Marketing Offer Recommendations:
Select this option, if you want to use rules that have been created in the Manage Offer Recommendations
app, in the OData service CUAN_OFFER_DISCOVERY SRV to display the best offers to customers in the
Offers app.

1 Note

We recommend to select only one of the options for offer recommendation at a time, as the options are
self-contained and do not build on each other.

1 Note

Keep in mind that all rule-based options above require an installed SAP HANA rules framework as a
prerequisite. If not yet done, execute the technical configuration scenario HANA Rules Framework (see Scenario
"HANA Rules Framework" [page 58]).
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7.8 Applying Technical Configuration Artifacts to Production
System

In your development and configuration system, the Essentials scenario in the technical configuration cockpit
automatically creates transport requests with repository and Customizing objects (see Scenario "Essentials”
[page 541]).

To make the artifacts - created during technical configuration in the development system - available in the
production system, you must carry out the following two steps:

® |nthe development and configuration system, release the transport requests.

® |nthe production system, import the transport requests in a specific sequence and execute the technical
configuration

7.8.1 Releasing Transport Requests in Development System

To release the transport requests in your development system, proceed as follows:

1. Logon to the development system with the User for Application Setup [page 47].
2. Goto transaction sE09 and release and transport the following requests in the following sequence:
1. Workbench Request created manually for the development packages (see Creating Development
Packages [page 51]).
2. Customizing Request: Common Customizing Activities
3. Workbench Request: Common Workbench Objects
4. Workbench Request: Activated Bl Queries

7.8.2 Importing Transport Requests and Executing Technical
Configuration in Production System

After you have carried out the technical configuration and released the relevant transport requests in your
development system, you need to import the requests and execute the technical configuration of the Essentials
scenario in the production system.

Proceed as follows in the production system:

1. Logon to the production system with the User for Application Setup [page 47].
2. Gototransaction STMS IMPORT and import the requests listed above in the specified sequence:
1. Workbench Request created manually for the development packages (see Creating Development
Packages [page 51]).
2. Customizing Request: Common Customizing Activities
3. Workbench Request: Common Workbench Objects

3. Execute the Essentials scenario in the technical configuration cockpit in the production system (see section
Scenario "Essentials" [page 54]).
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4. Import the following request:
o Workbench Request: Activated Bl Queries

1 Note

When importing the transports into the production system, ensure that the client-specific Customizing is
transported to the client, in which you execute the technical configuration.

7.9 Initial Setup of SAP Fiori

Set up the administrator role as well as the end user role for SAP Fiori by following the instructions described on
the SAP Help Portal in the following two sections:

http://help.sap.com/fiori_bs2013#& |+ Configuration of SAP Fiori Infrastructure » Configuration Information ¥
Setup of SAP Fiori Launchpad ¥ Assign Administrator Role for SAP Fiori Launchpad to Administrator User 3.
(http://help.sap.com/fiori_bs2013/helpdata/en/38/ca4353c7b9f663e10000000a4450e5/content.htm?
frameset.htmesr)

http://help.sap.com/fiori_bs2013# |l Configuration of SAP Fiori Infrastructure » Configuration Information ¥
Setup of SAP Fiori Launchpad » Assign Role with Launchpad Start Authorization to End Users 3.

(http://help.sap.com/fiori_bs2013/helpdata/en/26/cf4353c7b9f663e10000000a4450e5/content.htm?
frameset.htmee)

Now go to to transaction PFCG, create a new role (for example ZCHIP_FOUNDATION) and add the following
authorizations

Table 14:
Authorization Object Web Dynpro ABAP Activity
/UI2/CHIP X-SAP-UI2-CHIP* 03
/UI2/CHIP X-SAP-UI2-PAGE* 03,16
S_PB_CHIP X-SAP-UI2-CHIP* 03
Table 15:
Authorization Ob- | Activity Package Object Name Object Type Authorization
ject Group ABAP / 4
Program
S_DEVELOP 03 * X-SAP-UI2- * *
CHIP*
S_DEVELOP 03,16 * X-SAP-UI2- * *
PAGE*
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S_DEVELOP 03 /u12/ /UI2/* WDCC *
SERVICES P
B_UTIL_700
Table 16:
Authorization Object Activity Request Type
S_TRANSPRT 03 *

Generate the profile. Now assign the new role to all your business and administration users.

710 Defining a Virus Scan Profile

In order to adhere to security standards, we recommend that you use a virus scanner. The scanner performs
checks in various SAP Hybris Marketing applications. For example, the scanner checks the HTML code of emails in
SAP Hybris Marketing Acquisition.

By default, the virus scanning is switched on in the SAP NetWeaver Gateway, and as a result, you need to maintain
the corresponding profile in the customizing of the virus scanning. For information about how to define a profile,
see the Security Guide at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Security Information 3 under Virus Scan Profile
(ABAP).

You can switch on, or switch off the virus scanner in the SAP NetWeaver Gateway using transaction /IWFND/
VIRUS SCAN, or using the |l SAP Customizing Implementation Guide » SAP NetWeaver » Gateway # OData
Channel » Administration » General Settings ¥ Define Virus Scan Profiles 3.

1 Note

SAP strongly recommends to keep the virus scan switched on.

1 Note

Make sure that you complete this customizing step as part of the installation process.

711 Generating Authorization Profiles for the User Interface

In SAP Hybris Marketing several composite roles are provided that give you access to the SAP Hybris Marketing
applications. These composite roles include all single roles that are necessary to run the corresponding solution.
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The following table lists the available composite roles by business roles:

Table 17:

Business Role

Composite Role Name

Description

Marketing Experts

SAP MARKETING EXPERT

General access to SAP Hybris Marketing

SAP MARKETING SEGMENTATION

Access to applications belonging to
Segmentation

SAP MARKETING CAMPAIGNS

Access to applications belonging to
Acquisition

SAP MARKETING SPEND MGMT PROG

Access to applications belonging to Planning

SAP MARKETING RECOMMEND EXPERT

Access to applications belonging to
Recommendations

SAP MARKETING INSIGHT

Access to applications belonging to Insight

SAP MARKETING DATA MANAGEMENT

Access to applications belonging to Data
Management

SAP MARKETING EAC

Access to extended application components
(applications based on SAP Hybris as as
Service (YaaS) - separate license required)

Marketing Managers

SAP_MARKETING_MANAGER

General Access to SAP Hybris Marketing

SAP_MARKETING_ PLANNING

Access to Planning

Marketing Executives

SAP_MARKETING_EXECUT_DASHBOARD

General Access to SAP Hybris Marketing

Business Analysts

SAP MARKETING RECOMMENDATION

Access to applications belonging to
Recommendations

Administrator - Marketing

SAP_MARKETING BUS_ADMIN_ USER

Access to applications for key user and ad-
ministrative tasks

Installation / Upgrade Team
Members

SAP_MARKETING TECHNICAL_ CONF

Contains all roles needed to run the technical
configuration tasks of the installation and up-
grade process

User Administrator - Marketing

SAP MARKETING USER ADMIN

Access for user administrators

Sales Representative

SAP SALES REP MKT INFO

Access to applications for sales representa-
tives

To initially generate an authorization profile in your AS ABAP system and assign it to a user, you have to copy the
required composite role including the single roles (depending on your purchased SAP Hybris Marketing solutions)

and configure the copies of all roles according to your requirements.

1. Log on to your AS ABAP system and go to transaction PFcG.

70 CUSTOMER

Installation and Configuration Guide 1702

Post-Installation




2. Forexample, if you purchased the Segmentation price list component, enter
SAP_MARKETING SEGMENTATION inthe Role field and choose the Copy pushbutton.
A dialog box appears.

Enter a self-defined name for your role and choose the Copy all pushbutton.

> w

composite role.

Back on the Role Maintenance screen, choose the Change pushbutton.
Choose the Roles tab, and access the first new role by double-clicking it.

© N O O

Information About Authorization Profile section.
The system enters a profile name and a profile text.

9. Choose the Change Authorization Data pushbutton in the Maintain Authorization Data and Generate Profiles
section.

10. On the Change Role: Authorizations screen, maintain authorizations to suit your requirements.

11. To generate the authorization profile, choose the Generate menu option from the Authorizations menu or
choose the Generate pushbutton.

12. Repeat step 7 to 11 for all new roles in your composite role.

1 Note

If you create a copy of another composite role (as you purchased more than one SAP Hybris Marketing
solution), be aware that some of the included single roles may already have been copied.

1 Note

These steps do not apply to roles for which a profile cannot be generated because they do not contain any
authorization data, for example, business catalog roles such as SAP CEI _KUA FLP.

13. All required authorizations roles are described in the SAP Hybris Marketing Security Guide at https://

help.sap.com/viewer/p/SAP_HYBRIS_MARKETING#|p Security » Authorizations 3.
https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4e6af5¢c/1702%20YMKT/en-US/
10i018cf203bb338438c8d8251194fb5a5f3.pdf

14. Assign your copied composite role to the users in transaction sU01.

1 Note

If you purchase additional licenses, you need to adapt your roles accordingly.

712 Generating the URL for Displaying the User Interface

Caution

All previous steps have to be completed successfully before you can start with this step.
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In the following dialog box, select all single roles. Enter suitable names for each role in the New Role column.

Choose the Authorizations tab, switch to Edit mode, and choose the Propose Profile Name pushbutton in the
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You create a start URL and distribute it to all potential end users as follows: https://<fully qualified
domain name of your SAP Web Dispatcher>:<HTTPS Port of SAP Web Dispatcher>/sap/bc/
ui5 ui5/ui2/ushell/shells/abap/FioriLaunchpad.html?sap-client=<Client>#Shell-home

From the AS ABAP system, you can launch the user interface using transaction START CEI.

Logout Screen for the SAP Fiori Launchpad

By default, the SAP Hybris Marketing front-end system redirects you to a standard page, when you log out of the
system.

If you want your users who log out of the system to be redirected to another page such as the SAP Fiori default log
in page, follow the instructions described in the following documentation on the SAP Help Portal:

http://help.sap.com/nw75 | Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori
Launchpad ¥ Setting Up the Launchpad ¥ Configuring Logout ¥ Configure a Logout Screen for the SAP Fiori
Launchpad (Optional) 3

(https://help.sap.com/viewer/cclc7615ee2f4a699a9272453379006¢/7.5.5/en-US/
8eb10085b029478c8498fba3bc35ef60.html)

Creating a Custom Configuration File

If you want to adapt the launchpad configuration, for example, to prevent business users from changing the
application by creating an own personalization or from showing or hiding business groups, you can create your
own configuration file without adapting the file delivered by SAP. For more information, see the SAP Library at:

http:/help.sap.com/nw75 | Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori
Launchpad ¥ Setting Up the Launchpad » Configuring the Launchpad ¥ Setting Parameters in a Launchpad
Configuration File 3

( https://help.sap.com/viewer/cclc7615ee2f4a699a9272453379006¢/7.5.5/en-US/
2ddd5b940dd74fbf8c49751b98f97a3b.html)

Caution
If you create your own configuration file, you must ensure that your start URL includes the path ¢sap-ushell-

config-url=/sap/ushell config/CEC_MKT.jsonwhen generating this URL (see above).

For general information about about the levels of the launchpad, see the SAP Library at:
http://help.sap.com/nw75 | Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori
Launchpad ¥ Setting Up the Launchpad » Configuring the Launchpad 3

(https://help.sap.com/viewer/cclc7615ee2f4a699a9272453379006c¢/7.5.5/en-US/
98cb0b6355094b2e91a0e6de030cd4ea.html)
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8 General Configuration Settings in SAP
Hybris Marketing

8.1 Setting up Integration with SAP Jam

You have the option to integrate various parts of SAP Hybris Marketing with the collaboration platform SAP Jam.

The integration with SAP Jam is available for the following licenses and applications:

e Data Management (Sentiment Engagement):
You can use SAP Jam as a data source for Sentiment Engagement, which allows you to filter, analyze, and
process posts from SAP Jam. In addition, you can create SAP Jam groups directly from the Sentiment
Engagement user interface.
® Acquisition:
o Campaign Management:
You can store campaign-related information in corresponding SAP Jam groups to support online
communication such as discussions with other sales people about your campaign.
o Campaign Management (Paid Search):
You can share paid search campaign data with an existing group on SAP Jam to collaborate with other
marketing experts. The post on SAP Jam will include a link to the specific paid search campaign you are
sharing and the external marketing campaign associated with it.
® Planning (Budget Plans):

You can share planning data with an existing group on SAP Jam to collaborate with other marketing managers.

The post on SAP Jam will include a link to the Budget Plans application.

® |naddition, you must set up the integration with SAP Jam if you want to use the share function which is
available in some SAP Fiori applications. This function allows the user to send posts to the feed of any SAP
Jam group.

To set up the integration with SAP Jam, you need to carry out the following steps:
e Set up the connection with SAP Jam:
o For a description of how to connect SAP Jam with AS ABAP systems, see the SAP Library at:
http://help.sap.com/netweaver [ Ul add-on for SAP NetWeaver j» Ul add-on 2.0 for SAP NetWeaver ¥

Application Help # Social Media Integration j Information for Administrators  Configuration 3
(https://help.sap.com/viewer/7259d88d94bb48c7b80b7928b7977ac6/7.4.15/en-US/
1c8f86d5fe634a28bldal86abfd87f81.html)

o You find the relevant steps in the SAP NetWeaver implementation guide (IMG) (transaction SPrO) under

| SAP NetWeaver j» Application Server » Basis Services » Collaboration # SAP Jam Integration .
e Carry out the customizing steps specified under SAP Hybris Marketing: |+ General Settings ¥ Integration ¥
Define Settings for Integration of SAP Jam 3.

e |naddition, for the use in Sentiment Engagement, you have to carry out the Customizing steps specified under

SAP Hybris Marketing: |» Contacts and Profiles » Sentiment Engagement 3.
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1 Note

You can only access the Collaboration menu path if you have activated the business function BC_SRvV_STw 03
(Enable Social Media ABAP Integration 3) in customizing under [|» Activate Business Functions
ENTERPRISE_BUSINESS_FUNCTIONS
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9 Configuring Data Management

This section is relevant for all SAP Hybris Marketingapplications.

With SAP Hybris Marketing Data Management, you can analyze contact data from various sources (such as SAP
ERP, SAP CRM as well as external data sources such as social media) in order to gain a deeper insight into your
contacts’ sentiments and interests. Based on this information, you can create contact target groups and identify
follow-up actions.

9.1 Sentiment Engagement (Optional)

Sentiment Engagement allows you to filter, analyze, and process data that has been harvested from external data
sources such as social networks.

1 Note

The use of information originating from social networks and other data sources must be checked in the
individual case against the background of all applicable laws and regulations (e.g. on data protection) and
individual rules (e.g. for the relevant data source). SAP does not accept any liability for the use of the application
by its customers.

Since the setup requirements for collecting external data will always vary greatly depending between individual
customers and countries, data harvesting is not part of the SAP Hybris Marketing Data Management application.

9.1.1 Setting up Data Harvesting

Prerequisites

In order to set up Sentiment Engagement, you need to carry out the steps below.

Ensure that the following Customizing entries have been made under Contacts and Profiles in SAP Hybris
Marketing:

e |} Interaction Contacts # Define Settings for Social Media Integration
Enter the social media channel codes that you want to use in the Sentiment Engagement application (for
example, FB).

e |} Interactions ¥ Define Communication Media 3
Enter the communication media that you need (for example, FB).
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1 Note

Every communication medium that you want to use in the Sentiment Engagement application must
correspond to a social media channel code.

e |» Interactions » Define Interaction Types 4
Select the Text Anlys checkbox for all interaction types that you want to use in the Sentiment Engagement
application.

o | Interactions » Assign Interaction Types and Communication Media to Channels 3
Assign the communication media that you have created to the interaction types that are selected for the text
analysis.

Importing Social Posts

You first have to import the data that you want to analyze to your SAP Hybris Marketing system. Social posts are
imported as interactions of interaction type SOCIAL POSTING. In addition, social posts of any other interaction
type are displayed in Sentiment Engagement if the text analysis is selected in Customizing for these interaction
types (see the corresponding Customizing setting above).

The import is realized using one of the following data upload interfaces:

e OData service CUAN IMPORT SRV
e RFC function module CUAN_CE_INTERACTIONS POST or CUAN CE INTERACTIONS POST FLAT
e \Web service CUANPOSTINTERACTIONS

The regular background job CUAN IA TA EXTR DELTA thatis scheduled during technical configuration ensures
that the imported interactions are updated by sentiments and tags according to the results of SAP HANA Text
Analysis.

For more information about the import of interactions, see the corresponding sections for interactions in the Data
Management Upload Interfaces guide for SAP Hybris Marketing under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration » Data Management Upload
Interfaces 3

https://help.sap.com/doc/4d660f95f99b41a3a66283a7dff0e160/1702%20YMKT/en-US/
10i0339d4f548e6a5176e10000000a4450e5. pdf
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9.1.2 Setting up SMTP for Post Groups (Send Email to Me)

As a prerequisite for the usage of the post group action Send Email to Me (see the corresponding Customizing
path below), you must set up the SMTP configuration for SAPconnect. To do so, proceed as follows:

1. Make the configuration settings for email exchange between your AS ABAP system and any SMTP (Simple
Mail Transfer Protocol) mail server. For more information, see the Quick Guide for SMTP Configuration on SAP
Help Portal at:

http://help.sap.com/nw75# | Application Help » SAP NetWeaver Library: Function-Oriented View
Application Server » Application Server ABAP » Other Services ¥ Services for Business Users » SAPconnect

(BC-SRV-COM) » Quick Guide to SMTP Configuration 3
https://help.sap.com/viewer/026f8a31bca948a086e995ce267f4e38/7.4.17/en-US/
49e5e6a986420896e10000000a421937.htm| e

2. Make the required settings in Customizing for SAP Hybris Marketing under |» Contacts and Profiles »

Sentiment Engagement j» Create Action ID for Post Groups 3. The EMATL2ME (Send Email to Me) action must
be active.

9.2 Scoring

Scores are calculated KPIs that help your end users to make assumptions about the future actions and decisions
of an account, a contact, consumer, or prospect. Scores are displayed in a separate facet of the fact sheets on the
user interface and can be used within Segmentation.

9.2.1 Scoring Including SAP Predictive Analytics

SAP Predictive Analytics allows for an automated training of predictive models, which reduces the effort of the
business analyst, and provides best results.

To enable the usage of SAP Predictive Analytics as an implementation method, an installation of SAP Automated
Predictive Library (APL) on SAP HANA is required. The integration setup of SAP Predictive Analytics with SAP
Hybris Marketing is not part of the SAP Hybris Marketing delivery.

If you have installed SAP HANA SPSQ9, you can use the APL for an easier and more convenient setup installation.

For details on how to install the APL, go to http://help.sap.com/paf | Development Information » APL Reference
Guide 3.

(https://service.sap.com/~sapidb/012002523100013455472015E/ #r)
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9.2.2 Scoring Based on SAP HANA Rules Framework (HRF)

You have the option of integrating the SAP HANA rules framework (HRF) to help manage your heuristic scoring
models. With this feature, your business analysts can create heuristic scoring models by defining the score
calculation directly on the user interface in the Score Builder app using an intuitive rules expression language.

A prerequisite for using this option is an installed and configured HRF. If you did not install and configure HRF
before, follow the instructions in section Scenario "HANA Rules Framework" [page 58].

9.2.3 Predictive Model Training Based on [nu]-Support Vector
Machine (R)

If you want to use [nu]-Support Vector Machine (R) for the training of a predictive model, you need to integrate R
with the SAP HANA database. For more information about how to enable the embedding of R code in the SAP
HANA database, see the SAP HANA R Integration Guide at:

http://help.sap.com/hana_platform/#|p References » R Integration Guide 3

http://help.sap.com/hana/SAP_HANA_R_Integration_Guide_en.pdff

9.3 Web Shop Personalization Based on Customer Segments

You can integrate SAP Hybris Marketing with release 5.3 of the Hybris Commerce Suite, to personalize your Web
shop based on customer segments. You do this by defining tactical customer segments in Segmentation, which
leads to a personalized shopping experience in Hybris commerce.

The Web shop designer who works in the Hybris design environment calls up a list of campaigns resulting from the
customer segments defined in Segmentation. The designer implements the personalization for the Web shop,
which can range from layout and featured products to promotional pricing, for example.

This feature is enabled via the OData service CUAN_COMMON_SRV: The Hybris content management system
(Hybris CMS Cockpit) calls the SAP Hybris Marketing system during design time via this service to search for
customer segments and, therefore, campaigns that are available for assignment to customer segment rules.

During runtime, that is when a user logs on to the Hybris commerce platform, the Hybris commerce system calls
the SAP Hybris Marketing system via the OData service to establish which campaign and, therefore, to which
customer segment the login user is assigned. With this information the corresponding customer segment rules as
defined in Hybris CMS Cockpit are derived and the web shop is personalized accordingly.

In order to use the appropriate level of authorization when accessing information in SAP Hybris Marketing from the
Hybris Commerce Suite, we recommend that you carry out the following steps:
1. Copy the singlerole SAP CEI ECOMMERCE INTEGRATION using transaction PFCG.

2. Assign the new copied role to the technical user specified for accessing SAP Hybris Marketing from the Hybris
Commerce Suite.

The integration setup of the Hybris Commerce Suite with SAP Hybris Marketing is not part of the SAP Hybris
Marketing delivery. You can implement the setup on a project basis.
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For more information, see the SAP Hybris Marketing documentation at: https://wiki.hybris.com/display/
release5/SAP+hybris+Marketing+Integration

94

Customer Journey Insight

Customer Journey Insight allows you to view customer journeys. A journey is a sequence of events performed by a
customer over time through various media, such as social, Web and phone, for example, clicked ads, opened
emails, and confirmed Web searches. Marketing managers can explore journeys that lead to a certain event
performed by a customer, such as a buy, an abandoned shopping cart, or a conversion.

You can view customer journey data, such as all customers taking the same journey, the number of times a
specific journey is taken, and the top journeys by percentage. You can filter customer journeys based on date
range, touchpoints, top journey percentage, events, interaction types, target group, and granularity.

In addition, you are provided with the option to create target groups of identified contacts for further processing in
campaigns or promotion activities.

9.4.1 Setting up Customer Journey Insight

Before you start with the configuration for Customer Journey Insight, ensure that you have carried out the steps
described in the following section:

® |[nitial Setup of SAP Fiori [page 68]

To set up Customer Journey Insight, carry out the following steps:

1. Carry out the Customizing steps specified under SAP Hybris Marketing under | Contacts and Profiles 3.
Ensure that you make all the required settings for interaction contacts, origins of contact ID, communication
media, interaction types, interaction channels, and that you assign the interaction types and communication
media to channels. Specifically, these need to be done in the following customizing steps:

o

(¢]

o

e}

o

| Contacts and Profiles ¥ Interaction Contacts » Define Origins of Contact ID 3
| Contacts and Profiles ¥ Interactions ¥ Define Communication Media 3

| Contacts and Profiles ¥ Interactions » Define Interaction Types 4

| Contacts and Profiles ¥ Interactions ¥ Define Interaction Channels 3

| Contacts and Profiles » Interactions » Assign Interaction Types and Communication Media to
Channels 3

2. Define interaction interests on the user interface, in the Interaction Interests application within the Business
Administration business group.

3. Upload the necessary data including interactions and interaction contacts. Ensure that there are some
interaction contacts and interactions available in your system, otherwise the chart will be empty.

4. Define events on the user interface, in the Customer Journey Events application within the Business
Administration business group (see Setting up Customer Journey Events [page 80]).
Enter the events and assign the interactions you want to use to these events. Save your entries.
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5. Toenable users to use Customer Journey Insight, assign your copies of the following PFCG roles to AS ABAP
users:
© SAP CEI SCI_FLP (business catalog role)

© SAP CEI TG_INI (for creating, filtering and viewing target groups; included in composite role
SAP MARKETING DATA MANAGEMENT)

o SAP CEI cJI (for accessing Customer Journey Insight; included in composite role
SAP_MARKETING DATA MANAGEMENT)

© SAP CEI CJI EVENTS (for accessing Customer Journey Events;included in composite role
SAP MARKETING BUS ADMIN USER)

© SAP CEI HOME (for personalization purposes)

9.4.2 Setting up Customer Journey Events

Customer Journey Events, located in the Business Administration business group, allows business administrators
to define events for customer journeys. An event can be any outcome of a customer journey, such as a buy, an
abandoned shopping cart, or a conversion.

To enable business administrators to use Customer Journey Events, assign your copies of the following PFCG roles
to the corresponding AS ABAP users:

® SAP CEI KUA FLP (business catalogrole)

® SAP MARKETING BUS ADMIN USER (for accessing all applications for key user and administrative activities)

® SAP CEI CJI EVENTS (for accessing Customer Journey Events; included in composite role
SAP_MARKETING BUS ADMIN USER)

1 Note

Ensure that the OData service CUAN_ODATA CJI SRV is added to your copy of role

SAP CEI CJI_EVENTS. For a description of how to add an OData service manually, see the upgrade guide
for |» SAP Hybris Marketing » » Adding an OData Service to a Role » General Adaptations in SAP Hybris
Marketing ¥ Adaptations of Roles and Authorizations » New OData Services in Single Roles 7 at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# |l Installation and Upgrade » Upgrade
Guide 3

https://help.sap.com/doc/c71261fcb939441190a621df0f2d8cea/1702%20YMKT/en-US/
loioOcaa705127e05905e10000000a44538d. pdf

e sSAp CEI HOME (for personalization purposes)
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9.5 Configuring Commerce Integration

9.5.1 Generating Interactions from the Tracking of Unknown
Web Site Visitors

You can use the results of the visitors tracking in Hybris Commerce Suite Web shops as interactions in SAP Hybris
Marketing. Based on the clicks of visitors, the Business Event Extension of the Web shop generates a set of events,
and sends it to the SAP Event Stream Processor (ESP). From the ESP, the events are converted to SAP Hybris
Marketing interactions.

To find out how to set up the required components, see SAP Hybris Marketing Web Tracking on the Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration § View all » SAP Hybris Marketing
Webtracking 3

https://help.sap.com/doc/719f84311f244cclb2dcc9418b8e6f62/1702%20YMKT/en-US/ymkwebtrckngl702.pdf

9.6 Setting up Applications for Data Import for Analytics

The following applications are available in the Import Data business group and allow you to import data for analytic
purposes in the Marketing Executive Dashboard:

e |mport Data for Analytics allows you to upload KPI data records.

1 Note

You can find example data for the available KPIs (see Configuring SAP Smart Business, executive edition
[page 86]) on the SAP Community Network (SCN) at: http://scn.sap.com/docs/DOC-65033#%).

e Competitors allows you to import competitor data such as the competitor's market share via CSV upload.
e Audiences allows you to import audience data such as a group or a segment of customers via CSV upload.

Assign Users to Roles

To enable administrators in marketing to upload analytic data, you have to assign their AS ABAP users to your
copy of the following roles:

For Import Data for Analytics:

® SAP CEI KUA FLP (business catalog role; no copy required - you can assign the delivered standard role)

® SAP CEI IMPORT ANALYTICS (back-endrole;included in composite role
SAP_MARKETING BUS ADMIN USER)

® SAP CEI HOME (for personalization purposes)
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For Competitors:

® SAP CEI KUA FLP (business catalog role; no copy required - you can assign the delivered standard role)
® SAP CEI COMPETITORS (back-end role; included in composite role SAP MARKETING BUS ADMIN USER)
® SAP CEI HOME (for personalization purposes)

For Audiences:

® SAP CEI KUA FLP (business catalog role; no copy required - you can assign the delivered standard role)
® SAP CEI AUDIENCES (back-end role;included in composite role SAP MARKETING BUS ADMIN USER)
® SAP CEI HOME (for personalization purposes)

9.7 Setting up Application "Business User"

The application Business User in the Business Administration business group allows marketing user administrators
to create business users in the SAP Hybris Marketing system, for example, business users in the context of SAP
Smart Business, executive edition (see Setup for SAP Hybris Marketing Business Users [page 89]). The user
administrator can only use this app, if his or her user is assigned to your copy of the following roles:

® SAP CEI USER HANDLING (back-end role;included in composite role SAP MARKETING USER ADMIN)
e SAP CEI HOME (for personalization purposes)

9.8 Setting up Application "Digital Accounts"

With the Digital Accounts application, marketing experts can view and analyze the followers of social media
accounts of their companies.

1 Note

Currently, the only social network supported by Digital Accounts is WeChat. As WeChat is mainly used in China,
you must also apply the settings described in section Configuring China Localization [page 135].

Customizing Activities and Business Add-Ins

The Customizing activities and BAdIs for the Digital Accounts app are located in Customizing for SAP Hybris
Marketing under |+ Contacts and Profiles » Digital Accounts 3.

e Customizing Activity "Define Digital Account Types"
You decide what types of digital accounts can be configured in Digital Accounts.

® Business Add-In "Acquiring Access Token"
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Due to business requirements, you may have multiple servers that receive various types of messages from the
same digital account. If you allow each server to request the access token that is required for calling APIs for
the digital account, trouble will arise due to conflicting access tokens.

Instead, you should use one of them as a primary server, which is responsible for getting and storing the
access token. If the server that you have configured for the integration of the digital account and SAP Hybris
Marketing is not the primary server, then you need to implement this BAdI to get the access token from the
primary server.

Display Digital Accounts on SAP Fiori Launchpad

To display Digital Accounts in the Contacts and Profiles business group on the SAP Fiori launchpad, you do the
following:

1.

10.

11.

Launch the SAP Fiori launchpad designer.

For information about how to call up the SAP Fiori launchpad designer, see the SAP Library under:
https://help.sap.com/nw75#% |» Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750
SAP Fiori Launchpad » Using the Launchpad Designer » Launching the Launchpad Designer 3

(https://help.sap.com/viewer/a7b390faab1140c087b8926571e942b7/7.4.17/en-US/
2d98610a5bcf43dfad588e755459dc42.html)

Create a new business catalog ZSAP_CEI DA.

Open the technical catalog SApP_CEI TC T.

On the Target Mappings tab, select the semantic object DigitalAccounts and then click the Create
Reference button. The Select Catalog dialog box appears.

Select the business catalog ZSAP _CEI DA.

Repeat steps 3 — 5 to assign the semantic objects TargetGroup and InteractionContact to the business
catalog ZSAP_CEI DA.

On the Tiles tab for the technical catalog SAP CEI TC T, dragand drop the Digital Accounts tile into the
Create Reference zone. The Select Catalog dialog box appears.

Select the business catalog zsAp CEI DA.

Openthe saP_CEC_BCG_MKT DM OP business group.

Add the Digital Accounts tile that the business catalog zSAP _CEI DA references to the business group.

On the SAP Fiori launchpad, click Personalize Home Page to add Digital Accounts to the business group
Contacts and Profiles.

Assign PFCG Role to Users

Call up transaction PFCG.

In the Role field, enter z CEI _BCR DIGITAL_ ACCOUNT. Click the Single Role button to create a new PFCG role
for Digital Accounts.

On the Menu tab, insert the SAP Fiori Tile Catalog node. The Assign Tile Catalog dialog box appears.

Enter zSAP_CEI DA as the catalog ID.

Installation and Configuration Guide 1702
Configuring Data Management CUSTOMER 83


http://help.sap.com/disclaimer?site=https://help.sap.com/nw75
https://help.sap.com/viewer/a7b390faab1140c087b8926571e942b7/7.4.17/en-US/2d98610a5bcf43dfad588e755459dc42.html
https://help.sap.com/viewer/a7b390faab1140c087b8926571e942b7/7.4.17/en-US/2d98610a5bcf43dfad588e755459dc42.html

5. Onthe Authorizations tab, assign the following authorization to the PFCG role:

Table 18:

Authorization Object Object Name Activity

HPA OBJECT CUAN_DIGITAL ACCOUNT Display, Change

6. Onthe User tab, assign the new PFCG role to users.

9.9 Marketing Locations

Marketing Locations allows you to maintain information about marketing locations. You can store information such
as location name, location address, coordinates, phone number, web address, email and location picture. You can
also upload location data using the Import Data application in the Import Data business group.

Access to Map Provider

You can also view marketing locations on a map. As a prerequisite, the user's browser needs access to the internet
domain here.com, which provides the map data. Note that only locations with a valid latitude and longitude are
shown on the map.

Consider the implications of communicating with servers outside your firewall.

For more information, see the security guide for SAP Hybris Marketing at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |» Security » Security Guide 3

https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4e6af5¢c/1702%20YMKT/en-US/
10i018¢cf203bb338438c8d8251194fb5abf3.pdf

9.9.1 Setting up Marketing Locations

To set up Marketing Locations, make the settings in the following activities in Customizing for SAP Hybris
Marketing under | Contacts and Profiles » Marketing Locations 3:

e Define Origins of Marketing Location ID
e Define Marketing Location Types

To enable users for Marketing Locations, assign your copies of the following PFCG roles to the corresponding AS
ABAP users:
® SAP CEI SCI FLP (business catalogrole)

® SAP CEI MARKETING LOCATION (for accessing Marketing Locations; included in composite role
SAP_MARKETING DATA MANAGEMENT)
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Uploading Marketing Location Data

To add marketing locations to SAP Hybris Marketing, you must import marketing location data from a comma-
separated value (CSV) file using the Import Data application in the Import Data business group.

For more information about importing marketing locations, see SAP Library for SAP Hybris Marketing on SAP Help
Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING | Application Help » SAP Hybris Marketing » SAP
Hybris Marketing Applications ¥ Contacts and Profiles ¥ Import of Data Using CSV Upload 3

(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
7dd16e5458548c4cel0000000a4450e5.html)

To access the Import Data application, the user must be assigned a copy of the
SAP MARKETING BUS ADMIN USERrole.

For more information, see the security guide for SAP Hybris Marketing on SAP Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |p Security » Security Guide 3

https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4e6af5¢c/1702%20YMKT/en-US/
10i018cf203bb338438c8d8251194fb5a5f3.pdf
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10 Configuring Insight

The settings described in this section are only relevant if you want to run SAP Hybris Marketing Insight.

10.1 Configuring SAP Smart Business, executive edition

The following applications within SAP Hybris Marketing are based on SAP Smart Business, executive edition:

Marketing Executive Dashboard

This application is available for marketing executives in the Marketing Executive business group.

The Marketing Executive Dashboard contains key performance indicators (KPI), which allow marketing executives
to review the success of marketing investments, and gain an overview of KPI attainment and marketing
performance benchmarks.

You are provided with a range of KPIs for the Marketing Executive Dashboard.

The following KPIs are available:

e Contact Conversion

e Sentiment Media Mix

® |eads

e Opportunities

e Sales Forecast

® Revenue

® Return on Marketing Investment (ROMI)
e Sales Pipeline

e Converted Pipeline

® Pipeline Acceleration

e Market Share

e Net Promoter Score

e \Web Visits

e \Web Downloads

e Brand Awareness

e Planned Budget, Planned and Actual Spend for Current and Last Year

1 Note

e The KPIs are delivered as templates. You might need to adjust them to better meet your business
requirements.
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e The KPlIs, and the descriptions of the measures and dimensions are only available in English.

1 Note

As a prerequisite for the use of the Marketing Executive Dashboard application, you must install SAP Smart
Business, executive edition and execute the technical configuration scenario Marketing Executive Dashboard
(see section Scenario "Marketing Executive Dashboard" [page 59]).

Lead Dashboard

This application is available for marketing experts in the Lead Management business group.

The Lead Dashboard app allows marketing experts to review the success of the lead management process, and
provides them with a comprehensive overview of Key Performance Indicator (KPI) attainment and lead
management performance benchmarks.

1 Note

As a prerequisite for the use of the Lead Dashboard application, you must install SAP Smart Business, executive
edition and execute the technical configuration scenario Lead Management with Cloud for Customer Integration
(see section Scenario "Lead Management with Cloud for Customer Integration" [page 62]).

10.1.1 User Configuration for SAP Smart Business, executive
edition

For the use of SAP Smart Business, executive edition, you must set up a user environment that creates a
corresponding SAP HANA user for every AS ABAP user.

Creating SAP HANA User for Configuration of SAP Smart Business, executive
edition

1. Logontothe SAP HANA studio with the sYsTEM user and choose the SAP HANA Administration Console

perspective under menu | Window » Open Perspective 3.

2. Inthe Navigator section on the left, expand the folder of your SAP HANA database.

3. Expand the corresponding security folder, select the Users folder, and choose the menu item New User from
the context menu. The User view appears.

4. Enter a name for the user (ABAP_HANA USER_ADMIN, for example) and a password.

5. Onthe Granted Roles tab, choose the + pushbutton. In the following Select Catalog Object dialog box, search
for sap.hana-app.cuan.common.roles: :XSUserAdmin. Select it in the Matching Items field, and confirm
your entry.
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6.

7.

Save the user. Role PUBLIC is automatically assigned to your new user.

Open the SQL Console and run the following command:

ALTER USER ABAP HANA USER ADMIN DISABLE PASSWORD LIFETIME

Creating Database Connection for User Creation

To set up a database connection to the SAP HANA database, proceed as follows:

A won e

Log on to the system with the user that you have created in section User for Application Setup [page 471].

Go to transaction bBCO and choose the New Entry pushbutton.

Enter a user-defined name in field DB Connection.

Enter HDB in field DBMS (Database Management System) to indicate that you are establishing a database
connection to a SAP HANA database.

Enter the name of the user that you have just created in the preceding section (Creating SAP HANA User for
Configuration of SAP Smart Business, executive edition) in field User Name and the corresponding password in
field DB Password.

Enter <Servername>:<SQLport> (for example, [d9719:30215) in field Connection Info. In a SAP HANA single-
container system, this entry is usually <Servername>: 3<InstanceNumber>15.

Take a note of this info for further processing in technical configuration.

Save your entries.

Maintaining System Settings for User Management in DBMS (Client-Specific)

> w oo

5.

Log on to the system with the user that you have created in section User for Application Setup [page 471].
Go to transaction sM30.
Enter usR_DBMS_SYSTEM in field View/Table and choose the Maintain pushbutton.
On the next screen, create a new entry and enter the following parameters:
o The database connection that you have created in section Creating Database Connection for User Creation
(see above).
©  The current client.
Save the entry.

As a result, for each ABAP user you create, a corresponding SAP HANA user is created automatically. If you have
already created your business users for SAP Hybris Marketing, do the following:

1

88

Go to transaction sA38 and run report RSUSR_DBMS_USERS. Enter all AS ABAP business users and select
Create and Map DBMS Users in the Function Selection section. Execute the report.

To check if your creation was successful you can open one of your users in transaction su01. On the tab
DBMS, you see a DBMS user and the information that a DBMS user exists.
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10.1.2 Exchange of Certificates Between SAP HANA and AS
ABAP

To be able to use SAP Single Sign-On in connection with logon tickets to log on to SAP Smart Business, executive
edition, you must exchange the corresponding certificates between the SAP HANA database and your SAP Hybris
Marketing AS ABAP system.

To do so, proceed as follows:

1. Logontothe SAP HANA XS Administration console under https://<your server>:<your HTTPS
port>/sap/hana/xs/admin with a SAP HANA user that is assigned the role
sap.hana.xs.admin.roles::TrustStoreAdministrator.

From the menu in the upper left corner, select Trust Manager.

In the Trust Store list, select SAPLOGON.

In the Trust Store details to the right, select the Certificate List tab.
Choose the Import Certificate pushbutton to import the HTTPS certificate presented by AS ABAP.
To complete the process, you must restart the SAP HANA Extended Application Services (SAP HANA XS). To
do so, proceed as follows:

1. Log on to the SAP HANA studio with the sYSTEM user and choose the SAP HANA Administration Console

o oA WD

perspective under menu | Window » Open Perspective 1.

In the navigation section to the right, choose the context menu of your system.

In the appearing section with system details to the left, select the Landscape tab.

In the context menu of the table entry with value xsengine in column Service, choose Stop.

ok wn

To restart, choose Start from the context menu of the same table entry.

10.1.3 Setup for SAP Hybris Marketing Business Users

To create marketing users for SAP Hybris Marketing, you are provided with the application Business User
Administration (see Setting up Application "Business User" [page 82]). To create marketing users that are allowed
to access the Marketing Executive Dashboard or the Lead Dashboard, proceed as follows:

1. For the Marketing Executive Dashboard, copy the composite role SAP. MARKETING EXECUT DASHBOARD and
its single roles to customer roles.

2. Forthe Lead Dashboard, copy the composite role SAP MARKETING INSIGHT and its single roles to customer
roles.

3. By default, the application creates all SAP HANA users with SAP Logon Ticket authentication. If you want to
restrict the role selection in this application to marketing roles only, open transaction sM30 and maintain view
CUANV_UM_ ROLES. Enter the marketing roles, to which the role selection of the application is to be restricted.

4. Create a user for SAP Hybris Marketing Business User Administration, and assign your copy of composite role
SAP_MARKETING USER_ADMIN.
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10.1.4 Creation of SAP Hybris Marketing Business Users

To create a business user within SAP Hybris Marketing, follow these steps:

1. Open SAP Hybris Marketing through the following URL: https://
<webdispatcher host>:<webdispatcher port>/sap/bc/ui5 ui5/ui2/ushell/shells/abap/
FioriLaunchpad.html?sap-client=<Client>#Shell-home.

2. Log on with the user for SAP Hybris Marketing Business User Administration from Setup for SAP Hybris
Marketing Business Users [page 89].

3. Open the Business User Administration application and create SAP Hybris Marketing business users. Assign
your copy of composite role SAP_ MARKETING EXECUT DASHBOARD Or SAP_MARKETING INSIGHT,
respectively (see section Setup for SAP Hybris Marketing Business Users [page 897).

4. When the SAP Hybris Marketing business users open SAP Hybris Marketing, they find the dashboard as
follows:

o The Marketing Executive Dashboard within business group Marketing - Executive Dashboard
o The Lead Dashboard within business group Lead Management

10.1.5 Optional: Modeling Instance Authorizations for
Restricted User Access

If you want to prevent your business users from seeing all data in the Marketing Executive Dashboard or in the Lead
Dashboard, you can model instance authorizations (for example, to restrict data by country) with the help of
analytic privileges. Analytic privileges in the SAP HANA database are used to grant different users access to
different portions of data in the same view depending on their business role.

As a prerequisite to model instance authorization using analytic priviliges, you must grant your users start
authorization for the corresponding SAP HANA information models relevant for the Marketing Executive
Dashboard or the Lead Dashboard.

For some of the steps below, you will need the SAP HANA developer guide, which you can find at:

http://help.sap.com/hana_platform#& | Development Information » SAP HANA Developer Guide 3

(http://help.sap.com/saphelp_hanaplatform/helpdata/en/34/29fc63alde4cd6876ea211dc86ee54/
frameset.htmesr)

Creating a SAP HANA Role for Authorization Purposes

To model authorizations, we recommend that you create a corresponding role first, which you can assign to the
relevant users. To do so, proceed as follows:

Create a new role as described in the SAP HANA developer guide under [+ Setting Up Roles and Privileges » Create
a Design-Time Role .
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Granting Start Authorization for Relevant SAP HANA Information Models

o oA WD

7.

Log on to the SAP HANA studio with the SAP HANA user for technical configuration (see section SAP HANA
User for Technical Configuration [page 36]).

In the Navigator section on the left, expand the folder of your SAP HANA database.
Expand the corresponding Security folder and the Roles folder.

Double-click the SAP HANA role that you have created in the previous step.

In the center section, choose the Object Privileges tab, and choose the + pushbutton.

In the following Select Catalog Object dialog box, search for one of the following SAP HANA information
models, confirm your selection, and select the privilege SELECT. Repeat this step for every information model
in the list below:

o For Marketing Executive Dashboard:
O sap.hana-app.cuan.mkteff.XSAPP.v/CA CE IC CONTACT ANALYSIS (_SYS_BIC)
O sap.hana-app.csan.common.internal/CA SE INTERACTION ANALYSIS (_SYS_BIC)
© sap.hana-app.cuan.mkteff.XSAPP.v/CA D CMO KPI VALUES (_SYS_BIC)
O sap.hana-app.cuan.mkteff.XSAPP.v/CA D CMO KPI VALUES OVER TIME (_SYS_BIC)
O sap.hana-app.cuan.mkteff.ext/AN CMO WEB DOWNLOADS (_SYS_BIC)
O sap.hana-app.cuan.mkteff.ext/AN CMO WEB VISITS (_SYS_BIC)

o For Lead Dashboard:
O sap.hana-app.cuan.lm.internal/CA LM IA KPI (_SYS_BIC)
O sap.hana-app.cuan.lm.internal/ CA LM LEAD PER IOI (_SYS_BIC)
O sap.hana-app.cuan.lm.internal/CA LM LEAD STAGE (_SYS_BIC)
© sap.hana-app.cuan.lm.internal/CA LM LEAD STAGE DAYS (_SYS_BIC)
O sap.hana-app.cuan.lm.internal/CA LM LEAD STAGE CURRENT (_SYS_BIC)

Save the role.

Creating Analytic Privileges

SAP has delivered an example analytic privilege, which you find in the SAP HANA database under |» Content » sap

» hana-app » cuan » mkteff » Analytic Privileges » AP_CMO_COUNTRY_TMP 1.

To create your own analytic privilege, proceeds as follows:

1

Log on to the SAP HANA system with the SAP HANA user for technical configuration (see section SAP HANA
User for Technical Configuration [page 36]).

Create a new repository package as described in the SAP HANA Developer Guide under ||+ Setting Up Your
Application » Maintaining Repository Packages » Create a Repository Package 1.
Create a new analytic privilege as described in the SAP HANA Developer Guide under | Setting Up Roles and

Privileges ¥ Create Analytic Privileges 3. You can use the following pre-delivered analytic privileges as
templates:
© For Marketing Executive Dashboard: sap.hana-app.cuan.mkteff.internal: :AP CMO KPI S4H
o For Lead Dashboard: sap.hana-app.cuan.lm.internal::AP_LM KPI S4H
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In the section Reference Models, add the SAP HANA information model to which you want to apply access
restrictions. The following information models are available:
For the Marketing Executive Dashboard:

Table 19:

SAP Smart Business, executive edi- SAP HANA Information Models Package

tion Data Source

Contact Conversion CA CE IC CONTACT ANALYSIS sap.hana-
app.cuan.mkteff.XSAPP.v

Sentiment Media Mix CA SE INTERACTION ANALYSIS sap.hana-app.csan.common
Marketing Executive Dashboard - KPI | cA D CMO KPI VALUES sap.hana-
Values app.cuan.mkteff.XSAPP.v

Marketing Executive Dashboard - KPI CA D CMO KPI VALUES OVER TIME |sap.hana-

Values Over Time app.cuan.mkteff.XSAPP.v
Web Downloads AN CMO WEB DOWNLOADS sap.hana-app.cuan.mkteff.ext
Web Visits AN CMO WEB_VISITS sap.hana-app.cuan.mkteff

For the Lead Dashboard:

Table 20:
SAP Smart Business, executive edi- SAP HANA Information Models Package
tion Data Source
Lead Dashboard — KPI Values CA LM IA KPI sap.hana-app.cuan.lm.internal
Lead Dashboard — Item of Interests CA LM LEAD PER IOI sap.hana-app.cuan.lm.internal
Lead Dashboard - Stages per Month/ |CA LM LEAD STAGE sap.hana-app.cuan.lm.internal
Year
Lead Dashboard - Stages per Day CA LM LEAD STAGE DAYS sap.hana-app.cuan.lm.internal
Lead Dashboard — Current Stages CA LM LEAD STAGE CURRENT sap.hana-app.cuan.lm.internal

In the section Associated Attributes Restrictions the column is defined on which the instance check should be
executed. In the example delivered with SAP Hybris Marketing, column LAND1, which represents a country, is
taken into account.

In the section Assign Restrictions, you define the values that need to be checked when the instance
authorization is carried out. You can define either fixed filter values or determine the values using a filter
procedure. A procedure has the advantage that you have to create less analytic privileges and roles.
Performance depends on the logic of the procedure. You can find detailed information on filter procedures in
the SAP HANA developer guide at:

| Setting up Roles and Privileges ¥ Create Analytic Privileges » Example: Create an Analytic Privilege with
Dynamic Value Filter 3
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(http://help.sap.com/saphelp_hanaplatform/helpdata/en/b5/08f2d6a35a4059b7505afb7a3682df/
content.htm#)

The example delivered with SAP Hybris Marketing uses the procedure sap.hana-app.cuan.mkteff/

PR XMLBASED FILTER FOR COUNTRY to determine the values for the field Country from the authorization
object CRA_CUNTR from the AS ABAP user assigned to the SAP HANA user.

Caution

Do not assign the analytic privilege directly to the users. It will be assigned to a role in the next step.

4. Now add your analytic privilege to the role that you have created in section Creating a SAP HANA Role for
Authorization Purposes above.

5. Logontothe SAP Hybris Marketing system with the user that you have created in section User for Application
Setup [page 471].

6. Go to transaction sA38 and run report RSUSR_DBMS_USERS. Enter all relevant AS ABAP business users.
Choose the Select DBMS Roles pushbutton in the DBMS Role Selection section and choose your new role.
Select Assign DBMS Roles in the Function Selection section. Execute the report.

As an alternative to the assignment in the back end, you can also assign the new role to the relevant users in
the SAP HANA studio. To do so, proceed as follows:
o Expand the Security folder of your SAP HANA database, then expand the Users folder.
o Double-click the user to which you want to assign the new role.
o In the center section, choose the Granted Roles tab, and choose the + pushbutton.
o Inthe following Select Catalog Object dialog box, search for the new role, double-click it, and save the user.
o Repeat these steps for every user to which you want to assign the role.

10.2 Creating SAP CRM Business Transactions

If you use SAP CRM as a source system, you can create activities directly in the SAP CRM source system from your
SAP Hybris Marketing system.

This function is based on the enhancement spot CUAN CRM CREATE 10 (Trigger Creation of CRM Activity) to
implement the BAdI CUAN CRM CREATE ONEORDER ACT (Create Business Transactions). This BAdl includes a
standard implementation.

If you want to enhance the standard implementation, create your own implementation on the basis of the
standard. In addition, consider SAP Note 1784897 ¥ .

For more information, see the document Create SAP CRM Business Transactions on the SAP Service Marketplace
at https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING

https://help.sap.com/doc/266f3ec81b36474bbe705cdflcdbc45a/1702%20YMKT/en-US/
CRMBusTransactions1702.pdf
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10.3 Importing Data from External Source to "Margin
Decomposition”

With the Web service CUAN ANALYTIC FND (to be accessed in your AS ABAP system under transaction SEGw),
you can import analytical data from any external source into the Margin Decomposition application of SAP Hybris
Marketing Insight.

In particular, you can import the amount and the document currency of the invoicing account for each of the
following decomposition groups in Margin Decomposition:

® Gross Revenue

® |nvoice Discounts
e Accrued Discounts
e CoGS

® Direct Costs

® |nvoice Surcharges

The data can also be provided on the granularity of decomposition subgroups, for example, to show reporting
results for different types of invoice discounts.

1 Note

You can also use the Web service to integrate Controlling data from SAP ERP (CO-Pa).

In addition, the data records are to be provided together with values (for IDs and codes) for characteristics/
dimensions such as the following:

e Customer Group

e [ndustry Code

e Sales Organization
e Country

® Region of Country
e Distribution Channel
e Division

e Sales Group

e Sales Office

e Sales District

e Product

e Product Group

e Product Category

1 Note

The needed master data or Customizing information for the dimensions values must be already part of SAP
Hybris Marketing by means of a connected SAP ERP system.
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For information about all required steps to set up the data import by Web service, see the corresponding guide on
the SAP Service Marketplace under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING | Integration ¥ View All  Import Analytical Data by
Web Service 3

(https://help.sap.com/doc/e5197692cac34f6eb39f2c49f24b7b83/1702%20YMKT/en-US/
ymktimpdtaWebServ1702.pdf)
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11 Configuring Segmentation

The settings described in this section are only relevant if you want to run SAP Hybris Marketing Segmentation.

11.1 Dialog Work Processes

To achieve optimal performance, SAP Hybris Marketing Segmentation parallelizes requests in the ABAP application
server as well as in the SAP HANA database. Therefore you must configure a suitable number of dialog work
processes. The number of dialog work processes depends on the number of frequent SAP Hybris Marketing
Segmentation users. A frequent user works, for example, every day for several hours in the system. The minimum
number of processes that the application requires is 25.

To configure the number of dialog work processes, follow the description in SAP Note 39412 ¥ .

= Recommendation

SAP recommends the following number of dialog work processes per number of frequent users:

Table 21:
Frequent Users <10 25 50 75
Dialog Work Processes 25 30 65 90

11.2 Geospatial Segmentation (Optional)

This function allows viewing the distribution of geolocations on a map (for example, the distribution of customers
in a region) and creating new segments based on areas defined on a map (radius or polygon).

If you want to use this function with any segmentation profile, you need to ensure that your attribute universe
provides the necessary geolocation information (for details, see chapter Setting up the Geospatial Segmentation
and Map Preview under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# |» Development » Extensibility Guide 3

(https://help.sap.com/doc/880bfld5aa0642d4b718cal530ccd131/1702%20YMKT/en-US/
loioda70d053fdd61823e10000000a44538d.pdf)
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Access to Map Provider

To use geospatial segmentation, you need both map visualization and geocoding services.

Access to Map Provider with Default Configuration

SAP ships a default configuration, which uses here.com for map visualization and geocoding. You can use this
default configuration if it fits your legal and functional requirements.

1 Note

SAP only provides the interfaces and configuration options which allow you to connect the map visualization
and geocoding services. The usage of here.com is not part of your end-user license agreement with SAP. It is
your responsibility to check and/or adapt the default configuration.

If you keep the default configuration, you need to check the following:
Map Visualization

The user's browser will need access to the internet domain here.com. The domain provides the map data that is
used in the geospatial segmentation option. Check, whether the users in question have access to this domain and
consider the implications of communicating with servers outside your firewall.

For more information, see the SAP Hybris Marketing Security Guide at https:/help.sap.com/viewer/p/
SAP_HYBRIS_MARKETING#&# | Security » Security Guide » Network and Communication Security »
Communication Destinations 3.

https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4e6af5¢c/1702%20YMKT/en-US/
l0i018cf203bb338438c8d8251194fb5a5f3. pdf

Access to Map Provider with Custom Configuration

You can change the configuration using SAP Visual Business. For more information, go to https://help.sap.com/
viewer/p/SAP_VISUAL_BUSINESS_2.1, |+ Technology Platform » SAP Visual Buisness 3.

To change the default configuration, go to Customizing Mode by selecting |» Personalization » Start Customizing
Mode 3 on the segmentation UL.

In the Console view, enter the following:

® sap.hpa.gseg.gen.Config(function (c) {c. setGeoService
("sap.hpa.gseg.gen.VbService") ;c.saveAllBagAttrValues () ; }) to change the configuration for
the geocoding service

® sap.hpa.gseg.gen.Config(function (c)
{c.setGeoMap ("sap.hpa.gseg.controls.VbMap") ;c.saveAllBagAttrValues () ;}) to change the
configuration for the map visualization

You can now change the configuration for the geocoding service under Customizing: [+ SAP NetWeaver » Ul

Technologies » SAP Visual Business ¥ Maintain Application Definition 3. The relevant application name is
GSEG_GEOSPATIAL.
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In case you want to go back to the default configuration, enter the following in the Console view:

® sap.hpa.gseg.gen.Config(function (c)
{c.setGeoService ("sap.hpa.gseg.gen.NokiaService") ;c.saveAllBagAttrValues () ;}) for
geocoding services

® sap.hpa.gseg.gen.Config(function (c)
{c.setGeoMap ("sap.hpa.gseg.controls.NokiaMap") ;c.saveAllBagAttrValues () ; }) for map
visualization.

11.3 SAP Hybris Marketing Integration with SAP Consumer
Insight 365

1 Note

To use this integration, you must have licensed and set up SAP Hybris Marketing Segmentation (see Configuring
Segmentation [page 96]).

If you productively use SAP Hybris Marketing as well as SAP Consumer Insight 365 you have the option to take
advantage of the integration of these products. By using the location planning or catchment features of SAP
Consumer Insight 365, the integration provides you with the automatic creation of a segmentation model in SAP
Hybris Marketing Segmentation.

For more information about the implementation of the integration, see the corresponding guide on SAP Service
Marketplace at:

https:/help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration » View all » Integrating SAP
Consumer Insight 365 » 3

https://help.sap.com/doc/487628cbf6cc486d9c89c876d7bf945f/1702%20YMKT/en-US/
IntegConsins365_1702.pdf

11.4 Enabling China-Specific Segmentation Profile

To enable the use of the China-specific segmentation profile All China Consumers (B2C) (SAP_CE_LOC_CN),
configure the china localization as described in section Configuring China Localization [page 135].

The All China Consumers (B2C) segmentation profile is used to segment WeChat followers by geographical
location on Baidu Maps. For more information, see the application help for SAP Hybris Marketing at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Application Help » SAP Hybris Marketing # SAP
Hybris Marketing Applications » Segmentation » Segmentation of WeChat Followers via Baidu Maps 3

(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
39ac65044ca841a89f3898d927el2c9e.html)
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12 Configuring Recommendation

The settings described in this section are only relevant if you want to run SAP Hybris Marketing Recommendation.

With SAP Hybris Marketing Recommendation you can build different product recommendation model types from
various sources (such as SAP ERP, SAP Hybris Marketing Data Management, as well as external data sources such
as social media) in order to provide a recommendation. This recommendation can be consumed by various
applications such as a web shop or an interaction contact.

In addition, Recommendation includes the Offer Management applications Offers and Manage Offer
Recommendations.

For more information about performance and load balance, see SAP Note 2264072 #sr .

1 Note

As a prerequisite for the use of the Recommendation applications, you must have executed the technical
configuration scenario Recommendation (see section Scenario "Recommendation” [page 65]).

12.1 Post-Installation Steps

12.1.1 Adapting Customer Channels for New Integration
Scenarios

Customer channels for which SAP does not provide an integration scenario must be adapted to consume
recommendations models using one of the following:

e Remote Function Call (RFC)

e OData service

For more information, go to https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING . Choose a release and
then |» Development » Extensibility Guide » SAP Hybris Marketing Recommendation 3.

12.1.2 Configuring Offer Management

Offer Management provides you with the following applications:

e The app Offers allows you to create, release, and put offers on hold. During creation, you define a validity
period and define the offer content. This can be both a picture and a text.
If you want to manage rule-based tasks in SAP Hybris Marketing, the SAP HANA rules framework must be
installed (see Scenario "HANA Rules Framework" [page 58]).
In addition, you can use an interface to generate offers from external systems.
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e \With the app Manage Offer Recommendations, you are provided with a rule-based offer finding option.
The app is based on the SAP HANA rules framework (see Scenario "HANA Rules Framework" [page 58]). The
app can include offers created in the Offers app or offers from SAP Promotion Management for Retail.

1 Note

Before you start configuring Offer Management, ensure that you have carried out the steps described in section
Initial Setup of SAP Fiori [page 68].

12.1.2.1 Setting up Application "Offers"

To set up the Offers application, assign your copy of the following role to the AS ABAP users of your marketing
managers or experts:

® SAP CEI OFFER APP (back-endrole;included in composite role SAP MARKETING RECOMMEND EXPERT)

By assigning the role, the users are given the following authorizations:

Table 22:
Authorization Object HPA OBJECT
Object Name (HPA_0OBJ) CUAN_OFFER, CUAN TARGET GROUP
Activity Display
Table 23:
Authorization Object HPA MKT AR
Object Name (HPA_0OBJ) CUAN_INITIATIVE, CUAN INTERACTION, CUAN OFFER
Activity Display
1 Note

The standard role SAP_CEI OFFER_APP includes an authorization check at instance level for marketing areas.
The marketing areas are defined in Customizing for SAP Hybris Marketing under |+ Planning ¥ General Settings

» Define Marketing Areas 1. If a user assigned to a copy of SAP_ CET OFFER_APP tries to access an object
instance for a particular marketing area, the system checks whether they are allowed to access that area.

In addition, you have to assign your copies of the following roles to the AS ABAP users of your marketing experts:

® SAP CEI ROF_FLP (business catalog role; no copy required - you can assign the delivered standard role)
® SAP CEI HOME (for personalization purposes)

Installation and Configuration Guide 1702
100 CUSTOMER Configuring Recommendation



Enabling the OData API for E-Commerce Integration

To display suitable offers to customers, the public OData service API CUAN OFFER DISCOVERY SRV can be used
to make offers available in an e-commerce scenario, for example in the SAP Hybris Commerce Web shop.

For more information about the OData API, see the Extensibility Guide on the SAP Help Portal at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration » Integration Guide » APIs and
OData Services » Generic Inbound OData Service for Offer Discovery J

https://help.sap.com/doc/ccaf91f47b0a489285b8e0c57a377349/1702%20YMKT/en-US/
loio8f37e2bdedf741d7b75¢cd7561cb813dd. pdf

To enable the OData API for e-commerce integration, you need to assign the technical AS ABAP user that is used
to communicate between the e-commerce suite, such as SAP Hybris Commerce, and the SAP Hybris Marketing
back-end system to the following role:

® SAP CEI OFFER PUBLIC API

After you have assigned the role, the user should have the following authorizations:

Table 24:
Authorization Object HPA OBJECT
Object Name (HPA 0BJ) CUAN OFFER
Activity Display
Table 25:
Authorization Object S_SERVICE
Program, transaction or function module name ® (OAC639FB8EBFB4FI9FBEA65AF56B546 R3TR IWSV
CUAN_OFFER DISCOVERY SRV 0001
® F0G6EB29134F3DAOEE136BA140613FB R3TR IWSG
ZCUAN OFFER DISCOVERY SRV 0001
Type of Check Flag and Authorization Default Values Hash Value for TADIR Object

Enabling the OData API for Offer Import

You are provided with the public OData APl CUAN OFFER_IMPORT SRV to import offers from any third-party
system to your SAP Hybris Marketing system. To enable the OData API for offer import, you need to assign the
technical AS ABAP user that is used to communicate between the legacy system and the SAP Hybris Marketing
back-end system to the following role:

® SAP CEI OFFER IMPORT API
For more information about the public OData APl CUAN OFFER IMPORT SRV, see https://help.sap.com/viewer/p/

SAP_HYBRIS_MARKETING# ||+ Integration ¥ Integration Guide » APIs and OData Services # Import of Offers
Using an OData Service J.
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After you have assigned the role, the user should have the following authorizations:

Table 26:
Authorization Object HPA OBJECT
Object Name (HPA OBJ) CUAN_OFFER
Activity ® Display
e (Change
Table 27:
Authorization Object HPA OBJECT
Object Name (HPA OBJ) HPA USER
Activity ® Display
Table 28:
Authorization Object S_SERVICE
Program, transaction or function module name ® G49DCCE8465AA4448AC9617AECEE27 R3TR IWSV
CUAN_OFFER IMPORT SRV 0001
® OB46720527408B9E1F11D1A881D0OFA R3TR IWSG
ZCUAN OFFER_IMPORT SRV 0001
Type of Check Flag and Authorization Default Values Hash Value for TADIR Object

12.1.2.2 Setting up Application "Manage Offer
Recommendations”

The Manage Offer Recommendations app is based on the SAP HANA rules framework. For this reason, as a
prerequisite for using the app, you need to follow the steps described in section Using Rule-Based Tasks [page
103].

In addition, you have to assign the following role to the AS ABAP users of your marketing experts:

® SAP CEI RECO_MKT OFFER (back-end role; included in composite role
SAP MARKETING RECOMMEND EXPERT)

After you have assigned the role, the user should have the following authorizations:

Table 29:

Authorization Object HPA OBJECT
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Object Name (HPA 0BJ) PROD RECO_ RUNTIME
Activity ® Display
e (Change
Table 30:
Authorization Object S_SERVICE
Program, transaction or function module name ® BFEC7A2EF5E9DC425B0A52F413DADT

® CB8C95D3F8063D9DF121A571A16BBB

Type of Check Flag and Authorization Default Values Hash Value for TADIR Object
Table 31:
Authorization Object S_RFC
Activity Execute
Name (Whitelist) of RFC object ® PROD RECO GET RECOMMENDATIONS

® PROD RECO GET RECO BY SCENARIO
® PROD RECO POST IA FOR SCENARIO

® PROD_RECO_POST_INTERACTION

Type of RFC object to which access Function Module
Table 32:
Authorization Object CRA_COUNTR
Activity e Display
e (Change

Table 33:

Authorization Object RECO_RTGET
Activity Read

In addition, you have to assign your copies of the following roles to the AS ABAP users of your marketing experts:

® SAP CEI ROF FLP (business catalog role; no copy required - you can assign the delivered standard rolee)
® SAP CEI HOME (for personalization purposes)

12.2 Using Rule-Based Tasks

Rule-based tasks are used in the Manage Recommendations app (for example, to do a re-rank of a result from a
previous step) as well as in the Manage Offer Recommendations app. Rules can also be used to find the best offer
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using an OData service. For more information, see Setting up Application "Offers" [page 100], section Enabling the
OData API for E-Commerce Integration.

To use rule-based tasks, it is required to have the SAP HANA rules framework installed. To do so, follow the steps
described in section Scenario "HANA Rules Framework" [page 58].

In addition, make sure that:

e SAP HANA rules framework activation plug-in is activated
e SAPHANAuser SAP COM 2002 <SAP SID> <Client> has the following privileges:
o All package privileges on the package system system-local.prodreco.hrf
o Object privilege SELECT and EXECUTE on data base schemas sAP_CUAN APPL, on physical data base

schema of authoring schema SAP_CUAN ERP, and on physical data base schema of authoring schema
SAP CUAN CAR.
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13 Configuring Planning

The settings described in this section are only relevant if you want to run SAP Hybris Marketing Planning.

With SAP Hybris Marketing Planning, marketing managers can plan budgets, programs, and spends in Budget
Plans; marketing experts can plan campaigns and spends in a simple and intuitive way in applications belonging to
the Spend Management business group. Marketing managers can view programs and the corresponding
campaigns that are assigned to the programs, and assign and remove campaigns to programs in the Programs
application. Marketing managers and marketing experts can have a complete overview of ongoing and planned
marketing activities in the Marketing Calendar application.

1 Note
Marketing Calendar does not yet support multiple currencies.

When configuring currencies, note that Budget Plans, Spend Management, and Programs only support rates of
type M.

13.1 Setting up "Budget Plans"

1 Note

Before you start with the configuration for Budget Plans, ensure that you have performed the steps described in
the following section:

® |nitial Setup of SAP Fiori[page 68]

To allow marketing managers to plan a budget according to their organization’s requirements, you configure how
budget planning is performed by defining a planning model and setting up the authorization for budget planning in
Customizing for SAP Hybris Marketing (see below). A planning model has a hierarchical structure that can have
both standard and custom dimensions for which budget can be planned. Dimensions can be as follows:

e Standard dimensions:
© Brand
o Market
o Country
o Region
© Audience

e (Custom dimensions:
Other dimensions for which marketing managers can plan budget. Custom dimensions are defined in
Customizing for SAP Hybris Marketing (see below).

When you define a planning model, you assign a dimension to a level in the hierarchy. You must have at least two
levels in your planning model. A budget is allocated to the dimension at the first level of the hierarchy. The
marketing manager plans a budget for the dimensions at the other levels of the hierarchy.
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For more information, see SAP Library for SAP Hybris Marketing on SAP Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# |+ Application Help » SAP Hybris Marketing # SAP
Hybris Marketing Applications » Planning » Budget Planning 3

(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
€03a20562d06c34ee10000000a44147b.html)

To set up budget planning, ensure that you make the following settings:

1.

10.

11.

12.

106

If custom dimensions are going to be used for budget planning, define them in Customizing for SAP Hybris
Marketing under | Planning ¥ Budget Planning ¥ Define Custom Dimensions 4.

If you defined custom dimensions, upload data for them in the system from a comma-separated value (CSV)
file using the Import Data application in the Import Data business group.

If brand is going to be used as a dimension for budget planning, upload brand data in the system from a CSV
file using the Import Data application in the Import Data business group.

If country is going to be used as a dimension for budget planning, define countries in Customizing for SAP
NetWeaver under |+ General Settings ¥ Set Countries 3.

If region is going to be used as a dimension for budget planning, assign regions to countries in Customizing for
SAP NetWeaver under | General Settings » Set Countries j Insert Regions 3.

If market is going to be used as a dimension for budget planning, make the required settings in Customizing
for SAP Hybris Marketing under | Planning » General Settings » Define Markets .

If audience is going to be used as a dimension for budget planning, maintain the audience data using the
Import Data application in the Import Data business group.

If budget planning is going to be done for different media types, make the required settings in Customizing for
SAP Hybris Marketing under | General Settings » Define Media Types 1.

If a plan uses a planning model for which media type is enabled, and no images or icons are defined for the
media types, the media type descriptions are shown in the axis of the chart. If only an image is defined for a
media type, the image is shown in the axis of the chart. If only an icon is defined for a media type, the icon is
shown in the axis of the chart. If both an image and an icon are defined for a media type, only the image is
shown in the axis of the chart.

1 Note

It is not mandatory to use media type for campaigns. However, if budget is planned for different media
types, it is mandatory that all campaigns that are assigned to programs and are funded by that budget have
media type assigned. Otherwise, if such campaigns have actual spend data, the actual spend cannot be
shown in Budget Plans. We recommend that you create a media type, such as other or miscellaneous, and
assign it to campaigns so that actual spend data for this media type can be shown in Budget Plans.

Make the required settings in Customizing for SAP Hybris Marketing under | Planning » General Settings »
Define Marketing Areas 3.

To define planning models that are going to be used for budget planning, make the required settings in
Customizing for SAP Hybris Marketing under | Planning » Budget Planning ¥ Define Planning Models 3.

If you want to restrict the values that can be used for plans in budget planning, create dimension relationships
and select the values of the dimensions that can be used in the Dimension Relationships application.

To set up user authorization for budget planning, do the following:
1. Make the required settings in Customizing for SAP Hybris Marketing under [ Planning » Budget Planning
» Define Areas of Responsibility 3.
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For more information, see Areas of Resonsibility in the application help for SAP Hybris Marketing at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# || SAP Hybris Marketing Application Help ¥

SAP Hybris Marketing #» SAP Hybris Marketing Applications ¥ Planning ¥ Authorization in Planning 4.
(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
655ae7917e85443380b7b9f4eel7c3d8.html)

2. Assign marketing areas and areas of responsibility to roles and then assign users to the roles using the
Role Maintenance (PFCG) transaction.

13. To define the default currency that is going to be used for budget planning and spend management, make the
required settings in Customizing for SAP Hybris Marketing under | Planning » General Settings » Set

Currency 3.
You must set up all currencies that you want to use for planning together with their exchange rates. Make the

required settings in Customizing for SAP NetWeaver under | General Settings » Currencies .
14 If you defined custom dimensions or if you want to change the labels for the standard dimensions and

measures, make the required settings in Customizing for SAP Hybris Marketing under |+ Planning ¥ Budget

Planning ¥ Define Labels for Dimensions and Labels .

For more information, see:

e SAP Library for SAP Hybris Marketing on SAP Help Portal at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Application Help » SAP Hybris Marketing »
SAP Hybris Marketing Applications » Contacts and Profiles  Import of Data Using CSV Upload J
(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
7dd16e5458548c4cel0000000a4450e5.html)

e SAP Library for SAP Hybris Marketing on SAP Help Portal at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# |» Application Help  SAP Hybris Marketing ¥
SAP Hybris Marketing Applications ¥ Planning ¥ Authorization in Planning » Authorization Examples for

Budget Planning, Programs, and Marketing Spend Management 3
(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
abd4845400082357e10000000a44176d.html)

Uploading Data for "Budget Plans"

If the planning model you have defined includes brand information, you need to upload brands in the system. You
upload brand data from a comma-separated value (CSV) file using the Import Data application in the Import Data
business group.

For more information, see SAP Library for SAP Hybris Marketing on SAP Help Portal at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# |» SAP Hybris Marketing » SAP Hybris Marketing
Applications ¥ Contacts and Profiles * Import of Data Using CSV Upload 3

(https://help.sap.com/viewer/0204678aad934e5da0ecf4d40ba38ca9/1702%20YMKT/en-US/
7dd16e5458548c4cel0000000a4450e5.html)

To access the Import Data application, the user must be assigned a copy of the following role:

® SAP MARKETING BUS ADMIN USER
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For more information, see the security guide for SAP Hybris Marketing on SAP Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Security ¥ Security Guide J

(https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4ebafbc/1702%20YMKT/en-US/
[0i018cf203bb338438c8d8251194fb5a5f3.pdf)

If you want to use custom dimensions, you proceed as follows:

1. Define the custom dimensions in Customizing for SAP Hybris Marketing under [ Planning » Budget Planning

» Define Custom Dimensions 4. You can define a maximum of 10 custom dimensions. The technical object
name for each dimension is CUAN_CUSTOM DIMENSION_(SAP technical ID of custom dimension from O1 to
10). The mapping from the dimension ID and the technical ID is done automatically. For example, you have
defined a custom dimension with the ID MyDimension. It will be mapped to the technical ID

CUAN CUSTOM DIMENSION 01.

2. Assign the custom dimensions to the planning model dimensions in Customizing for SAP Hybris Marketing
under | Planning ¥ Budget Planning ¥ Define Planning Model 3.

3. Upload the custom dimension values in the system from a CSV file using the Import Data application in the
Import Data business group.

To access the Import Data application, the user must be assigned a copy of the following composite role:

® SAP MARKETING BUS ADMIN USER

For more information, see the security guide for SAP Hybris Marketing on SAP Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Security ¥ Security Guide .

(https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4ebafbe/1702%20YMKT/en-US/
10i018cf203bb338438c8d8251194fb5a5f3. pdf)

Setting up the Authorization for "Budget Plans"

Budget planning, programs, and marketing spend management use marketing areas for authorization. In addition,
budget planning and programs use areas of responsibility. It is mandatory to set the marketing area and area of
responsibility for each user. For more information, see Authorization Examples for Budget Planning, Programs, and
Marketing Spend Management on SAP Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Application Help » SAP Hybris Marketing » SAP
Hybris Marketing Applications  Planning ¥ Authorization in Planning 3

(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
655ae7917e85443380b7b9f4eel7c3d8.html)

1. Define the marketing areas in Customizing for SAP Hybris Marketing under [ General Settings # Define
Marketing Areas 3.
2. Define the areas of responsibility in Customizing for SAP Hybris Marketing under [ Planning # Budget

Planning ¥ Define Areas of Responsibility 3.
For more information, see Areas of Resonsibility in the application help for SAP Hybris Marketing at: https://

help.sap.com/viewer/p/SAP_HYBRIS_MARKETING#& |p Application Help » SAP Hybris Marketing » SAP
Hybris Marketing Applications ¥ Planning ¥ Authorization in Planning 3.
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3. Assign areas of responsibility to users in transaction PFCG.

4. The users must be assigned a copy of the sap_CEI_2aMP role with the following start authorization settings:

Table 34:

Authorization Object Object Name (HPA OBJ) Activity (AcTvT)

HPA OBJECT CUAN BUDGET PLANNING © 02 (Change)
o 03 (Display)

5. Assign instance authorization to users as follows:

Table 35:

Authorization Object Object Name (HPA OBJ) Area of Responsibility ID Activity (AcTVT)

(RSPAREA 1ID)

HPA RSP AR CUAN_BUDGET PLANNING Area of responsibility ID as 02 (Change)
defined in Customizing for
SAP Hybris Marketing under

| Planning ¥ Budget

Planning » Define Areas of

Responsibility }

For more information about the authorization object, see the security guide for SAP Hybris Marketing on SAP Help
Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Security #» Security Guide J

(https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4e6af5¢c/1702%20YMKT/en-US/
10i018cf203bb338438c8d8251194fb5a5f3. pdf)

Setting Up the Map Visualization

The Budget Plans application does not come with a pre-configured map. To set up your map, follow the steps in the
SCN blog on SAP Visual Business:

http://scn.sap.com/docs/DOC-59547 ¥
For more information, see the SAP Visual Business documentation on the SAP Help Portal at:

http://help.sap.com/visualbusiness21 e
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13.2 Setting up "Programs"

Programs are containers for marketing activities. Marketing managers propose how much to be spent on
marketing activities.

Setting Up the Authorization for Programs

A user can assign a funding source to a program from any plan based on the area of responsibility and marketing
area to which the user is assigned.

1. The users must be assigned a copy of the SAP_ CEI PROGRAM role.
2. Assign the authorization for funding assignment as follows:

Table 36:

Authorization Object Object Name (HPA 0OBJ) Area of Responsibility ID Activity (AcTvT)

(RSPAREA 1ID)

HPA RSP AR CUAN BUDGET PLANNING | Area of responsibility ID as © 03 (Display)
defined in Customizing for
SAP Hybris Marketing under

|} Planning > Budget
Planning # Define Areas of

Responsibility |

For more information about the authorization objects, see the security guide for SAP Hybris Marketing on SAP
Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Security ¥ Security Guide J

https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4ebafbc/1702%20YMKT/en-US/
10i018cf203bbh338438c8d8251194fb5a5f3.pdf

13.3 Setting up Spend Management

Before you start with the configuration for the applications belonging to spend management (Quick Campaign
Spend, Detailed Campaign Spend), ensure that you have carried out steps described in section Initial Setup of SAP
Fiori [page 68].
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To set up spend management apps, you need to carry out the following steps:

Set up Spend Types

1. In Customizing, under SAP Hybris Marketing, go to |l Planning ¥ Spend Management » Define Spend Types 3.
2. Enter the spend types you want to use.
3. Save and close the transaction.

Assign Users to Roles for Spend Management

To enable marketing managers/experts to use the spend management apps Quick Campaign Spend and Detailed
Campaign Spend, you need to assign your copies of the following PFCG roles to their AS ABAP users:

e One of the following business catalog roles (no copy required - you can assign the delivered standard role):
o For managers: SAP_CEI PLG_FLP
o Forexperts: SAP CEI SMP FLP

® For managers: SAP_CEI MSM sM APP (back-end role; included in composite role
SAP_MARKETING PLANNING)

® Forexperts: SAP_CEI_MSM QE APPand SAP_CEI MSM sSM APP (backend roles;included in composite role
SAP_MARKETING SPEND MGMT PROG)

® SAP CEI HOME (for personalization purposes)

Add Authorization for Approval of Spends

1. Logon to your SAP Hybris Marketing system and call up transaction prcG.
2. Inorder to authorize users to approve spends, you need to assign the following activities to the following
authorization objects in your copies of the SAP standard roles SAP CEI MSM QE APP and
SAP_CEI MSM SM APP.
To assign the activities to the authorization objects in your copies of the SAP standard roles, proceed as
follows:
1. Gototransaction PFCG and call up your copy of SAP standard role SAP_CEI MSM QE APP in change
mode.
Switch to the Authorizations tab.
Choose the Change Authorization Data pushbutton.
Expand the node Cross-application Authorization Objects.
Add the missing activities based on the table above.
Save your changes and generate the profile.

N oo s N

Repeat steps 1 to 6 for your copy of SAP standard role SAP_ CEI_MSM_SM APP.
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Activate SAP ERP PS Integration for Cost Collection

To enable cost tracking for marketing spends in SAP ERP, activate one of the BAdI implementations of the
BAdI: Outbound System Integration for Cost References in Customizing under SAP Hybris Marketing:
|» Planning ¥ Spend Management .

If you have activated multiple BAdl implementations, we recommend that you use filter options to distinguish
between different campaign categories so that for one campaign category one implementation is processed.
With this option, you can create project WBS elements in different systems and avoid to generate multiple
projects and WBS elements for the same campaign.

If you activated the BAdI implementation Marketing Spends Actuals - Create Projects and WBS Elements (ES),
which is based on Enterprise Services, you have also to establish a logical port. For more information, see also
the documentation of the Customizing activity BAdI: Outbound System Integration for Cost References.
As a prerequisite you have maintained a logical port in the target SAP ERP system using the SOA Manager. In
the transaction SOAMANAGER under |+ Service Administration » Web Service Configuration 3 you have
configured the following services as SSL (https) connection and with the same service and binding name
CUAN_MSM PROJECT:

O ProjectERPCreateRequestConfirmation In V1 (internal name ECC_PROJECTERPCRTRC1)

O ProjectERPByIDQueryResponse In V1 (internal Name ECC_PROJECTERPIDQR1)

© ProjectERPUpdateRequestConfirmation In (internal name ECC_PROJECTUPDRC)
As a next step run task list CUAN_MSM SETUP_PS INTEGRATION as follows:

1. Log on to your SAP Hybris Marketing AS ABAP system with the application setup user. For more

information, see User for Application Setup [page 47].
2. Gototransaction sTCO1.
3. Execute task list CUAN MSM SETUP PS INTEGRATION.

Assign Marketing Area to Project Profile

In Customizing, under SAP Hybris Marketing, go to |* Planning » Spend Management » Assign Marketing Area
to Project Profile 3. (Defined in SAP ERP Customizing under |» Project System @ Structures » Operative
Structures » Work Breakdown Structure (WBS) ¥ Create Project Profile 3

Enter a Project Profile ID from SAP ERP PS to which you would like to assign a Marketing Area.

Select the Project Profile ID and select the Folder Assign Marketing Area

Choose New Entries to assign a new Marketing Area.

Maintain Project and WBS Element Prefix for SAP ERP

112

In Customizing, under SAP Hybris Marketing, go to|lr Planning ¥ Spend Management » Maintain Project and
WBS Element Prefix for ERP .
Create afirst entry and enter Prefix for ERP Project as wellasWBS Prefix. (Defined in SAP ERP

Customizing under | Project System ¥ Structures » Operative Structures # Work Breakdown Structure (WBS)
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» Project Coding Mask ¥ Define Project Coding Mask . These prefixes must not have any masks assigned in
SAP ERP.

Upload Actual and Committed Spend from External System

You can use one of the following ways to upload actual and committed spend:

e Using areport.
Go to transaction sE38 (Program Execution) and run program CUAN_MSM UPLOAD ACTUAL. You upload actual
and committed spend from a file. For more information about the required file format, see the report
documentation.

e Usingthe CUAN ACTUAL IMPORT SRV OData service.
For detailed information about how to use the OData service for the upload of actual spend, see section Import
of Actual Spend Using an OData Service in the SAP Hybris Marketing Master Guide under:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Integration » Integration Guide # APIs and
OData Services ¥ Import of Actual and Committed Spend Using an OData Service 3
(https://help.sap.com/doc/ccaf91f47b0a489285b8e0c57a377349/1702%20YMKT/en-US/
loio8f37e2bdedf741d7b75cd7561ch813dd. pdf)

e Using a CSV file in the Import Data application within the Import Data business group.
To access the Import Data application, the user must be assigned a copy of the role
SAP MARKETING BUS ADMIN USER.

The report, as well as the OData service, and the import using the CSV file, log either a success or an error
message. The log is displayed once the report is executed. You can also find all log messages using the transaction
Analyze Application Log (SLG1) transaction, entering the parameters CUAN IMPORT as an object and

CUAN_ ACTUAL_ IMPORT as a subobject.

13.4 Setting up "Marketing Calendar"

Marketing Calendar is an application that marketing managers and experts can use to see an overview of all
marketing-related activities for which they are responsible during selected time ranges. The focus here is on
aggregated KPIs and how they are influenced by marketing activities in the corresponding time context.

Marketing Calendar aggregates and displays data from different SAP Hybris Marketing applications. To use the full
functionality (all charts in the Marketing Calendar app show data), the following solutions should be enabled:

e Segmentation
® Planning

In addition, you are provided with the Subscribe to Campaign Calendar function. This calendar service for
subscription can be used with native calendar applications on devices that support the ICS format. The calendar
events contain detailed information about the corresponding campaigns.

Before you start with the configuration Marketing Calendar, ensure that you have carried out steps described in
section Initial Setup of SAP Fiori [page 68].
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To set up the Marketing Calendar app, carry out the following steps:
1. To enable marketing managers/experts to use the Marketing Calendar app, you need to assign your copies of
the following PFCG roles to their AS ABAP users:

o One of the following business catalog roles (no copy required - you can assign the delivered standard role):
o For managers: SAP_CEI PLG_FLP
o Forexperts: SAP_CEI SMP FLP

© SAP CEI MKT CAL APP (back-endrole;included in composite role SAP MARKETING MANAGER for

man_agers_andi_n cor;posite role SAP_ MARKETING SPEND MGMT PROG fgr experts) -
O SAP CEI HOME (for personalization purposes)

1 Note

The standard role SAP_ CEI_MKT CAL APP includes an authorization check at instance level for marketing
areas. The marketing areas are defined in customizing under SAP Hybris Marketing under |» Planning »

General Settings ¥ Define Marketing Areas 3. If a user assigned to a copy of SAP CEI MKT CAL_APP tries

to access an object instance for a particular marketing area, the system checks whether they are allowed to
access that area.

2. Configure your ABAP system to access the SAP Web Dispatcher as follows:

Log on to your SAP Hybris Marketing system with the user for application setup.
Call up transaction se16 and enter table HTTPURLLOC.

Press Create Entries.

A wop o

Create an entry with the following parameters:
o SORT KEY: MCAL
o PROTOCOL: HTTPS
© APPLICATN: /SAP/CUAN/CUAN MKTCAL ICS
o HOST: Enter the fully qualified domain name of your SAP Web Dispatcher that matches the Common
Name in your SSL certificate.
o PORT: Enter the HTTPS port.
o Save your entry.
5. Create an entry with the following parameters:
o SORT KEY: NAVT
© PROTOCOL: HTTPS
© APPLICATN: /sAP/BC/UI5 UI5/SAP/CUAN NAV TO
o HOST: Enter the fully qualified domain name of your SAP Web Dispatcher that matches the Common
Name in your SSL certificate.
o PORT: Enter the HTTPS port.
o Save your entry.
6. Integrate the marketing calendar as an internet calendar into your calendar application (supporting the
ICS format). For more information about this step, see the documentation of your calendar application.
You can use the Subscribe to Campaign Calendar function to transfer campaigns to your calendar
application. This works with all calendar applications (such as Microsoft Outlook) that support ICS format.
If you select this function, a mail opens in your email program containing a link which you can copy and
use once in your calendar application. The campaigns that are matching the filter criteria applied in the

marketing calendar (before running the Subscribe function) are then transferred to your calendar
application.
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3. Configure the SAP Visual Business by following the steps in the SAP Visual Business documentation:
http://help.sap.com/visualbusiness21# | Installation and Upgrade Information ¥ Installation and
Configuration Guide
(https://service.sap.com/~sapidb/011000358700000544602013E #)

1 Note
There is also an SCN blog on the subject:

http://scn.sap.com/docs/DOC-59547 #e
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14 Configuring Acquisition

The settings described in this section are only relevant if you want to run SAP Hybris Marketing Acquisition.

1 Note

To install Acquisition, you must first install Segmentation (see Configuring Segmentation [page 96]).

A prerequisite for configuring Acquisition is the corresponding technical configuration. If you have not executed
the technical configuration for Acquisition yet, follow the instructions in section Scenario "Campaign
Management" [page 60].

14.1 Configuring Campaigns

The configuration of campaigns requires a few manual steps that are described in this section.

14.1.1 Prerequisites

Define Interaction Interests

If required, you have defined the necessary interests on the user interface in the Manage Interests application in
the Business Administration business group.

Configuring the SAP Web Dispatcher

For the tracking services to run as required, define a routing rule for the tracking and bounce ICF services /sap/
public/cuan/linkand /sap/public/cuan/bounce. They need to be routed to the ABAP backend servers
where the corresponding ICF services run.

For the tracking services to run as required, extend the SAP Web Dispatcher profile of your publicly accessible web
dispatcher as follows:

1. Enter the port number to be used to access the SAP Web Dispatcher for the tracking services: icm/
server port <port enum> = PROT=HTTPS, PORT=43<xx>, VCLIENT=0
O <port_ enum>is used to enumerate the port number entries in the profile. It determines the order in
which these entries are searched for. As soon as the first valid entry is found, the web dispatcher stops
searching and uses that entry.
o <xx> defines the last digits of the port number used.
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2. Enter the system and URL of the backend system running the tracking services: wdisp/system <sys enum>
= SID=<SID>, EXTSRV=https://<hostname>:<port>, SRCSRV=*:<port number> - -

0 <sys_enum> is used to enumerate the system entries in the profile. It determines the order in which these
entries are searched for. As soon as the first valid entry is found, the web dispatcher stops searching and
uses that entry.

0 <s1D>defines the ID of the SAP system that the services are running on.

© <host name>and <port> define the host name and port that must be used to access the tracking
services.

O <port number> defines the complete port number defined above in the entry icm/
server port <port enum>

Caution

For the tracking services it is essential that you disable the client verification at the SAP Web Dispatcher.

e Disabling client verification for all ports
The following code line in the sample profile disables client verification for all ports: icm/HTTPS/
verify client = 0
e Disabling client verification for a specific port
If certain application parts require client authentication, you can disable the client verification at port level.
This is done by adding VCLIENT=0 to the code line that specifies the SAP Web Dispatcher port in question.
In the sample profile, for example, you would have to make the following changes:
o Take out the following code line from section 'Start Web Dispatcher: icm/HTTPS/verify client =
0
o Change the following code line in section 'SAP Web Dispatcher Ports' from: icm/server port 1 =
PROT=HTTPS, HOST=mo-29b02fleb, PORT=825$ to: icm/server port 1 =
PROT=HTTPS, HOST=mo-29b02fleb, PORT=82$$, VCLIENT=0

14.1.2 Setting Up Service Provider for Emails and Text
Messages

In the following you will find information about how to conduct your system for SAP Hybris Marketing with the
required service providers, such as SAP Mobile Services, for sending out emails and text messages directly out of
the system.

With the following steps you will be able to send mass emails to your customers and inform them, for example,
about your new developments.

As a preperation we recommend to read the following documents and recommendations to don't get listed as a
spammer Deliverability Best Practices # .

To be prepared for the onboarding for SAP Mobile Services as email provider, see SAP Intelligent Notification 365
Email Service - On-boarding Guide for Hybris Marketing Customers # and fill out the following form Details To Be
Collected During Email Provisioning [page 119].

Please follow the steps below to get your service provider up and running:

Installation and Configuration Guide 1702
Configuring Acquisition CUSTOMER 117


http://help.sap.com/disclaimer?site=https://community.sapmobileservices.com/t5/SAP-Intelligent-Notification-365/Deliverability-Best-Practices-Guide-for-SAP-Intelligent/td-p/2492
http://help.sap.com/disclaimer?site=https://community.sapmobileservices.com/t5/SAP-Intelligent-Notification-365/SAP-Intelligent-Notification-365-Email-Service-On-boarding-Guide/td-p/2496
http://help.sap.com/disclaimer?site=https://community.sapmobileservices.com/t5/SAP-Intelligent-Notification-365/SAP-Intelligent-Notification-365-Email-Service-On-boarding-Guide/td-p/2496

1. First of all set up SAP Mobile Services as your service provider according to your needs:
© Prerequisites

o You need an account with SAP Mobiles Services for sending emails using http service call.

If you need more details or have questions on this solution, send an email to SAP Mobile Services
mailto:sapmobileservices@sap.com.

To access the http service from SAP Mobile Services, you must populate the externally visible IP
address of your server to SAP Mobiles Services and you must know the ID, so that it can be added to
the whitelist of allowed callers for your account. If you are using a proxy for sending, you must
populate the external IP address of the proxy.

o If you want to receive delivery feedback (text messages delivered to handset or delivery failed), you
have to open a port in your firewall for inbound calls from the server of SAP Mobile Services. You have
to provide an externally visible host name and port for this connection. This should already be set up
in section Prerequisites [page 116], Configuring the SAP Web Dispatcher, above for tracking and also
applies here.

o You have a User and a Password as well as a URL and a Path Prefix (such as https://sms-
pp.sapmobileservices.com/cmn/<accountid>/<accountid>.sms whereas /<accountid>/
<accountid>.sms is the path prefix) from SAP Mobile Services.

o Import SSL Certificates for Email and Text Messages from SAP Mobile Services in the Trust Store

1. Download SSL certificates for your email or text message API target host by using the following URLs
(you can also download the SSL certificate by opening the target host URL in your internet browser
and downloading the SSL certificate): https:/multichannel-pp.sapmobileservices.com/email/ # and
https://sms-pp.sapmobileservices.com/cmn/ #
https://multichannel-pp.sapmobileservices.com/email/ #

1 Note

The links above do not work in all browsers. Use an appropriate browser to open the link.

2. Import the certificates into the PSE as described in Creating the Anonymous SSL Client PSE. You find
this topic under http://help.sap.com/nw75# | Application Help » Function-Oriented View ¥ Security
» Network and Transport Layer Security ¥ Transport Layer Security on the AS ABAP » Configuring the
SAP NetWeaver AS for ABAP to Support SSL  Creating the Anonymous SSL Client PSE 3.
http://help.sap.com/saphelp_nw75/helpdata/en/49/26af8639242583e10000000a421937/
content.htm e
3. Set SSL to Active for RFC destinations MSMAIL and SMSSAP.
4. Select the certificate list to which you uploaded the certificates.
5. Testthe MsMAIL and sMsSAP RFC destination. If you receive an HTTP response code 500 with a
response body containing a JSON string, then the setup is correct.
2. Then maintain the provider credentials for the provider you are using. For more information, see Provider
Credentials [page 122].
3. Finally maintain your sender profiles. For more information, see Sender Profiles [page 119].

For more information about the integration with Amazon, see Setting up Amazon Email Service Provider [page
120].
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14.1.2.1 Details To Be Collected During Email Provisioning

Please use the following form to fill in all details.

Table 37:

Customer Service(s) Details
Please enter for each Domain or Sub-Do- Sender Name From Address Reply-To Address
email the required sub- | main
domains with the add-
esses for From- Example: newsletter.ex- | <Your Company <Your main email ad-
(Sender) and Reply To- | @mple.com Name> dress such as info@ex-
addresses. ample.com>
Deliverability? SPF or DKIM

DKIM key size

e 2048

e 1024
Notifications From? Single Source (Application)

Multiple Sources (Applications)

Source Public IP Ad-
dresses for On-Prem
Only (Please list.)

Contact Name and
Phone Number (Cus-
tomer)

14.1.2.2 Sender Profiles

Marketing administrators can use this app to maintain sender profiles on the user interface for the channels email
and text message. It allows them to ensure, their marketers can carry out campaigns for different channels in
different markets.

Prerequisites

® You have setup the service provider for emails and text messages.
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For more information, see Setting Up Service Provider for Emails and Text Messages [page 117].

® You have done the steps in Customizing for SAP Hybris Marketing, by choosing | Campaigns » Campaign

Define Sender Profile 3.
® You have registered the Sender Address and the Reply-To Address at SAP Mobile Services and/or Amazon.

Maintain Sender Profiles

You use this app to:

1. Choose the Sender Profiles app and edit either an existing sender profile for a specific marketing area or create
a new sender profile by copying an existing entry.
o For email messages: Adapt a sender profile name and enter the name and email addresses for the sender
and recipient.
o For text messages: Adapt a sender profile name and enter the name for the sender of the text message.
2. Save your entries.

Test Sender Profiles

To test the maintained sender profiles, we recommend to use Send Test Email or Send Test Text Message to ensure
that the settings are working. Otherwise the issues can appear during campaign execution.

The test sends a message to one or more email addresses.

= Recommendation

We strongly recommend to test the sender profile to ensure that the settings are working.

14.1.2.3 Setting up Amazon Email Service Provider

In order to set up the Amazon email service provider, several parameters have to be adjusted in Amazon Service for
Emails, Notifications and Queues and SAP Customizing.

Prerequisites

The following prerequisites exist for setting up Amazon as an email service provider:

® You are familiar with the basics of the Amazon Service for Emails, Notifications and Queues:
O aws.amazon.com/de/documentation/ses/
© aws.amazon.com/de/documentation/sns/

O aws.amazon.com/de/documentation/sqgs/
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e You have an Amazon Web Service Account for the Simple Email Service (SES) using http (not smtp)
e The Amazon Service for Emails, Notifications and Queues have been configured correctly. To do this, go into
the Amazon Management Console and prepare the following:
1. Configure a verified sender email address. You will need this when you define a sender profile later on.
2. For the verified sender email address, edit the Notification Configuration and create a new Amazon SNS
topic, so that bounces and complaints create notifications. Give the new topic the same name as the
feedback queue.

3. Inthe Sender Notification Configuration, assign the SNS topic and disable Email Feedback Forwarding.

4. Inthe SQS console, create a new queue with the same name you gave the feedback queue in technical
configuration.

5. Subscribe the new queue to the SNS topic you created earlier.

1 Note

Please create for each system and client a seperate bounce queue on the Amazon side, because otherwise
the bounces aren't processed correctly and might be missing in the corresponding system.

® You have set an account up at Amazon and got the following parameters during the set-up:
©  Amazon Access Key ID (hash string)
o Secret Access Key (hash string)

o Feedback Queue Path
The Feedback Queue Path is the last individual portion of the queue URL at Amazon. For example, the path
fromhttps://sgs.eu-west-1.amazonaws.com/NNNNNNNNNNNN/ABC iS /NNNNNNNNNNNN/ABC.

1 Note

You will need these parameters again during the Technical Configuration.

® You have access granted on Amazon for the following APl methods:
0 SendRawEmail (SES)
0 ListIdentities (SES)
0 GetIdentityVerificationAttributes (SES)
0 ReceiveMessage (SQS)
© DeleteMessageBatch (SQS)
For more information, see Controlling Access to Amazon SES # .

For more details about the setup of Amazon, see the following links:

e Sending: http://docs.aws.amazon.com/ses/latest/DeveloperGuide/before-you-begin.html #*
e Notifications: http://docs.aws.amazon.com/ses/latest/DeveloperGuide/configure-sns-notifications.html #

® Queue: http://docs.aws.amazon.com/AWSSimpleQueueService/latest/SQSDeveloperGuide/
sqgssubscribe.html #*
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Import Amazon SES SSL Certificates in the Trust Store

1. Download SSL Certificates for your AMAZON SES target host by using the following URLs (you can also
download the SSL certificate by opening the target host URLs in your internet browser and downloading the
SSL certificate):

o Certificate for sending: https:/email.eu-west-1.amazonaws.com
o Certficate for the bouncing queue: https://sqgs.eu-west-l.amazonaws.com

1 Note
The links above do not work in all browsers. Use an appropriate browser to open the links.
2. Import the certificate into the PSE as described in Creating the Anonymous SSL Client PSE. You find this topic
under http://help.sap.com/nw75#% |l Application Help ¥ Function-Oriented View » Security » Network and

Transport Layer Security » Transport Layer Security on the AS ABAP » Configuring the SAP NetWeaver AS for
ABAP to Support SSL # Creating the Anonymous SSL Client PSE 7.
http://help.sap.com/saphelp_nw75/helpdata/en/49/26af8639242583e10000000a421937/content.htm

3. Set SSL to Active for RFC destinations AMAZONMATIL and AMAZONBOUNCE.

4. Select the certificate list to which you uploaded the certificates.

5. Testthe aMAZONMATL RFC destination. If you receive an HTTP response code 404, then the set up is correct.

14.1.2.3.1 Provider Credentials

With the Provider Credentials app you maintain the provider credentials that you got from the service provider
such as Amazon SES for sending out emails and text messages out of your system.

1 Note

The settings here are pre-filled with data that has been already entered during the technical configuration.

Prerequisites

® You have created the communication arrangements for the required service providers.
e Your user has been assigned to the single role SAP CEI PROVIDER CREDENTIALS.
® Your user has been assigned to the business catalog role SAP_CEI _KUA FLP .

Maintaining Provider Credentials

1. Choose the Provider Credential app.
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2. Depending on the services you use you have to maintain some of the following credentials you got from your
service providers:

o SAP Mobile Services (Email) and SAP Mobile Services (Text Message)

o UserlID

o Password

o Path Prefix such as /email/<accountID customer-specific>/notifications
o Amazon SES

o Access Key

o Secret Key

o Bounce Queue Path: The Bounce Queue Path (also known as Feedback Queue Path) is the last
individual portion of the queue URL at Amazon. For example, the path fromhttps://sgs.eu-
west-1.amazonaws .com/NNNNNNNNNNNN/ABC iS /NNNNNNNNNNNN/ABC.

3. Save your entries.

Test Provider Credentials

To test the saved credentials choose Test.

The system then checks the saved data and shows the results in a popup. Choosing the corresponding line you get
more information in case there are any issues.

With the check report CUAN_ MKT EXEC CHECK CONFIG you can check your configuration settings for sending
emails and text messages.

14.2 Integrations

The Campaign Management in SAP Hybris Marketing can be integrated with various internal or external systems
or services. You can find a description of available integrations on the SAP Help Portal under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING | Integration ¥ Integration Guide J

(https://help.sap.com/doc/ccaf91f47b0a489285b8e0c57a377349/1702%20YMKT/en-US/
loio8f37e2bdedf741d7b75cd7561cb813dd.pdf)

The setup of the following integrations are included in the integration guide:

Setting up Integration with Facebook (Optional)

You can plan and create campaigns that are handed over to Facebook for execution. Optionally, you can define and
transfer a target group to be addressed at Facebook. From Facebook, actual spend and campaign success data is
retrieved and made available for analysis in SAP Hybris Marketing.
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Setting up External Campaign Integration (Optional)

You can create campaigns on generic external systems, which are implementing the interfaces for external
campaigns. Alternatively, you can use a middleware such as SAP HANA Cloud Integration (HCI) to map the SAP
Hybris Marketing interfaces to the interfaces of the external system (such as Twitter).

Enabling WeChat-Specific Campaign Categories and Actions

You can integrate WeChat with your system.

Setting up Landing Pages

You are provided with the Landing Pages application. This app allows you to design landing pages to collect
interaction contact and marketing permission data. The content of the app is also included in the Content Studio
application.

Setting up the Integration of Digital Asset Management Systems

Digital asset management (DAM) systems provide catalogs of digital images, videos, documents, music etc. Digital
assets can be searched easily by keywords. With the integration of DAM systems you can directly access images
for use in static image links in an email. SAP delivers standard settings for the following DAM systems:

e Hybris Product Content Management
e SAP Hybris Digital Asset Management by OpenText

14.2.1 Setting up Integration with Paid Search (Optional)

The integration of SAP Hybris Marketing with Paid Search provides you with the following options:

e |f you use the classic Campaigns app, you can create marketing campaigns that correspond to a paid search
campaign in Google AdWords, Yahoo Gemini, or Bing Ads using the Create Paid Search Campaign pushbutton
on the overview screen of the the Campaigns app.

e |f you use the flow-based Campaigns app, you can create marketing campaigns that correspond to a paid
search campaign in Google AdWords using the Paid Search pushbutton in the Select Campaign Type screen.

e From the Campaign overview screen, you can open a paid search campaign by selecting it in the overview list,
and display key performance indicators (KPIs) either retrieved from Google AdWords or manually uploaded
(for Google, Yahoo, and Bing campaigns).

e \When you open a target group in the Target Groups app, on the Campaigns tab of the target group details
screen, you can open a paid search campaign by selecting it from the list.

® From the Marketing Calendar app (in the Campaign Management or the Spend Management business groups),
you can open a paid search campaign by selecting it in the campaign calendar view.
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e From the Import Data app (in the Import Data business group), you can upload campaign KPIs using the
Campaign Success option.

e When SAP Hybris Marketing Planning is active, you can plan spends for paid search campaigns and open these
campaigns by selecting the correponding campaign ID in the Marketing Spend - Details app (Spend
Management business group). You can also see the cost of the campaign in the Spend view.

Before you start with the configuration for the Paid Search integration, carry out the following steps Customizing
for SAP Hybris Marketing (transaction SPrO):

e Under | General Settings ¥ Define Media Types 3

Table 38:

Media Type Media Type Description SAPUI5 Icon Name

PAID SEARCH Paid Search search

e Under |l Contacts and Profiles ¥ Interactions » Define Communication Media J:

Table 39:
Communication Medium Communication Medium Description | Media Type ID
BING_ADS Bing Ads PAID_SEARCH
GOOGLE_ADS Google Ads PAID_SEARCH
_YAHOO ADS Yahoo! Ads PAID_SEARCH

e Upload animage for each of the entries above, with the logo of the specific communication medium (shown on
the Paid Search and the Campaigns screens) using the Manage Images Fiori app.

e Under | Campaigns » Campaign ¥ Define Categories and Actions 4 in the Define Campaign Categories view:
If you use the classic Campaigns app:

Table 40:
Category | Category Name Category Tooltip Is Active | Perm. Hldng Process Type
ID
PS Paid Search Campaigns for creating and link- | Yes Ignore Paid Search
ing to paid search campaigns Marketing
executed on search platforms Permission

such as Google, Bing, Yahoo
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If you use the flow-based Campaigns app:

Table 41:

Category | Category Name Category Tooltip Is Active | Perm. Hldng Process Type

PGS AdWords Search | Google AdWords campaigns for | Yes Ignore Paid Search
advertising on Google search Marketing
(Search Network only) Permission
1 Note

It is recommended that you have either campaign category ID PGS or Ps activated, but not both in parallel.

e Under |} Campaigns  Campaign ¥ Define Categories and Actions 3 in the Define Campaign Actions view:

Table 42:
Action ID Action Name Action Button Text Button Tooltip Class/Interface
PS_CUSTOM AUDIENC | Create Paid Search Create Paid Search Create Paid Search CL_CUAN_MO_TG_TRA
E Custom Audience Custom Audience Custom Audience NSFER PS

e Under |} Campaigns » Campaign ¥ Define Categories and Actions 3 in the Assign Actions to Categories view
for the ps category ID (or PGS if you use the flow-based Campaigns app):

Table 43:

Action ID Action Name

PS CUSTOM AUDIENCE Create Paid Search Custom Audience

To access the Campaign Management business group and the Paid Search application, the user must be assigned
a copy of the following roles:

® SAP CEI CPM FLP (business catalog role; no copy required - you can assign the delivered standard role)
® SAP CEI TG INI (back-endrole;included in composite role SAP MARKETING DATA MANAGEMENT)
® SAP CEI HOME (for personalization purposes)

For more information, see Integrating SAP Hybris Marketing Paid Search with SAP HCI at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING#|p Integration » View all » Integrating SAP Hybris
Marketing Paid Search with SAP HCI

https://help.sap.com/doc/dc85e3bf387e48509bfd9755560b407a/1702%20YMKT/en-US/
IntegHCIPaidSearch_1702.pdf
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Uploading Data for Paid Search KPIs

KPIs for Google AdWords campaigns are retrieved automatically from Google via the scheduled background job
SAP CUAN PAID SEARCH KPI . Thisjob isscheduled to runon aregular basis to always have the most up to
date KPlIs for your Google AdWords campaigns.

You can also manually upload campaign success KPIs. You upload campaign success data from a comma-
separated value (CSV) file using the Import Data application in the Import Data business group.

For more information, see SAP Library for SAP Hybris Marketing on SAP Help Portal at:
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING#r |+ Application Help » SAP Hybris Marketing
Applications ¥ Contacts and Profiles # Import of Data Using CSV Upload 3

(https://help.sap.com/viewer/0204678aad934e5dalecf4d40ba38ca9/1702%20YMKT/en-US/
7dd16e5458548c4cel0000000a4450e5.html)

To access the Import Data application, the user must be assigned a copy of the following role:

® SAP MARKETING BUS ADMIN USER

To upload paid search KPls, the user must have the following authorization object assignments:

Table 44:
Authorization Object ‘ Object Name (HPA OBJ) Activity (acTvT)
HPA OBJECT CUAN_ INITIATIVE 02 (Change)
Table 45:
Authorization Object ’ Object Name (HPA OBJ) Action Name (HPA_ACTION) | Activity (ACTVT)
HPA ACTION CUAN_INITIATIVE UPDATE_EXTERNAL REPORTI | 16 (Execute)
NG_DATA

For more information, see the security guide for SAP Hybris Marketing on SAP Help Portal at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING# | Security ¥ Security Guide J

https://help.sap.com/doc/d2f34d1cf75c4744a7e83378b4ebafbc/1702%20YMKT/en-US/
10i018cf203bb338438c8d8251194fb5a5f3.pdf

14.2.2 Setting up Integration with SAP CRM (Optional)

Enhanced integration of SAP Hybris Marketing with SAP CRM offers the following options:

e |nthe Campaigns app in business group Campaign Management, you can use an action to create leads,
opportunities, tasks, activities, or call lists in SAP CRM.

® [or acampaign, you can display success measures that are based on the leads, opportunities, tasks, activities,
or call lists created in SAP CRM.

® |nthe Marketing Executive Dashboard, the leads created in SAP CRM are displayed as key figures.
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For more information, see the SAP CRM Integration checklist under https://help.sap.com/viewer/p/
SAP_HYBRIS_MARKETING# | Integration j» View all  Integrating SAP Hybris Marketing with SAP CRM:
Checklist 3

https://help.sap.com/doc/43391cab490e4a5db5653a9d97a74dd3/1702%20YMKT/en-US/CRMCheckl1702.pdf

14.2.3 Setting Up Call Center Integration (Optional)

SAP Hybris Marketing provides you with the option to integrate call centers in your campaign execution.

You have the following integration options:

® [ntegration with SAP Hybris Cloud for Customer (see Setting Up Call Center Integration with SAP Hybris Cloud
for Customer [page 128])

e |ntegration with SAP Contact Center or an external call center (see Setting up Call Center Integration with SAP
Contact Center or External Call Centers [page 129])

® Integration with SAP CRM Interaction Center (see Setting up Integration with SAP CRM (Optional) [page 127]
and Installation of SAP Landscape Transformation Replication Server [page 30])

14.2.3.1 Setting Up Call Center Integration with SAP Hybris
Cloud for Customer

1 Note

e As a prerequisite for the call center integration with SAP Hybris Cloud for Customer, you must have carried
out the steps related to C4C integration described in section Scenario "Lead Management with Cloud for
Customer Integration" [page 62].

e |f SAP Hybris Marketing is integrated with SAP CRM or SAP ERP, these systems must also be connected to
the SAP Hybris Cloud for Customer systems. This ensures that the replication of customers and business
transactions, such as leads or opportunities is consistent.

You are provided with the option to trigger SAP Hybris Cloud for Customer call qualifications to the SAP Hybris
Cloud for Customer system directly from a campaign in your SAP Hybris Marketing system. A standard action for
campaigns is available to do so. These call qualifications are handled as marketing leads in SAP Hybris Cloud for

Customer.

Assigning Standard Action to Campaign Category

To activate this function, you must assign the standard action CALL QUALIFICATION (Trigger C4C Call
Qualification) to a campaign category in Customizing for SAP Hybris Marketing (transaction sPrO) under

| Campaigns » Campaign ¥ Define Campaign Categories and Actions 3. This is already assigned to the campaign
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category CIC - Call Center in the standard SAP system or you assign the action CALL _QUALIFICATION to the
required category as follows:

1. Select the required category to which you want to assign the action CALL_QUALIFICATION in the Define
Campaign Categories view.

Choose the Assign Actions to Categories view.

Choose New Entries.

Choose the action CALL_QUALIFICATION from the value help for the Action ID field and confirm your entry

o M wn

Enter any required text in the Action Button Tooltip and Button Tooltip fields if you want to override the action
button text and button tooltip that is specified directly in the action. This override is valid in the context of this
category/action relationship only.

As aresult, the new action is available for new campaigns with this category.

Check Permission to Contact in SAP Hybris Marketing

According to the Customizing settings you have made, when the action to create the call list is executed in SAP
Hybris Marketing, the system checks whether permission to make contact by telephone is available. Check this

setting in Customizing for SAP Hybris Marketing under |» Campaigns » Campaign ¥ Define Campaign Categories

and Actions 3. Choose Define Campaign Categories followed by the category c1c. If the value Ignore Marketing
Permission has not been selected for the Category Type, the system checks whether permission to make contact is
available when the action to create the leads (CALL_QUALIFICATION) is executed.

14.2.3.2 Setting up Call Center Integration with SAP Contact
Center or External Call Centers

Integration with SAP Contact Center

File Export for SAP Contact Center

You can export call center requests to SAP Contact Center directly from a campaign in your SAP Hybris Marketing
system. A new standard action for campaigns has been provided for this.

This will create a CSV file that can be imported to SAP Contact Center. To activate this function, you must assign
the new standard action EXPORT TO cc (Create Exp. File for SAP Contact Center) to a campaign category in

Customizing for SAP Hybris Marketing (transaction CET _1MG) under | Campaign » Campaigns » Define

Campaign Categories and Actions 3. This is already assigned to the campaign category CIC - Call Center in the
standard SAP system, or you can assign the action EXPORT TO cC to the required category as follows:

1. Select the required category to which you want to assign the action EXPORT TO cc in the Define Campaign
Categories view.

2. Choose the Assign Actions to Categories view.

3. Choose New Entries.

4. Choose the action EXPORT TO ccC from the value help for the Action ID field and confirm your entry
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5. Enter any required text in the Action Button Tooltip and Button Tooltip fields if you want to override the action
button text and button tooltip that is specified directly in the action. This override is only valid in the context of
this category/action relationship.

This results in the new action being available for new campaigns of this category.

As a default, the CSV file is created in the application server directory defined by the DIR HOME directory
parameter. You can see the value of this parameter in the transaction AL11. If you want the CSV file to be written to
a different application server directory, you can do this as follows:

Call the transaction FILE.

2. Create a logical file path definition, suchas z_SAP _CONTACT CENTER, and assign the directory to which you
want the file to be written as a physical path to it, using a syntax group appropriate for your application server
file system.

3. Open the logical file name definition CALL_CENTER CSV and enter the name of your logical path definition in
field Logical Path.

4. Save and exit.

So that it can be imported to SAP Contact Center, the CSV file created by the action has to be transferred from the
file system for the SAP Hybris Marketing application server to the file system for SAP Contact Center. You should
schedule an appropriate job (such as FTP) to do this periodically. This file can be imported to SAP Contact Center
using the System Configurator (SC). For more information about SAP Contact Center, see http://help.sap.com/
contact-center#e.

Check Permission to Contact in SAP Hybris Marketing

According to the Customizing settings you have made, when the action to create the call list is executed in SAP
Hybris Marketing, the system checks whether permission to make contact by telephone is available. Check this

setting in Customizing for SAP Hybris Marketing under |» Campaigns # Campaign ¥ Define Campaign Categories

and Actions 3. Choose Define Campaign Categories followed by the category c1c. If the value Ignore Marketing
Permission has not been selected for the Category Type, the system checks whether permission to make contact is
available when the action (such as Create Export File for SAP Contact Center - EXPORT TO CC) is executed to
create the CSV file.

Import of Call Results from SAP Contact Center
You can import call results from SAP Contact Center to your SAP Hybris Marketing system.

You can export CSV files with call results from SAP Contact Center to the System Configurator (SC). Following this,
the CSV file that contains the call results has to be transferred from the file system for the SAP Contact Center to
the file system for the SAP Hybris Marketing application server. You should schedule an appropriate job (such as
FTP) to do this periodically.

Once the file is available on the application server, it can be imported to SAP Hybris Marketing. You can do this
using a new report CUAN_CC_UPLOAD_CsV that can be scheduled periodically.

To do so, you have to create a variant of the selection screen for the report.

Call transaction SE38 and execute the report CUAN_CC_UPLOAD CSV.

Leave the default value saP_cc in the parameter Call Center.

Enter the directory from where the call result files are read in the parameter Upload Files from Directory.
Leave the default value *csv in the parameter Upload Files with Name Pattern.

o s W e

Optionally enter the directory to which the process call result files are to be archived in the parameter Archive
Files to Directory.
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6. Save the variant by choosing |+ Go to # Variants » Save as Variant... 3.

Integration with External Call Centers

If you want to connect a call center other than SAP Contact Center to SAP Hybris Marketing using CSV files, see
SAP Note 2182902 - How-To Configuration Guide - Execute SAP Hybris Marketing Campaigns using an external
Call Center.

14.2.4 Setting up Integration with SAP Exchange Media
(Optional)

You can create campaigns on SAP Exchange Media (SAP XM), for example, to display ads shown on web pages.
You can also track the success of the SAP XM campaign in SAP Hybris Marketing once it has been activated.

To set up the integration with SAP Exchange Media, follow the instructions in the corresponding integration guide.
You find this guide on the SAP Service Marketplace at:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING | Integration » View all » Integrating SAP Hybris
Marketing with SAP Exchange Media 3

https://help.sap.com/doc/e8434dab8e6a4972a95a11089b9¢c73d0/1702%20YMKT/en-US/
IntSAPXM_Hybris1702.pdf

14.3 Configuring the Marketing Calendar

If you have not already carried out this step as a part of Configuring Planning, configure the marketing calendar as
described in Setting up "Marketing Calendar" [page 113].
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15 Configuring Manager-Related Tasks

The following functions and apps are available to managers:

e Workflow for the marketing approval process with the the apps Marketing Approvals and Manage Workflows

15.1 Configuring Workflow

The following manager-related applications improve the approval process for marketing campaigns by a workflow-
based approach:

e Marketing Approvals
® Manage Workflows

Both applications are located in the Marketing Manager - Quick Launch business group.

Marketing Approvals

To set up the Marketing Approvals application, you need to carry out the following steps:

Enable Workflow

To ensure the workflow is enabled, go to transaction swu3 in your SAP Hybris Marketing system and execute the
automatic workflow Customizing. To do so, follow the instructions documented in the SAP Library under:

https://help.sap.com/viewer/p/SAP_S4HANA_ON-PREMISE |[p SAP NetWeaver for SAP S/4HANA » SAP
NetWeaver Library: Function-Oriented View ¥ Application Server » Application Server ABAP » Other Services
Services for Application Developers » SAP Business Workflow: Reference Documentation » Workflow System
Administration ¥ Automatic Workflow Customizing 3

(https://help.sap.com/viewer/DRAFT/4400bdc8dd4648a5a2e5c1c8e05198d7/1709%20000/en-US/
4£25999fe85a18c3e10000000a421937.html)

Agents
Go to the Task Customizing Overview (00CU) transaction.

e For Campaigns
Choose | CEC » CEC-MKT » CEC-MKT-CPG » Assign Agents . For each item, choose Attributes and select
the General Task radio button.

e For Target Groups
Choose | CEC » CEC-MKT » CEC-MKT-TG » Assign Agents J. For each item, choose Attributes and select the
General Task radio button.
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If one of the paths CEC-MKT-CPG, CEC-MKT-TG, or the Assign Agents button is not displayed , execute report
RS APPL REFRESH in transaction SA38 and repeat the step above.

Activate Advanced Status Management

In Customizing for SAP Hybris Marketing under [ General Settings » Activate Workflow for Business Objects 3,
choose the business object for which you want to activate workflows, and select the Active checkbox.

Assign Users to Roles

To enable marketing managers to use the Marketing Approvals application, you need to assign your copies of the
following PFCG roles to the corresponding AS ABAP users:
® SAP CEI PLG FLP (business catalog role, no copy is required, you can assign the delivered standard role)
® SAP CEI MKT APPROVAL (back-end role; includedin composite role SAP MARKETING MANAGER)
® SAP CEI HOME (for personalization purposes)

In addition, you must assign a copy of the back-end role SAP CEI MKT BATCH APPROVAL to the workflow batch
user WF-BATCH to execute the user decision in the Marketing Approvals app.

Deactivate Task Filter

To be able to see approval requests in the Marketing Approvals app, in the Enable Task Filter activity in Customizing

for SAP NetWeaver under [ SAP Gateway Service Enablement  Content » Workflow Settings 3, the task filter
must always be deactivated.

Manage Workflows

To enable marketing managers to use Manage Workflows, assign your copies of the following PFCG roles to the
corresponding AS ABAP users.
® SAP CEI PLG_FLP (business catalog role; no copy required - you can assign the delivered standard role)
® SAP CEI WORKFLOW EDITOR (back-end role;included in composite role SAP. MARKETING MANAGER)
® SAP CEI HOME (for personalization purposes)

15.2 Setting up "Release Target Groups"

To set up the Release Target Groups application, you need to carry out the following steps:

e Activate Advanced Status Management
1. In Customizing, under SAP Hybris Marketing, go to |» Segmentation » Target Group * Activate Advanced

Status Management 3.
2. Select Activate Advanced Status Management and, if desired, Enable Editing of Target Group. Save your
entries.

3. In Customizing, under SAP Hybris Marketing, go to |# General Settings » Set Up Quick Filter Tiles J and
enable a quick filter To Be Released for the target group list. Save your entries.
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® Assign Users to Roles
To enable managers to use the Release Target Group app, you need to assign your copies of the following PFCG
roles to their AS ABAP users:
© SAP CEI REL_FLP (business catalog role; no copy required - you can assign the delivered standard role)
© SAP CEI CUAN MK TG REL APP (back-end role;included in composite role SAP MARKETING MANAGER)

o SAP CEI HOME (for personalization purposes)
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16 Configuring China Localization

The China localization of under SAP Hybris Marketing contains the following functions:

e Viewing of followers of WeChat official accounts via the Digital Accounts application
e Analysis of followers of WeChat official accounts via the Digital Accounts application
® |ntegration of Baidu Maps into Segmentation

e China-specific segmentation profile

e | aunch of WeChat campaigns via Campaign Management

1 Note

To integrate Baidu Maps into Segmentation, you need to apply for a Baidu account key.

Required Technical Configuration

Technical configuration are required before you can use the China-specific functions. To make the required
technical configuration, you do the following:

e Calluptransaction STC01 and run task list CUAN_LOCALIZATION CN.
Note that you need to do the following in the parameters of the first task:
o Select the Tech. Customizing System checkbox and enter your Customizing request number.
o Enter your Baidu account key.

Business Add-Ins (BAdls)

There are BAdIs available, which you can use to customize the way you use the China-specific functions.

In Customizing for under SAP Hybris Marketing under |+ General Settings ¥ Integration # Integration Settings for
WeChat 3, you can implement the following BAdls:

e Selection of Inbound WeChat Messages for Processing
You use this BAdI to determine which types of WeChat messages are processed by the system.

® Processing of Inbound WeChat Messages
You use this BAdI to determine how the system processes inbound WeChat messages.
Proxy Settings

Access to the internet from the AS ABAP system is made possible through a proxy server. If it is not yet configured,
configure your proxy server settings.
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Although the proxy settings may be active, the HTTPS protocol might not have a proxy listed. If this is the case,
add the SAP proxy 8080.

Secure Socket Layer (SSL) Settings for WeChat

1 Note

You will need a user assigned the role SAP_ BC_ BASIS ADMIN. For more information, see User for Application
Setup [page 47].

1. Gotohttps://api.weixin.qqg.comand click onthelock symbol next to the URL to get the site
information.

Locate the WeChat certificate and export it to a file.

Start transaction STRUST in the SAP Easy Access menu and switch to change mode.

Choose SSL client SSL Client (Standard).

From the Certificate area, choose Import Certificate and import the saved WeChat certificate file.
Choose Add to Certificate List and save the PSE file.

The AS ABAP will now trust SSL servers whose identity is confirmed by this certificate.

N O s WD
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17 Integration with Extended Marketing
Applications (YaaS Extensions)

171 Setting up YaaS Application "Customer Journey
Manager"

The application Customer Journey Manager in the Campaign Management business group allows marketing
experts to build, monitor, and optimize activities based on various stages in a customer's lifecycle.

1 Note

The application requires a separate license as it is based on SAP Hybris as as Service (YaaS).

To integrate the application with SAP Hybris Marketing you must set up a corresponding RFC destination in your
SAP Hybris Marketing system. To do so, proceed as follows:

Go to transaction sM59 (Configuration of RFC Connections) and choose HTTP Connections to External Server.

Choose |l Edit » Create 3.
On the appearing screen, enter the following SAP_coM_0058 in the RFC Destination field.

A wN e

On the Technical Settings tab, enter the following values:

o Target Host: customerjourney.yaas.io

o Service No. : 001

o Path Prefix: /<Client ID>
For information on how to obtain the client ID, refer to the section Obtain the client credentials in the
document Create a Client of the YaaS Getting Started guide under:
https://devportal.yaas.io/gettingstarted/createaclient/index.html #

o Save your entry.

To enable marketing experts to use Customer Journey Manager, assign your copies of the following roles to the
corresponding AS ABAP users:

® SAP CEI EAC_FLP (business catalog role to access YaaS applications from the SAP Fiori launchpad, included
in composite role SAP MARKETING EAC; no copy required - you can assign the delivered standard role)
® SAP CEI HOME (for personalization purposes)

For more information about the integration of Customer Journey Manager, see the corresponding integration guide
on the SAP Service Marketplace under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING | Integration » Viewl all  Integrating SAP Hybris
Marketing with SAP Hybris Customer Journey Manager 3
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17.2 Setting up YaaS Application "Profile Graph"

The application Profile Graph in the Contacts and Profiles business group allows marketing experts to launch the
Graph Explorer to view the customer profile information within their Hybris profiles.

1 Note

The application requires a separate license as it is based on SAP Hybris as as Service (YaaS).

To integrate the application with SAP Hybris Marketing you must set up a corresponding RFC destination in your
SAP Hybris Marketing system. To do so, proceed as follows:

Go to transaction sM59 (Configuration of RFC Connections) and choose HTTP Connections to External Server.

Choose |» Edit » Create 1.
On the appearing screen, enter the following SAP_coM 0059 in the RFC Destination field.

AN

On the Technical Settings tab, enter the following values:
o Target Host:builder.yaas.io

o Service No.: 001

o Path Prefix: /<tenant ID>

o Save your entry.

To enable marketing experts to use Profile Graph, assign your copies of the following roles to the corresponding AS
ABAP users:

® SAP CEI EAC_FLP (business catalog role to access YaaS applications from the SAP Fiori launchpad, included
in composite role SAP MARKETING EAC; no copy required - you can assign the delivered standard role)

® SAP CEI HOME (for personalization purposes)

For more information about the integration of Profile Graph, see the corresponding integration guide on the SAP
Service Marketplace under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING |j» Integration j» View all  Integrating with SAP Profile

Services for Marketing 3

(https://help.sap.com/doc/e0e4b672c3464976b07tfd3ce8dd3386e/1702%20YMKT/en-US/
loiobeef0c97¢5874db98cd8748d38779¢fb.pdf)
17.3 Setting Up YaaS Application "Loyalty"

The application Loyalty in the Loyalty Management business group allows marketing experts to create their own
cloud-based loyalty program in minutes and gain valuable consumer insights.

Installation and Configuration Guide 1702
138 CUSTOMER Integration with Extended Marketing Applications (YaaS Extensions)


https://help.sap.com/doc/6b4e06fd337744a98d71b509806181d8/1702%20YMKT/en-US/loio2261cab7820248449e93e704548ba2c0.pdf
https://help.sap.com/doc/6b4e06fd337744a98d71b509806181d8/1702%20YMKT/en-US/loio2261cab7820248449e93e704548ba2c0.pdf
https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING
https://help.sap.com/doc/e0e4b672c3464976b07fd3ce8dd3386e/1702%20YMKT/en-US/loiobeef0c97c5874db98cd8748d38779efb.pdf
https://help.sap.com/doc/e0e4b672c3464976b07fd3ce8dd3386e/1702%20YMKT/en-US/loiobeef0c97c5874db98cd8748d38779efb.pdf

1 Note

The application requires a separate license as it is based on SAP Hybris as as Service (YaaS).

To integrate the application with under SAP Hybris Marketing you must set up a corresponding RFC destination in
your under SAP Hybris Marketing system. To do so, proceed as follows:

Go to transaction sm59 (Configuration of RFC Connections) and choose HTTP Connections to External Server.

1
2. Choose || Edit » Create 1.
3. Onthe appearing screen, enter the following SAP_CcoM 0043 in the RFC Destination field.
4. Onthe Technical Settings tab, enter the following values:

o Target Host:builder.yaas.io

o Service No.: 007

o Path Prefix: /

o Save your entry.

To enable marketing experts to use Loyalty, assign your copies of the following roles to the corresponding AS ABAP
users:

® SAP CEI EAC FLP (business catalogrole to access Yaa$S applications from the SAP Fiori launchpad, included
in composite role SAP MARKETING EAC; no copy required - you can assign the delivered standard role)
® SAP CEI HOME (for personalization purposes)

For more information about the integration of Loyalty, see the corresponding integration guide on the SAP Service
Marketplace under:

https://help.sap.com/viewer/p/SAP_HYBRIS_MARKETING | Integration ¥ View all  Integrating SAP Hybris
Marketing with SAP Hybris Loyalty 3

(https://help.sap.com/doc/7fc087bbedcb4187a47879e8354499dd/1702%20YMKT/en-US/
10i068346e335b82a467788a9¢7c357a403dc.pdf)
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18 Frequently Asked Questions

140

Can | install SAP Hybris Marketing on any database and access SAP HANA using a secondary database
connection?

SAP Hybris Marketing runs on an SAP NetWeaver AS ABAP system with SAP HANA database as primary and
only database. During the installation of under SAP Hybris Marketing SAP HANA content is unpacked to the
SAP HANA database. This content is used for accessing SAP ERP, SAP CRM as well as SAP Hybris Marketing
data.

How is the SAP ERP and SAP CRM data accessed?

SAP ERP and SAP CRM data is stored in separate database schemas in the SAP HANA database. SAP Hybris
Marketing delivers SAP HANA information models that join together data from these separate database
schemas. The application accesses the data through these SAP HANA models. As the database schema name
is unique in your system, a schema mapping from SAP’s authoring schema to your schema name is defined
during the technical configuration of SAP Hybris Marketing.

For more information about SAP HANA schema mapping, see the SAP HANA Modeling Guide at:

http://help.sap.com/hana_appliancef|» Modeling Information 3
(http://help.sap.com/hana/SAP_HANA_Modeling_Guide_for_SAP_HANA_Studio_en.pdf#r)

What is the name of the database schema of my SAP ERP and SAP CRM data?

If you replicate data (see Scenario B: Hub-Deployment with Separate SAP HANA System [page 16]) through
SAP LT replication server the name of the SAP HANA database schema is your SAP LT configuration name. If
you run deployment scenario C, Hub-Deployment with Shared SAP HANA System of SAP Business Suite, your
database schema name is SAP<SID> while <STD> is the system ID of your SAP ERP or SAP CRM system.

Do | have to set up HTTPS?

You have to set up HTTPS as SAP Hybris Marketing does not allow HTTP calls.

Do | have to set up a Web Dispatcher?

You have to set up a Web Dispatcher as SAP Hybris Marketing integrates ABAP and SAP HANA

Do | need to set up a BW Client? Do | have to set up the BW Client for all solutions? Can | use a BW client
in another system?

You have to set up a BW client in your SAP Hybris Marketing system regardless of the SAP Hybris Marketing
solution you have licensed. The application uses the operational data provisioning (ODP) to directly access
SAP HANA information models. For ODP, you only need to perform minimal configuration of the BW in your
application system. You do not need to set up a Data Warehouse. Replication of the data to a BW system is not
necessary.
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19 SAP Notes for Installation and Upgrade

If there is additional information to the installation process as described in this guide, you find the new information
in the following SAP Note or SAP Notes.

Make sure that you have the current version of each SAP Note, which you can find on the SAP Service Marketplace
at http://support.sap.com/notes .

Table 46:
SAP Note Number ‘ Title Description
Release Information Note 1885803 # RIN SAP Hybris Marketing Contains information and references in
the context of applying SAP Hybris
Marketing
Note 2076331 # Follow Up Tasks after System Copy Contains information about the actions
to be carried out after system copy
Note 2072589 Far Installing and Configuring SAP Fiori Apps | Contains information about the installa-
for SAP CEl on a central Fiori Frontend tion and configuration of SAP Fiori apps
Server for SAP Hybris Marketing on a central
SAP Fiori front-end server

Final Implementation of SAP Notes

The Release Information Note (RIN) is the central note containing general installation/upgrade information on SAP
Hybris Marketing.

Make sure that you have implemented all notes that are listed in the RIN. For more information about the sequence
of the note implementation, see SAP Notes for Installation [page 9].
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20 Appendix

20.1 Technical Configuration - Expert Mode

If you are not able to use the technical configuration cockpit (Using the Technical Configuration Cockpit [page
52]), you can use the Technical Configuration Expert Mode to carry out the steps in the back end.

To use the expert mode, call up transaction sSTC01 and execute task list CUAN_BASE CONFIG (which corresponds
to the Essentials scenario in the technical configuration wizard). To call the parameter screen, select the last task
in the list and then click on the Change Parameters icon (column Parameter).

Afterwards, execute the following task lists if required:

® CUAN SETUP_ERPCONTENT corresponding to the ERP Integration scenario in the technical configuration
wizard

® CUAN SETUP CRMCONTENT corresponding to the CRM Integration scenario in the technical configuration
wizard

® CUAN SETUP_HRFcorresponding to the HANA Rules Framework scenario in the technical configuration wizard

® CUAN SETUP_CMO DASHBOARD corresponding to the Marketing Executive Dashboard scenario in the technical
configuration wizard

® CUAN SETUP CA corresponding to the Campaign Management scenario in the technical configuration wizard

For more information about the parameters to be provided within the different task lists, see the descriptions for
every scenario in section Section "Scenarios" [page 541].

Installation and Configuration Guide 1702
142 CUSTOMER Appendix



20.2 Replicated Tables in SAP Hybris Marketing

If you replicate data from SAP ERP and/or SAP CRM into SAP Hybris Marketing, the following tables are replicated
via SAP Landscape Transformation Replication Server:

Table 47: SAP ERP Tables

(N - TCURV) (TCURX - TVKO) (TVKOT - W)

ADCP NDBSMATG16 TCURX TVKOT
ADR2 PA0105 TKAOL TVLS
ADR3 PRPS TKEB TVLST
ADR6 T000 TKEBB TVM1
ADRC TOO1 TKEBC TVMIT
ADRP TOOIW TKEBT TVM2
ADRU T005 TKEF TVM2T
BKPF TOO5N TKEFE TVM3
BSEG T005S TKUKL TVM3T
BUT000 TOO5T TKUKT TVMA4
BUTO2I_FS TOO5U TPFK TVMAT
BUT050 TO06 TPFKT TVM5
BUTO51 TOO6A TPTMT TVM5T
BUT100 T009 TSAB TVMS
COBK TO16 TSABT TVTW
COEP TO16T TSAD12 TVTWT
cool T023 TSADI2T TVV1
CRMKUNNR T023T TSAD2 TVVIT
CRMPARNR T077D TSAD2T TVV2
CVI_CUST_LINK TO77X TSAD3 TVV2T
DDO2L T134M TSAD3T TVV3
DDO2T T151 TSAD4 TVV3T
DDOAT TI51T TSADV TVV4
DDO7L T171 TSADVT TVVAT
DDO7T TI71T TSPA TVV5
FPLA T179 TSPAT TVV5T
HRP1001 T179T TT2Z VAKGU
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(N - TCURV) (TCURX - TVKO) (TVKOT - W)
HRP1222 7685 TTZZT VBAK
HRT1222 T685T TVAG VBAP

KNAL TBOO3 TVAGT VBEP

KNB1 TB910 TVAK VBFA

KNVK TBI11 TVAKT VBKA

KNVP TB912 TVBUR VBKD

KNVV TB913 TVBVK VBKPA
KONV TBRC TVFKT VBRK

LIKP TBRCT TVFS VBRP

LIPS TCURC TVFST VBUK

MAKT TCURF TVGRT VBUP

MARA TCURN TVKBT VEDA

MARC TCURR TVKBZ WRF_BRANDS
MARD TCURT TVKGR

MBEW TCURV TVKO
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Table 48: SAP CRM Tables

(A - CRMC_CANCREASON)

ADCP

ADR2

ADR3

ADR6

ADRC

ADRP

AUSP

BUTOO00

BUT020
BUTO21_FS
BUTO50

BUTO51

BUTO52

BUT100

CABN

CABNT

CAWN

CAWNT
CGPL_HIERARCHY
CGPL_PRIO
CGPL_PRIOTX
CGPL_PROJECT
CGPL_TASK
CGPL_TEXT
COMC_PR_TYPE_T
COMM_CATEGORY
COMM_CATEGORYT
COMM_HIERARCHY
COMM_HIERARCHYT
COMM_IL_PRDBP

COMM_PR_FRG_ROD

(CRMC_CANCREASONT -

CRMC_PH)

CRMC_CANCREASONT
CRMC_CHM_PROG_T
CRMC_CHM_STATU_T
CRMC_CHM_TYPE_T
CRMC_CON_PHASE_T
CRMC_CUSTGRP1
CRMC_CUSTGRP2
CRMC_CUSTGRP3
CRMC_CUSTGRP4
CRMC_CUSTGRP5
CRMC_CYCLE_T
CRMC_DISTCHAN
CRMC_DISTCHAN_T
CRMC_DIVISION
CRMC_DIVISION_T
CRMC_ERMS_CAT_CA
CRMC_ERMS_CAT_CD
CRMC_INDUSTRY
CRMC_INDUSTRY_T
CRMC_LEAD_QL
CRMC_LEAD_QL_T
CRMC_LEAD_TYPE
CRMC_LEAD_TYPE_T
CRMC_MKP_CHAN
CRMC_MKTPL_AUTHG
CRMC_MKTPL_AUTHT
CRMC_MKTPL_CHAN
CRMC_MKTPL_CHANT
CRMC_MKTPL_CTYPE
CRMC_MKTPL_CTYPT

CRMC_MKTPL_OBJTT

(CRMC_PR - CRMM)

CRMC_PROC_TYPE
CRMC_PROC_TYPE_T
CRMC_SOURCE
CRMC_SOURCE_T
CRMD_BRELVONAE
CRMD_CHM_CLASS
CRMD_DHR_ACTIV
CRMD_DHR_HEADOPP
CRMD_DHR_HSLSCON
CRMD_DHR_HSLSORD
CRMD_DHR_HSLSQUO
CRMD_DHR_ISLSCON
CRMD_DHR_ISLSORD
CRMD_DHR_ISLSQUO
CRMD_DHR_ITEMOPP
CRMD_DHR_LEAD
CRMD_IM_ML_HEAD
CRMD_IM_ML_ITEM
CRMD_MKTCA_CT_IN
CRMD_MKTHV_MC
CRMD_MKTHV_MC_TC
CRMD_MKTPL_TGGRP
CRMD_MKTPL_TODO
CRMD_MKTTG_TG_EA
CRMD_MKTTG_TG_H
CRMD_MKTTG_TG_I
CRMD_MKTTG_TG_IO
CRMD_MKTTG_TG_I1
CRMD_MKTTG_TG_I2
CRMD_MKTTG_TG_I3

CRMD_MKTTG_TG_l4

DDO2L
DDO2T
DDO7L
DDO7T
HRP1000
HRP1001
HRP1222
HRT1222
QPCT
QPGT
SCPRIO
SCPRIOT
T0O0O
TOO1
T002
T002T
TO05
TOO5T
TOO5U
T006
TOOBA
T0O09
TB0O2
TB0O3
TBOO3T
TBOO4
TBOOAT
TB024
TBO27T
TB028T

TBO38A
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(A - CRMC_CANCREASON)

(CRMC_CANCREASONT -

CRMC_PH)

(CRMC_PR - CRMM)

COMM_PRODUCT
COMM_PRPRDCATR
COMM_PRSHTEXT
CRM_JEST
CRM_MKTPL_ATTR
CRM_MKTPL_OBJTXT
CRM_MKTPL_OBJTYP
CRM_STACOM_ATTR
CRM_STACOM_TEXT
CRMC_ACT_CAT_ASS
CRMC_ACT_CAT_T
CRMC_ACT_CATEGOR
CRMC_BUPA_CBBL
CRMC_BUPA_CDBL
CRMC_BUPA_COBL

CRMC_CANCREASON

CRMC_MKTPL_OBJTV
CRMC_MKTPL_TACTS
CRMC_MKTPL_TACTT
CRMC_MKTPL_TDCAT
CRMC_MKTPL_TODO
CRMC_MKTPL_TODOT
CRMC_MKTTG_OT_H
CRMC_OPPIMPOR
CRMC_OPPIMPOR_T
CRMC_OPPT_TYPE
CRMC_OPPT_TYPE_T
CRMC_PARTNER_FCT
CRMC_PARTNER_FT
CRMC_PARTY
CRMC_PARTY_T

CRMC_PHASE_T

CRMD_MKTTG_TG_I5
CRMD_ORDER_INDEX
CRMD_ORDERADM_H
CRMD_ORDERADM_I
CRMD_PRICING_I
CRMM_BUT_CONTNO
CRMM_BUT_CUSTNO
CRMM_BUT_FRG0041
CRMM_BUT_FRGO080
CRMM_BUT_FRG0100
CRMM_BUT_LNKOO11
CRMM_BUT_MKTPERM
CRMM_BUT_SET0010
CRMM_TERRITORY
CRMM_TERRITORY_T

CRMM_TERRITORY_V

TB910

TBO1l

TB912

TB913

TCURC

TCURF

TCURN

TCURR

TCURT

TCURV

TCURX

TJO2T

TJ30

TJ30T

TSAD3

TSAD3T
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see:
https://help.sap.com/viewer/disclaimer).
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